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New In this release

Features

Other

The following sections detail what's new with Attendant PC Console for
Nortel Communication Server 1000 Release 7.0.

* ‘“Features” (page 7)
* “Other” (page 7)

There have been no updates to the feature descriptions in this document.

See the following section for information about changes that are not
feature-related:

CP PM Co-resident Call Server and Signaling Server

A CS 1000 system consists of two major components, a Call Server and a
Signaling Server. These two components have historically run on separate
Intel Pentium processor-based hardware platforms operating under the
VxWorks Operating System.

CS 1000 introduces the CP PM Co-resident Call Server and Signaling
Server (CP PM Co-res CS and SS) which can run the Call Server
software, Signaling Server software, and System Management software on
the same hardware platform operating under the RedHat Linux Operating
System. For CS 1000, the only supported hardware platform for the CP
PM Co-res CS and SS Server is the Call Processor-Pentium Mobile (CP
PM) platform.

The key objective of co-residency is to provide a cost effective solution
for CS 1000 system installations that do not require high user capacity or
the need for a redundant Call Server

For more information, see Co-resident Call Server and Signaling Server
Fundamentals (NN43001-509).
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8 New in this release

Revision history
June 2010
Standard 04.01. This document is up-issued for Nortel Communication
Server 1000 Release 7.0.

May 2009
Standard 03.01. This document is up-issued for Nortel Communication
Server 1000 Release 6.0.

December 2007

Standard 02.01. This document is up-issued for Communication Server
1000 Release 5.5. All references to Communication Server 1000 Release
5.0 are applicable to Communication Server 1000 Release 5.5.

June 2007
Standard 01.02. This document is up-issued to remove the Nortel
Networks Confidential statement.

May 2007

Standard 01.01. This document is issued to support Communication
Server 1000 Release 5.0. This document contains information previously
contained in the following legacy document, now retired: Attendant

PC: Description, Installation, and Operation (553-3001-320). No new
content has been added for Communication Server 1000 Release 5.0. All
references to Communication Server 1000 Release 4.5 are applicable to
Communication Server 1000 Release 5.0.

July 2006
Standard 4.00. This document is up-issued to add Windows XP to the list
of supported operating systems.

August 2005
Standard 3.00. This document is up-issued to support Communication
Server 1000 Release 4.5.

September 2004
Standard 2.00. This document is up-issued for Communication Server
1000 Release 4.0.

October 2003
Standard 1.00. This document is a new NTP for Succession 3.0. It was
created to support a restructuring of the Documentation Library, which
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Other

9

resulted in the merging of multiple legacy NTPs. This new document
consolidates information previously contained in the following legacy
documents, now retired:

Attendant PC Software Installation Guide (553-3001-220)
Attendant PC Software Quick Start Guide (553-3001-221)
Attendant PC LAN Interface Installation Guide (553-3001-222)
Attendant PC Software Installation Guide (553-3001-320)
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How to get help

This chapter explains how to get help for Nortel products and services.

Getting Help from the Nortel Web site
The best source of support for Nortel products is the Nortel Support Web
site:

www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and
tools to address issues with Nortel products. From this site, you can:

* download software, documentation, and product bulletins

® search the Technical Support Web site and the Nortel Knowledge Base
for answers to technical issues

* sign up for automatic notification of new software and documentation
for Nortel equipment

* open and manage technical support cases

Getting Help over the phone from a Nortel Solutions Center
If you do not find the information you require on the Nortel Technical
Support web site, and you have a Nortel support contract, you can also get
help over the telephone from a Nortel Solutions Center.

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following Web site to obtain the
telephone number for your region:

www.nortel.com/callus
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12 How to get help

Getting help from a specialist by using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an
Express Routing Code (ERC) to quickly route your call to a specialist in
your Nortel product or service. To locate the ERC for your product or
service, go to:

www.nortel.com/erc

Getting Help through a Nortel distributor or reseller
If you purchased a service contract for your Nortel product from a
distributor or authorized reseller, contact the technical support staff for that
distributor or reseller.
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Introduction

This document is a global document. Contact your system supplier or your
Nortel representative to verify that the hardware and software described
are supported in your area.

Subject
This document contains information about Attendant PC Software.
It describes software features, installation and configuration, use,
administration, and installation of the Attendant PC LAN Interface.

Note on legacy products and releases
This document contains information about systems, components, and
features that are compatible with Nortel Communication Server 1000
Release 7.0 software. For more information about legacy products and
releases, go to the Nortel Web site at www.nortel.com.

Applicable systems
This document applies to the following systems:

®* Communication Server 1000M Single Group (CS 1000M SG)
®* Communication Server 1000M Multi Group (CS 1000M MG)
* Communication Server 1000E (CS 1000E)

®* Meridian 1 PBX 61C

* Meridian 1 PBX 81C

Note: When upgrading software, memory upgrades may be required
on the Signaling Server, the Call Server, or both.

System migration
When patrticular Meridian 1 systems are upgraded to run CS 1000 software
and configured to include a Signaling Server, they become CS 1000
systems. The following table lists each Meridian 1 system that supports an
upgrade path to a CS 1000 system.
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Table 1
Meridian 1 systems to CS 1000 systems
This Meridian 1 system... Maps to this CS 1000M system
Meridian 1 PBX 11C Chassis CS 1000E
Meridian 1 PBX 11C Cabinet CS 1000E
Meridian 1 PBX 61C CS 1000M Single Group
Meridian 1 PBX 81C CS 1000M Multi Group
For more information, see one or more of the following technical
documents:

®* CS 1000M and Meridian 1 Large System Upgrades Overview
(NN43021-458)

* Communication Server 1000E Software Upgrades (NN43041-458)

®* Communication Server 1000E Upgrade - Hardware Upgrade
Procedures (NN43041-464)

Intended audience
This document is intended for individuals responsible for installing,
configuring, administering CS 1000 and Meridian 1 systems.

Conventions
The following identifies the terminology used in this document.

Terminology
The following systems are referred to generically as system:
®* Communication Server 1000E (CS 1000E)
®* Communication Server 1000M (CS 1000M)

* Meridian 1

Related information
This section lists information sources that relate to this document.

Documentation references
The following documents are referenced in this document:
* Features and Services Fundamentals (NN43001-106)
* Software Input Output Reference—Administration (NN43001-611)
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Related information 15

Online
To access Nortel documentation on the Nortel Web site:

www.nortel.com/support

CD-ROM
To obtain Nortel documentation on CD-ROM, contact your Nortel customer
representative.
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Overview

Contents
This section contains information on the following topics:

“Description” (page 17)

“About the Attendant PC” (page 18)
“Starting the Attendant PC” (page 18)
“Menus” (page 19)

“Two-line display” (page 20)

“Position Busy indicator” (page 20)
“Fixed keys” (page 20)

“Loop keys” (page 21)

“Incoming Call Indicator Keys” (page 22)
“Trunk Group Busy keys” (page 22)

“Placing a call” (page 23)

“Using the Attendant PC online help” (page 23)
“Using the Help Index feature” (page 24)
“Exploring the Help Console” (page 25)

Description
The Attendant PC software allows you to perform attendant console
and call processing functions on a computer workstation using a mouse
pointing device or keyboard within a Windows 95, Windows 98, Windows
2000, Windows NT or Windows XP operating system environment.

NORTEL
£
o

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



18 Overview

About the Attendant PC
This section describes how to set up the Tools menu, configure features,
use the Attendant PC Help facility, do common call processing tasks and
points you to the other features that come with the Attendant PC software.

You can access the console functions by using the mouse to activate:

Loop keys

Incoming Call Indicator (ICI) keys

Trunk Group Busy (TGB) keys

Fixed keys (Release, Hold, Answer, Rls Dst, CAS)
Flexible feature keys

Virtual feature keys

Hotkeys

Starting the Attendant PC
When your Attendant PC software is installed and a shortcut is created
on your workstation desktop, simply double-click the icon Shortcut to
console.exe to launch Attendant PC.

? ]

Figure 1 "Attendant PC console display" (page 19) displays the Attendant
PC main screen.
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About the Attendant PC 19

Figure 1
Attendant PC console display
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You can resize and position the Attendant PC main screen and tool
windows any way you like by using the mouse to:

®* Move - Left click the mouse on the top part of the console or window
and drag it to the desired location.

* Resize - Move the cursor over any console or tools window edge until
it changes to a , then left click and drag to resize the window.

>

Menus
The Attendant PC menus located in the upper left corner provide access to
many Attendant PC features. Each submenu that follows introduces you
to one of the following four menus:
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Two-line display

There is a two-line display just above the Position Busy and Attendant PC
indicators. The first line displays information about the source of a call.
The second line displays information about the extended call. Figure 2
"Two-line display" (page 20) shows the two-line display.

Figure 2
Two-line display

[ Source of call
| Destination of call, trunk ¢
|Busy) @ Posiion Busy Fils Dst) | CAS) . 20Cess codes

Position Busy Release Destination  Centralized Attendant ™ Status Indicator

butten button Service button

Position Busy indicator

Just above the keypad is a Position Busy indicator. Use this key to
prevent calls from being routed to your console. When you first launch

the Attendant PC, the Position Busy lamp is on. When all Attendant PC
workstations are in Position Busy, the system is automatically put into
Night mode. In Night mode, all incoming calls are routed to a destination
other than the Attendant PC. For example, incoming calls can be routed to
a recorded message.

Fixed keys

The Attendant PC fixed keys are described below:
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About the Attendant PC 21

[ Answer

(Rls Dstj)
(cas)

* Click your mouse on Answer to connect to the current incoming caller

* Click on Hold to put the current caller on hold so you can answer
another call or perform transferring or conferencing services

* Click on the Release key to disconnect the current calling party.

* Click RIs Dst to release a called party, unanswered ringing, busy
signal or an extension requesting a transfer.

* Click CAS to automatically reroute calls to a centralized attendant at
the main location.

Loop keys
Loop keys allow the attendant to answer and originate calls from the
Attendant PC.

There are six loop keys, numbered from 0 to 5. There are two
half-diamonds next to each pickup key to indicate each loop’s status for:

O (g5 )AL
O (Coopd JAL>
0 (Ltop3 JaI»
O [(Lepz Ja >
O (gt )AL

O L=l gy
LGp Sourge
Destination

* Source: the half-diamond on the left gives status at the call's source

* Destination: the half-diamond on the right displays status at the call’s
destination
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22 Overview

In either case, the half-diamond may be off, flashing, or steady on:

Off: no activity is occurring on the line whose half-diamond is off
Flashing: the caller is waiting to be connected, or their line is on hold
Steady on: the caller is connected to another party

Steady red: the caller is busy

Incoming Call Indicator Keys
Incoming call indicators (ICI) indicate the type of call coming to your

console. The ICI keys help the attendant to:

=

ICI key

identify the type of incoming calls queued
prioritize call answering
verify how many calls are in queue

determine how long calls have been waiting

To answer a call associated with an ICI key, click on the flashing ICI lamp

in the ICI List.

Trunk Group Busy keys

Trunk Group Busy Keys (TGB) enable you to deny users access to trunk
groups and have calls to those trunk groups sent to your console instead.
The lamps show the status of each group of trunks. You can create up to
20 trunk group busy (TGB) keys that deny users access to one or more
trunk groups from 0 to 9. Refer to “The TGB tab” (page 78) for a detailed
description of TGB keys. The following indications display the status for
each trunk group:

X

TGB key

Steady on: you busied out all trunks in the group by pressing the TGB
key.

Off: With the TGB lamp steadily lit, press the TGB key to turn the
indicator off and permit access to the trunk group.

Flashing: All trunks in the group are busy.
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Using the Attendant PC online help 23

Placing a call
The Attendant PC supports four methods to dial in-house or outside:

Dialpad numbers
BIG]E
=) () ()
) () =
B0

Mini-keypad

® Use your mouse to click on the dialpad numbers shown on the screen

® Use the numeric keypad on your PC’s keyboard

* Drag and drop a highlighted telephone number into the mini-keypad
near the top left corner of the console display

* Drag and drop highlighted text into the Directory icon near the top of
the console display

For more information on call processing and feature activation, refer to
“Attendant PC call processing” (page 87).

Using the Attendant PC online help
The onscreen Help provides information on using Attendant PC features,
configuring the PC console, and reference sections which contains
additional information such as a Glossary and Troubleshooting.

Help Menu
] n

Cortwe vy B
B o 1 itercho P Corim

Figure 3 "Attendant PC Help Topics" (page 24) shows the Attendant PC
Help Topics window.
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Figure 3
Attendant PC Help Topics

Help Topics: Hortel Meridian 1 PC Console EHE

Contents | Index | Find |

Click a book. and then click Open. Or click another tab. such as Index.

L About Maortel Meridian 1 Attendant PC
Q Features

@ Usging the PC conzole screen

Q Configuring the PC conzole screen
Q Fieference

This section includes many references to Help. Many sections in the
manual contain a table like the one shown below that lists Help keywords
for you to search on in the Help index. This way, we can provide the
details when you need them and where you need them: while you are
administering to the typical operation of the Attendant PC.

To learn about... Search the Help Index for...
adding a new operator new operator
adjusting the sound volume volume

For more information on using Attendant PC online help, refer to “Using
the Attendant PC Help Facility” (page 173).

Using the Help Index feature

To locate information quickly, choose Index from the Help menu. Figure 4
"Attendant PC Help Index" (page 24) shows the Attendant PC Help Index.

Figure 4
Attendant PC Help Index

Help Topics: Nortel Meridian 1 PC Console EHE

Contents  Index IFind |

1 Type the first few letters of the word vou're looking for.

Conzoles

2 Click the index entry you want, and then click Display.

Congole Configuration -

Creating a wirtual feature
Diagrostics

Dial

Dialing a number

drag

Express: mail
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Exploring the Help Console
To locate comprehensive console information, use either the Help
Contents, Find, and or Glossary functions. Figure 5 "Help Console
window" (page 25) shows the Help Console window.

Figure 5
Help Console window

Click on Glossary fcya list
of console terms. «Z]
Click Help T'6pics to
display the Help Contents,
Index, and Find tabs.

Y R
o= )ar
@([(e=o Jar ([ Answer]
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Working with the Tools menu

Contents
This section contains information on the following topics:

“Tools menu” (page 28)
“Feature List” (page 29)
“Fixed features” (page 29)
“Flexible features” (page 30)
“Virtual features” (page 30)
“ICI List” (page 35)
“Adding an ICI key” (page 36)
“Adding an ICI key” (page 36)
“Using the ICI Keys page” (page 38)
“TGB keys” (page 39)
“Building a ToolBox” (page 41)
“Accessing the CPLUS Directory” (page 42)
“Directory” (page 43)
“Starting the Directory” (page 44)
“Creating a Directory entry” (page 46)
“Editing a directory entry” (page 56)
“Deleting a directory entry” (page 57)
“Exporting Directory dialing numbers” (page 57)
“Importing Directory dialing numbers” (page 58)
“Changing a directory number (DN)” (page 59)
“Searching the directory” (page 60)
“Using information screens” (page 60)
“Logging off the Attendant PC” (page 62)
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28 Working with the Tools menu

Tools menu
The Tools menu represents an important work area on the Attendant PC
desktop as shown in Figure 6 "Feature List display window" (page 29).
This is where you transact, administer and set up the fundamental call
processing activities. It is also a unified work area for making decisions
on how to process or route a call.

« Diractory
Fieature List
ICI List
TGB List
ToolBiox
CPlus Directory

Log off
Exit

The Tools menu contains the following eight submenus:

* Directory: Contains directory names, telephone numbers, and other
access information for you to use as needed.

* Feature List: Lists the features you selected from the Attendant
PCConfig menu. These features are accessible to you because they
were programmed in advance on the switch.

® [CI List: Lists the ICI (Incoming Call Indication) keys that are available
to you because they are programmed on the switch.

®* TGB List: Trunk Group Busy keys that are accessible to you.

* ToolBox: Contains features, ICls, and TGB keys that you have
customized to administer the PC Attendant console activities.
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Feature List 29

®* CPLUS Directory: Enables you to upload CPLUS directory files from
a diskette.

* Log off: Logs you out of the Attendant PC console.

e Exit: Quits the Attendant PCsoftware program.

Feature List
The Feature List contains fixed features that are programmed by your
System administrator. To display these features, select Feature List from
the Tools menu. Figure 6 "Feature List display window" (page 29) shows
the features accessible to your Attendant PCconsole.

To activate a feature, double-click on the feature in the Feature List.

Figure 6
Feature List display window

° Feature List M= B3

View Help
Feature | Other... |

(ORI 1)

. Fixed
Night > Features m

Use the View menu to Exc.. i You can also use the [E8) and

display features as large - — .
or fmgu icons. or in a I?st Exe/ .-~ -+ _ . [B04) fixed feature buttons on the

as shown in this figure. CAS 4« ” P - cclr:sole to reroute and release
- calls.

Conf Fixed
g a.. Features

Fixed features
Fixed features are standard in all Attendant PC workstations and cannot
be edited or removed. Table 2 "Fixed features" (page 30) lists the fixed
features shown in Figure 6 "Feature List display window" (page 29).
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30 Working with the Tools menu

Table 2
Fixed features
Alarm Centralized Attendant Service
Call Waiting Conference
Exclude Destination Exclude Source
Make Set Busy Night Service
Release Release Destination
Release Source Signal Destination
Signal Source

Flexible features
Flexible features are created when they meet the needs of the business
they serve. A flexible feature is assigned by a system administrator and
given a key label and definition in the Attendant PC software.

Before a flexible feature may be accessed from the Feature List, it must be
configured under the Flex Keys tab.

Use the following procedure to configure a flexible feature to appear in the
Features List.

Procedure 1
Configuring a flexible feature

Step Action

Select Console Configuration from the Configuration menu.
Click the Flex Keys tab.

Pull-down on one of the available Flex Keys and select the
desired feature.

—End--

Virtual features
Virtual feature keys allow you to consolidate multiple key strokes into
one keystroke. Virtual features are created using the Features tab in the
Console Configuration menu. To create Virtual features, see Figure 11
"Virtual List display window" (page 35).

For example, if you want to place a call to a pager using the M2250
Attendant Console, several key presses are required:
* select a loop key

e dial the pager number
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* pause 2 seconds

® press End-to-End Signalling key

® input your return number

* end with the pound key (#)

* press the Release button

Creating a Virtual feature for the above functions allows you to execute the
functions with a single keystroke.

Use Procedure 2 “Creating a Virtual feature key” (page 31) to create a
Virtual feature key.

Procedure 2
Creating a Virtual feature key

Step

Action

A W N P

Choose Console Configuration from the Configuration menu.
Select the Features tab.
Click New.

Type a description of the feature in the Feature Description text
box.

Type the label that is to appear on the console in the Key Label
text box.

Select Virtual in the Type group box.
Click Processing.

Figure 7 "Feature Specification window" (page 31) shows the
Feature Specification window.

Figure 7

Feature Specification window

Feature Specification

Feature Description oK

Jan Dee's Pager|

Cancel
Kew Label:

Processin
IJan'S Pager — g

EBemove

Type
|7 & irtual Help

didae

 Flexible feature key

™ Masterfeature (cannot be altered)

Select the steps that make up the virtual feature.
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Figure 8 "Processing Procedure window" (page 32) shows the
Processing Procedure window.

Figure 8

Processing Procedure window

Jan Dee's Pager - Processing Procedure

Awailable processing steps Selected Steps
ConnectAudiointo R - Selectan idle loop Cancel
Connect Audio into TX Dial & number (Static)

Connect R to Audio out Add | Pause for 2 seconds

Connect TA to Audio out Press aflexible feature key Flex Select I
Dial a number (Dynamic) Dial a number (Static)

Dial a number {Static) . Press Release :

Disconnect Audio in fram R Bl Dial Mumbear

Disconnect Audio in from T
Disconnect X from Audio out |E Belent
Disconnect TA fram Audio out
Pause for 2 seconds

Press aflexible feature key Help
Press anICl key

Press Release T 3

Fress the active lnnn :i

9 Highlight the appropriate processing steps in the Available
Processing Steps list box and click Add. The steps appear in
the Selected list box. Use the Remove button and the arrow
buttons to edit the Selected list box.

10 Define each step in the Selected list box that requires a flexible
key, an ICI key, or a number to be dialed.

® To assign flexible keys for the steps, click Flex Select. The
Flex Key Selection window opens. For each step entitled
"Press a flexible feature key," select the appropriate flexible
key from the Key list box. When all flexible keys have been
assigned for the required steps, click OK.

Figure 9 "Flex Key Selection window" (page 33) on Figure 9
"Flex Key Selection window" (page 33) shows the Flex Key
Selection window.
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Figure 9
Flex Key Selection window

Flex Key Selection

Y'ou have selected one or mare flexible feature keys to be pressed for this virtual
feature. Selecta "Press aflexible feature key" step in the "Steps" listthen select

the feature key to be pressed for that step from the "Keys" list. - |

Steps:

Selectanidle loop
Dial a number (Static)
Pause for 2 seconds

‘End to Enc

exible feature
Dial & number (Static)
Press Release

To assign ICI keys, click ICI Select. The ICI Select window
opens. For each step entitled "Press an ICI key," select the
appropriate ICI key from the Key list box. When all ICI keys
have been assigned for the required steps, click OK.

To assign phone numbers, click Dial Number. The Static
Dialing Assignment window opens. For each step entitled
"Dial a number (Static)," enter the number to be dialed. When

all numbers have been entered for the required steps, click
OK.

Figure 10 "Static Dialing Assignment window" (page 34) shows
the Static Dialing Assignment window.
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Figure 10
Static Dialing Assignment window

Static Dialing Assignment

Y'ou have selected one or more static dialing steps for this virtual feature. oK
Highlight each of the "Dial & number (Static)" steps in the "Steps” list then enter

the number to be dialed for that step. Cancel

di

Steps: Help

Selectanidle loop
Dial & numbe
Pausefori s
Press aflexible feature key
Dial & number (Static)
Press Release

Enter the number to be dialed.

{408) 555-1212

11 Click OK.

~End--

Use Procedure 3 “Using the Virtual feature” (page 34) to use the Virtual

feature.

Procedure 3
Using the Virtual feature

Step Action

1 Scroll through the list in the Virtual List display window, as shown
in Figure 11 "Virtual List display window" (page 35).

2 Double-click the light blue shaded Virtual Feature from the

Features List.

Note: Definitions for all features, as well as ICI's (Incoming
Call Indicators) and TGB’s (Trunk Group Busy keys), are
provided in the section "List of Terms" and also in the Glossary
and other help screens on the Console.

Figure 11 "Virtual List display window" (page 35) shows the

Virtual List window.
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ICI List

Figure 11
Virtual List display window

* Festure List =] x|
Yiew Help

Rils

Cwf

Busy

Might

Alarm

Excl Sie

Excl Dst

CAS

Rls Sie

Rls Dest

Conf

Sig Sic

Sig Dest

Class of Service

Display Date

Trace/alet Virtual

Trace (TRC)

Barge In

Fealures

—End--

The ICI List contains the ICI (Incoming Call Indicator) keys. The ICI keys
will help you:

O ((Loops_J<d B>
O ([Loopst J<a b
O (o3 J<d B>
O (Ltop2 Jea >
O ((Loop1 J<d >

| Loop0 J<J [>

Lamp Source

Destination

* identify the type of incoming calls queued

® prioritize call answering

* verify how many calls are in queue

® determine how long calls have been waiting

To answer a call associated with an ICI key, click on the flashing ICI
lamp in the ICI List.
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ICI Lists

Yiew Help

J

Code Blue

-
o

viP

You can answer call using the loop keys, or you can give preference to a
certain type of call, using the ICI keys. For example, to answer a WATS
call before you answer the other calls, click the WATS ICI key. All other ICI
indicators go off, and the WATS call is established.

Besides telling you the nature of a call, the ICI indicator also gives you an
idea of the number of calls of that type that are queued and how long the
calls have been queued:

* steady on — one call has been queued for less than 20 seconds
¢ flashing — two or more calls are queued, or one call has been queued
for more than 20 seconds

ICIs are programmed by the System administrator then assigned to a key
in the console. The software displays this list when you select the ICI List
from the Console Configuration menu.

Use the ICls tab in the
Console Configuration
menu to assign a specific
ICI for display in the ICI
list.

ICIs tab

[ (] il | Tk
Gored | i | b | Tome | Pemte | g

| (Cs
Note: You can also drag ICI keys from the ICI List and drop them
into your personal Toolbox.

Adding an ICI key
Use Procedure 4 “Adding an ICI key” (page 37) to add an ICI key.
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Procedure 4
Adding an ICI key
Step Action
1 Click New to bring up the popup dialog shown in Figure 12 "ICI
specification window" (page 37).
Figure 12
ICI specification window
¢
The path and location -
of the default directory T\Tﬁ:?ww
where the larget WAV S e |
files reside are shown fwars A Ciick Help for delailed
a8 ... Proeky (0 -Lowsst. 59 Highest] [0 3] information an ICI specifications
% ?mwwmroumumm
S+ = o P [FRDOWSUEDI T esmrat Serde (Y] [B] Click the Play bution to hear
T fastat foaing fcanriol e ahered) the selected default sound
2 Define a new ICI Description, Key Label and path to the location

of the default WAV file designated for audible signalling.

3 Click OK to save the ICI key.

The key label entry you created is now displayed on the ICI list
that you selected from the Tools menu.

ICls List

4 While still in the ICls window, click the ICI Keys tab to associate
a new ICI key with each number from 0-19, as described in “The

ICI Keys tab” (page 77).
Click OK to save the ICI key.

Select the ICI List from the Tools Menu to see the new
oval-shaped button associated with the ICI key assignment
you just made. Figure 13 "ICI Keys display window." (page

38) shows the ICI Key display window.

~End--
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Using the ICI Keys page
Figure 13 "ICI Keys display window." (page 38) displays the ICI Keys
window on which you can pair up to twenty ICI keys with one of the key
numbers (three ICI keys are defined in this sample window).

ICT Keys tab

Use Procedure 5 “Viewing the ICI keys display bar” (page 38) to view the
ICI keys display bar.

Procedure 5
Viewing the ICI keys display bar

Step Action

1 Click the to associate an ICI key with each nhumber from 0-19.
[

2 Select the ICI List from the Tools Menu to see the new
oval-shaped button associated with the ICI key assignment you
just made.

Figure 13 "ICI Keys display window." (page 38) shows the ICI
Keys display window.

Figure 13

ICI Keys display window.

Mavicdiant Attendant PC Conflgur stos

Geeerd | Hohen | Coucles | Amendwts | Fosle
Lists the ICls that have Fesken | i I T - | m;,:
been assigned using the
New button o [Cosrine 2 g0 [ o E Click, then select a number choice
1 [owr B = fo associale an ICI key assignment
2 |vP 2 2] Mo ¥
- B NEO
1 ET -] 1 [ o= B ——
4 [ chiones = [ oo T
g | cNones T L o e € . o v s s i o g o o
B | et = e | Mo Sln: Di-potonen S s
SO oo S e
g | tors = g [etione ko i =
8 [ e TR ctors: PN
.
Plaara pote o
These IO sl mbch
COIB smunt be configueed ot FL12 b we 1T 10 thea 15 l
Click Helip on how to assign ICI Keys
ok ] ceee | ﬁ fo the ICI Feature List

—End--
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TGB keys

TGB (Trunk Group Busy) keys allow you to quickly and easily:

* determine if all trunks in a route or trunk group are busy

* busy out particular routes to outgoing calls

* deny certain users direct access to trunk groups

The button lamps in the TGB List show the status of each group of trunks.

Use Procedure 6 “Activating a TGB key” (page 39) to activate a TGB key.

Procedure 6
Activating a TGB key

Step

Action

1

Choose one of the following to activate a TGB key:

a Click on the TGB lamp in the TGB List.

Note: TGB keys are programmed by the system
administrator.

b You can also drag TGB keys from the TGB List and drop
them into your personal Toolbox.

Use Procedure 7 “Adding a TGB key” (page 39) to add a TGB key.

Procedure 7
Adding a TGB key

Step

Action

1

Click New to bring up the popup dialog shown in Figure 14 "TGB
Specification window" (page 40).

Define a new TGB Description and Key Label.
Click OK to save the TGB key.

The key label entry you created is now displayed in the TGB list
that you select from the Tools menu.

TGBs List
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Figure 14 "TGB Specification window" (page 40) shows the TGB
Specification window.

Figure 14
TGB Specification window

TGB Qescrplon : I .
Lists the TGBs that [TE w5501 | | E—
have been assigned s B || SosssmeTsan sty syt o tyse
(0 106 Nesr hithon, [re A
Click Help for detailed
information on TGB specifications.
4 While still in the TGBs window click the TGB Keys tab to

associate a new TGB key with each number (0 to 19) as shown
in Figure 15 "TGB Keys display window" (page 40).

TGB Keys tab
T |

=/

s
o | i | i | e | Byl

]

Figure 15
TGB Keys display window

Meridiant Attendamt PC Configurator E|

Genetsl | Hotheys | Conseles |  Amerdsrts | Featues
FlnKeyr | 102 | IOIKeps | TGE: 168 Koy
0 [CO (Cerisa Ofice) 2 g0 | Meee E| Select a number choice fo
1 [T rurk group 1 E R 3 associate a TGB key
2 [TErnkgan2 =] 2 [<hones k| assignment
3 | TIE trurik growp 3 2l g3 | <Nones 3|
4 |WATS (wide Avea Telecom] #| 44 [ <None> =
5 [ -] 15 [toee ¥
g | <tone =l 4 | <hones EN
7 I:Nurej- j 17 IrNQng} j
g | cNene = g | Nones 3|
g | oo = a8 [ oo |
. Please note .

These TGB azmgrments must match the setup infomabion in he Meadian 1. |

COB must be configured lor 1012 to use TGE.

Ok | Cocel coi | € el Click Help on how to add TGB Keys.
e, ™

Click OK to save the TGB key.

Select the "TGBI List" from the Tools Menu to see the new
shaped "button" associated with the TGB key assignment you

just made.
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~End--

Building a ToolBox
The Attendant PC ToolBox, allows you to store the features that you use
the most in one window. Once you build a toolbox, you no longer need to
display the ICl and TGB directory windows except as needed. All features
(fixed, flexible, and virtual) are now available to you in one central display
window (Figure 16 "Sample Toolbox window" (page 42)) instead of three.

Each attendant’s toolbox is personalized. When an attendant logs in, no
matter which console is being used, the attendant’s toolbox appears with
the appropriate features.

To build your toolbox, drag and drop features from the Feature List, ICI
(Incoming Call Indicators) List, and TGB (Trunk Group Busy) List windows
into the Toolbox window.

Use Procedure 8 “Building your toolbox” (page 41) to build your toolbox.

Procedure 8
Building your toolbox

Step Action

1 Choose Toolbox from the Tools menu.
An empty Toolbox window is displayed on your desktop.

2 Select Feature List from Tools on the Attendant PC main
screen.

The Feature List window appears on your desktop.
3 Select ICI List from Tools on the main screen.
The ICI List window appears on your desktop.
4 Select TGB List from Tools on the main screen.
The TGB List window appears on your desktop.

5 Drag and drop the features you use the most from the Feature
List window to the Toolbox window.
6 Repeat Step 3 for the ICI List keys and the TGB List key.

Figure 16 "Sample Toolbox window" (page 42) shows a sample
of the Toolbox window.
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Figure 16
Sample Toolbox window

J

Tip

You can resize or

DN - 100 o for Adninistia. |

edge: and sides of the #* ToolBox for Administra... | X]

Toolbox window with TGB List

the mouse to enlarge it
in order to list more
features and keys.

Feature List

Cexde Bilan

ICI List

~End--

Accessing the CPLUS Directory
The following procedure shows you how to use the CPLUS Directory
function to access CPLUSDIR. BTR directory numbers from a diskette for
uploading into the Attendant PCData folder for transfer to your personal
Directory.

Use Procedure 9 “Accessing CPLUSDIR.BTR directory numbers” (page
42) to access CPLUSDIR.BTR directory numbers.

Procedure 9
Accessing CPLUSDIR.BTR directory numbers

Step Action

1 Select CPLUS Directory from the Tools menu.

A dialog displays prompting you that the CPLUS directory file
CPLUSDIR.BTR cannot be found. See Figure 17 "CPLUS
Directory dialog" (page 43).
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Figure 18

Figure 17
CPLUS Directory dialog

CONSOLE

@ The CPlus directory file (CPLUSDIR.BTR) cannot be found. Would you like to locate this file yourself?

Click Yes to locate the CPLUS file.

The CPLUS Directory "Look in" window is displayed. See Figure
18 "CPLUS Directory Look in display" (page 43).

Click the to display the 31/2 Floppy (A:) drive icon.

[

CPLUS Directory Look in display

¢

Tip

Drag and drop a
directory .+
entrytothe | 2% icon
to dial a user's
number
automatically.

Directory

- — = -Click here to access the
drop down devices window.

Fles e [ 93 Flns kasa bt}

Select the CPLUSDIR.BTR file and click Open.

The CPLUSDIR.BTR file is uploaded to the Attendant PCData
folder.

-~End--

The Directory is a principal component of the Tools menu. All Attendant
PC call processing activity is initiated from this key resource. The Directory
also records individual records for fast information retrieval.

Overall, the Directory functions as a "mini console" containing a two-line
display, Position Busy, RIs Dst, CAS buttons, Mini-keypad, and Directory
icons and Directory Help facility. See Figure 19 "Directory console display"

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



44 Working with the Tools menu

(page 44). You can also assign "hot keys" to one or more keys to activate
a specific function if you prefer using keyboard shortcuts. See “The
Hotkeys tab” (page 66).

Note: The Directory console functions just like the main console except
there is no global console Help, dialpad numbers or loopkeys which
allow you to assign an outgoing call or answer an incoming call.

Figure 19
Directory console display

Mini-keypad Directory

" Directory - Name, First Name

e Use the Ris Dst button to
rn —
I [;D L ‘w' release a called party,

[e) Sromns] (W] | / S0
Posiion St | 7 unanswered ringing, busy
Busy indicator | v signal or an extension
(3 [ES L] requesting a transfer.
T
\ <H
-~

s Use the CAS button to
'lﬁ) automatically reroute calls

to acentralized attendantat
the main location.

]|k

‘Status Indfcafor= P’}
|Busy] @ Pasition Busy [RIsDst) |CAS | =
Position Busy Release Destination Centralized Auendan
uton : hutton Service button

Starting the Directory
You can launch the Directory in two modes—uwith the mini-console
attached or with the default Directory List only.

Use Procedure 10 “Enabling the mini-console option” (page 44) to enable
the mini-console option.

Procedure 10
Enabling the mini-console option

Step Action

1 Select the Tools menu and click Directory.
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Figure 20
Main Properties page
[ —
Cohars | s i s | I I

Click the Directory menu and Properties to display the
Directory Properties page. See Figure 20 "Main Properties

page" (page 45).

Check the box labelled Include console functions.

Click OK.

The Directory with attached mini-console is displayed on your
workstation desktop.

Indicatea  + inthe i i
box to “Include L)
:;‘Jrlc:l_lons “to Ia:‘:!ch owes
e directory console
r h@uﬁm E] m

Note: Leave the box labelled Include console functions

(Eo=T] s | mown|

Click the Help button to open a book or ust
the Index tab to locate information on settir
up the directory display.

unchecked to display the Directory without the mini-console

option as shown in Figure 20 "Main Properties page" (page

45).
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Figure 21

Directory mini-console and Directory default displays

Tip

‘You can assign "hot keys"
to one or more keys to
activate a specific function
if you prefer using
keyboard shortcuts.

See "The Hotkeys tab” on
page 60.

tury - Nome. Firsl Name

i Direclory - Name, First Name

Directory with mini-console option Default Directory

—End--

Creating a Directory entry

A Directory entry or "row" listed in the work area of the Directory window
relates to a record for that entry. See Figure 23 "Directory display window"
(page 48). Each record defines a profile which is contained within the
following two tabs:

General tab
— Extension DN — Last and First Name and Title
— Access Code — Status

Address tab

— Street Address — City
— State — Postal Code (Zip)

To obtain help at any time on "Getting Started" and "Using the Directory",
click on Contents in the Directory Help facility.

Note: You can browse a view of the Directory Window by pressing
the F1 key.
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Use Procedure 11 “Creating a directory entry” (page 47) to create a
directory entry.

Procedure 11
Creating a directory entry

Step Action

1 Select Directory from the Console Tools menu.

Figure 22 "Console Tools menu display." (page 47) shows the
Console Tools menu display window.

Figure 22

Console Tools menu display.

7 Console: Console 1 - Attendant: Administrator _ O] x] I
Config Help

CPlus Di
Click Directory D-mh;my NS RTELMERIDIAN
to set up your Feature List
personalized ICI List
database of dialing TGB List
numbers. ToolBox

Eit

B Position Busy O

BIGIE | (_Belease)
(o) () ) o Cowyaac
Y@ o

H 9 Om‘-’ﬂﬁ" Attenda

Figure 23 "Directory display window" (page 48) shows the
Directory display window.
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Figure 23
Directory display window

BB Directory - Hama Firat Hame
| S=siTRD e - e Directory - displays menu options that
I Console - displays keyboard shoricuts
Ctri+E eh‘ ~. of "Hot Keys"
Change DN en T il -, ) )
Status (. Information — displays the Shifi screen
Delete Del i with key definiions
I‘Eggy
S _E. = Help - provides directory help
Export information on directory related topics
Import
=
Tip
Use the Tab key
instead of the mouse
to move through the
various text fields
and buttons
selections in any
Directory tab
3000 Jones, Mred
@72 Wilams. Pot 4
A )
2 Click on Directory to select the New page.

Enter General information for each person you want listed in

your directory.

Figure 23 "Directory display window" (page 48) shows the
General tab display window.
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Figure 24
General tab display

[
Tit:

| ™ Thesfs ot an i
Statu [ <] LastUpdatedt

I™ Do et publsh Click the Help button to see Help Topics on
providing general information for a directory
[ entry.

Click Apply and then OK.
The new entry is displayed in the Directory window.

Note: If the This is not an Individual check box is selected,
the Directory displays two face icons rather than one.

Double click on the newly defined entry to display additional
Directory tabs.

8 Directory - Name. First Name
Directory Console Information  Help
DI | MName |j
D000 Jones, Fred
© 8282 Smith, Jane
(2) 5555 Watsan, Chris .
(27326 Williams, Pat
«| | -]

Click the Address tab to record profile information for each
individual entry and then click OK.

Figure 25 "Address display tab" (page 50) shows the Address
display tab window.
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Figure 25
Address display tab

%)

[ eciony Eniry for irewm, Judy
D

Stiet Addeis

|45:3M:-IAW

[5ue £l

Ciy.

|£ S—

Staber Postal Code

IU- 4

o:lc-:d Help

~End--

Use Procedure 12 “Setting the Directory properties” (page 50) to set the
Directory properties.

Procedure 12
Setting the Directory properties

Step Action

1 Click Directory to select Properties.
The Directory Properties page displays five tabs.

Specify the columns that appear on your directory display screen
and in what order they should appear. See Figure 26 "Columns
display window" (page 51).

2 Click Columns.
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Figure 26

Columns display window

Columns

Tip

Double click on a column
item to move it quickly
between “not displayed” to
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see descriptions for sefting,
positioning, and removing
columns.

Usethia

7 !@E
Cokas | User Dita | Info | iccmes Codes | Stshun Codes | A
" Mlml : Opire I

mxmnﬁmmmlm

Sietngup the rectoey iapoy

Colomes et 1 Chwoose Progesies bom the Dirschary mery and cick nthe
(kg s

| b 2 Inthe Cokmns Hot Displaped et bo bighight eech colinn
ou wark b appe i e Divchony mndom and ek Addor
double cick.

| U the avow ke e b of he Cokumns Displaped et
b o change e order of e cokumnz

o 3 Dok D and sy the pasubs in e Dpsclony windoss

Click the Help button to see instructions for
] o] —@ setting up the directory display.

The User Data tab allows you to label custom columns. Column
labels that you type here appear on the Columns tab, where they
can be selected to display in the Directory window. See Figure
26 "Columns display window" (page 51).

Iser Data

Note: Custom columns can be used to order the directory.
For example, if you label a column Site and display the column
in the Directory window, clicking on the column label for Site
arranges the directory by site in ascending alphabetical order.

—End--

Use Procedure 13 “Labeling custom columns for display in the Directory
window” (page 51) to label custom columns for display in the Directory
window.

Procedure 13
Labeling custom columns for display in the Directory window

Step Action

1 Click User Data.
Figure 28 "User Data display window" (page 52) shows the User
Data display window.

2 Click Apply and then OK.

Use the Info tab to label tabs for storing additional information on
directory entries. You can label from 1 to 14 tabs. For each label
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you enter, a tab appears in the Directory Properties window. For
further information on using the information screens, refer to
“Using information screens” (page 60)

Figure 27 "Directory Properties window." (page 52) shows the
Directory Properties window.

Figure 27

Directory Properties window.

Cohmmrs Uresato [inko | Access Codes | Statn Codes |

1 1
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The directory contains two user
definable columns. Enter a
short, one- or two-word label for
| these columns.

Comn 81

Click the Help button to see
information on labeling custom
columns.

e C)

Figure 28 "User Data display window" (page 52) shows the User
Data display window.

Figure 28

User Data display window
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Type the appropriate information in the two text boxes. Each text
box is marked with the label assigned in the Directory Properties
dialog box.

Column labels that you type here appear on the Columns tab,
where they can be selected to display in the Directory window.

3 Click the Shift tab to customize labels.
Figure 30 "Info display window" (page 54) shows the Shift
display window.
Figure 29
Shift display window

1 Directony X

Directory Console Information Help

+ Shift - jones, joe X] I

Shift key type|

HEE
HepTopes) oo | Bl | Opbons
Addiianal Information

This feb lets you enles adcitional rdormation for an enry in a free fom best famat. You can customioe labels for up Lo 14 addtiondl
riomation tabs n the bnfo tab in Properties

b

4 Enter free-form text to define a label for an entry.
5 Click OK to accept the changes.

—End--

Use Procedure 14 “Labeling tabs for the Directory entry window” (page
53) to label tabs for the Directory entry window.

Procedure 14
Labeling tabs for the Directory entry window

Step Action

1 Click Info.

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



54 Working with the Tools menu

Info |

Figure 30
Info display window

Cokares | UsesDiata b0 | scoess Codes | Staus Codes |

w1t B |-10] x|
] el Labeling custom tabs for additional information
5 I - I 1 Choose Propearties from the Directory menu and chck the Info
af | tab
2 Type alabal for sachtab
& it 3 Chck OK when the Labs are complels
= ) T s the tabs, select an anky and choose Edt om the
Divachery meras
| 1a[
| | . . .
Click the Help button to see information on
[ or | cmea | [ creating label tabs.
2 Click Apply and then OK.

-~End--

Access codes

Access Codes are one or more digit(s) dialed by a console within the
telephone system prior to dialing an outside call. These codes determine
access to features and trunk facilities so that the Attendant PC can route
calls correctly.

Access Codes

Figure 31 "Access display window" (page 55) shows the Access display
window.

Use Procedure 15 “Defining access codes” (page 54) to define the access
codes for dialing outside numbers.

Procedure 15
Defining access codes

Step Action

1 Click Access Codes.
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Figure 31
Access display window

D ectory Properties %]
oo | Uses Dua] ks Accesa Codet | S Codes |

g If the access number must have Touch Tone
DTMF, include a T immediately before and

These digits make up the

i sl R . after the portion that requires the tones.
Acces dgty.
Yalid characters include F -
09, T, and comma (). All 7
other characters are , 4
ignored é
) WL
Click the Help button to see information on
ECE R E@rE) creating label tabs.
Add New Access Code
Prompts you for the new access code
i e s coe for an entry.
]

[

Delete an Access Code

Dircctory Click the Delete button to remove
(7)) aeyousueyeuwsindnse s | @ Selected access code.
.
2 Click Apply and then OK.

—End--

Status codes
Status Codes provide information about the user or the extension. The

status codes can be selected for an entry and displayed in the Directory
window.

Figure 32 "Status display window" (page 56) shows the Status display
window.

Use Procedure 16 “Creating Status Codes” (page 55) to create status
codes for a selected entry.

Procedure 16
Creating Status Codes

Step Action

1 Click Status Codes.
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Status Codes

Figure 32
Status display window

Coawrs | Ui Dot | i | igcmns Cocen  Statn Coden |
bk T

apked 83 drwctony sy
A word or short ph:qase

that idenifies the stalus ~ ~ v_j_l“. TN L e A Mtecat

such as Vacation or In.

explains what the stalus

fears These Help topics contain green_
underlined text. You can click the
green text to see descriptions for
crealing and assigning statuscodestoa
user.
Add New Status Code
[ =1
Prompts you for the new status code
Erler a new Malus code -_
_t | for an entry.
!rlll---
Delete a Status Code
.
@ s Click the Delete button to remove
R the selected status code.
_w |

2 Click Apply and then OK.

-~End--

Editing a directory entry
Use Procedure 17 “Editing a directory entry” (page 56) to edit or modify
any Directory tab displays.

Procedure 17
Editing a directory entry

Step Action

1 Double click the directory entry to display additional Directory
tabs.
© 7328 williams, Pat
2 Click Edit. Make the appropriate changes.
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3 Click OK to accept changes.

—End--

Deleting a directory entry
Use Procedure 18 “Deleting a directory entry” (page 57) to delete a
directory entry.

Procedure 18
Deleting a directory entry

Step Action

1 Double click the directory entry you wish to delete.
D 7328 Williams, Pat
Click Delete.
Click Yes to confirm deletion.
4 Click OK.
--End--

Exporting Directory dialing numbers
Use Procedure 19 “Exporting Directory numbers” (page 57) to export
Directory numbers.

Procedure 19
Exporting Directory numbers

Step Action

1 Click Directory to select Export.

Figure 33 "Export display window" (page 58) shows the Export
display window.

2 Click New to enter a name for the new export job.
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Figure 33
Export display window

Enimanme e renegotih

’ Iwﬂ

. . Click Edit (Figure 24) lo modify file
L~ information and columns for the exported

v m:'m..m*m
Tip Bt A Lfew |

Click the Help button fo directory job
see information on MAT ——
Exporting jobs using ) "\ 1)t o vt e
the Contents, Index, o
and Find tabs ! =l
Click Delete fo remove an export
directory job.
Figure 34 "Export Job display window" (page 58) shows the
Export Job display window.
Figure 34
Export Job display window
e
¢ Cmetmen o |
Dutput Fia o _
s L S Indicate file information
=T =~ - - -(default is Comma
;_,":dm o e e ot e Separated) and output
w w1 " .
‘% wecaed cchewn file name or location
Double dlick on & of the export job.
column ilem to move it
quickly between “not Select the columns you want
displayed” to included in the export file.
“displayed’ areas

3 Click OK.

~End--

Importing Directory dialing numbers
Use Procedure 20 “Importing Directory dialed numbers” (page 58) to
import Directory numbers.

Procedure 20
Importing Directory dialed numbers

Step Action

1 Click Directory to select Import.

Figure 35 "Import display window" (page 59) shows the Import
display window.

2 Click New to enter a name for the new import job.
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Figure 35

Import display window

¢

Click the Help bulion
lo see information on
Importing jobs using
the Contents, Index

and Find tabs.

Figure 36

Highlight one of the import § Bun I
m.:;nhhﬂmh'::\
omumndh?um Cancel I
selactad b Tha irformation  tha | .-
gt e vell ot b adeved in ary Hew
ey,
g | &
Do |} -

(D)

W | ot b i

o]
s Cocd ’

Click Edit (Figure 24) to modify file

= information and columns for the imported

directory job.

)

Click Delete 1o remove an imporl
direclory job

Figure 36 "Import Job display window." (page 59) shows the
Import Job display window.

Import Job display window.

J

Tp

Double click on a
column item to move it
quickly between “not
displayed to
displayed areas

Fim Irdmnation

oo, fm=scm)
Cploem _

S s T
Chugeas Fite N =
[Prerton T Aerdans PED 42 =

L e

3 Click OK.

- — = Indicate File Information (defaultis

Comma Separated) and Output File
Name or location of the import job.

Select the columns you want
included in the import file.

—End--

Changing a directory number (DN)
The Change DN function enables you to quickly access and transfer a

directory entry to a new directory number as shown in Figure 37 "Change

DN display window" (page 60).

Use Procedure 21 “Changing a Directory number” (page 59) to change an
existing directory number.

Procedure 21

Changing a Directory number

Step Action

1 Click Directory to select Change DN.
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The Change DN dialog box is displayed. See Figure 37 "Change
DN display window" (page 60).

Figure 37

Change DN display window

Indicate the new DN (dialing number) for a direct

entry. All directory information is transferred

mff,:&"&mmﬁ? ,?W to the new DN.

drectry cmation s Brom, Judy el be i .

barchened to e new DN ﬂ.’ Click the Help button to see Help Topics on
changing the DN using the Contents, Index,

NewDt _t | and Find tabs.

l L] =D

5 i g e e [
V' Change o diectony entiss forfis DN gy iy
2 Click OK.

--End--

Searching the directory
Use the Search Directory function to locate directory entries by name or
directory number See Figure 38 "Search Directory display" (page 60).

Figure 38
Search Directory display

Indicate a name, first or last, or

Search lor;

s o DN and click OK to start the
— search process.

& Mame [Laat. Feat)

oo

. Eust name, Last name

Using information screens
Up to fourteen information screens can be defined, to give additional
information on entries in the directory.

Use Procedure 22 “Creating an information screen” (page 60) to create
an information screen.

Procedure 22
Creating an information screen

Step Action

1 Select Properties from the Directory menu.
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The "Directory Properties" window appears.

Select the Info tab.

Type a label for each information screen to be created.
Click OK.

—End--

Use Procedure 23 “Adding information to an information screen” (page
61) to add information to an information screen.

Procedure 23
Adding information to an information screen

Step Action

1 Double-click the directory entry where you wish to enter
information.

2 Click on the information screen tab you have defined to which
you wish to add information.

3 Enter the information.
Click OK.

—End--

Use Procedure 24 “Adding information using the Information menu” (page
61) to add information using the information menu.

Procedure 24
Adding information using the Information menu

Step Action

Select the directory entry for which you want to view information.

Click on the Information menu and select the information tab to
which you wish to add information.

Enter the information.
Click OK.

—End--

Use Procedure 25 “Accessing an information screen” (page 62) to access
an information screen.
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Procedure 25
Accessing an information screen

Step Action

Select the directory entry for which you want to view information.

Click on the Information menu and select the information tab
you wish to view.

3 Click OK when finished.

—End--

Logging off the Attendant PC
Use the Log off function when you are ready to end your time at the
console. All of your personal console settings such as the ToolBox,
Directory and customized features (lists) are automatically saved.

For further information on any of the Tools topics discussed in this section,
consult the Help Facility.

Table 3 "Help facility subjects" (page 62) lists some Help facility topics.

Table 3
Help facility subjects
To learn about... Search the Help Index for...
Setting up the directory display dial
Ordering entries in the directory dialing a number
Searching the directory column label
Assign a status code status
Dialing out dial
Building a Toolbox toolbox
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Working with the Config menu

Contents
“Description” (page 63)
“Configuration menu” (page 63)

“Console Configuration” (page 64)

“Interface properties” (page 81)
“Configure Port” (page 85)
“Change Password” (page 86)

Description

This section describes how to set up your Attendant PCconsole, discusses

considerations that affect how you configure your console and presents
a series of step-by-step procedures designed to familiarize you with the

fundamental aspects of configuring your console.

Conzole Configuration...
Interface Propetties...
Configure Port...

Change Password..

Configuration menu
The Config menu displays four commands:

* Console Configuration

Lets you set up your Virtual Features, ICI, and TGB keys.

* Interface Properties

Lets you specify voice volume, call waiting, handset, relay and

diagnostic characteristics.

* Configure Port
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64 Working with the Config menu

Enables you to select a COM port for the Attendant PC.
®* Change Password

Permits you to set passwords for multiple attendants.

Console Configuration
When you select Console Configuration, Attendant PC displays the
following tabs:

* General * Flex keys
* ICI * Hotkeys

* ICl keys * Consoles
* TGB * Attendants
* TGB keys * Features

The General tab

Within the General tab, the system administrator or attendant must provide
a response to each of the following items listed on the General page. See
Figure 39 "General tab display" (page 65). This ensures that your console
is fully configured. The following items except the password (optional)
must be supplied:

g

Requires an assigned
access number
assignmentbefore the mail
tool can be displayed on
the main console display

Make sure that End-fo-
End Signalling (EES) is
defined as a fiexible
feature

Select the location and
WAV file for audible
signalling by opening the
folder icon. 5]
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* Enter the access number for Express Mail.

* Click the check box if a password is required to operate the Attendant
PC.

* |ndicate the location and name of the default WAV file for audible
signaling.

* Indicate the pause length, in milliseconds; the duration of a delay that
is generated when a comma appears in a typed-in number for dialing.

Figure 39 "General tab display" (page 65) shows the General Tab display
window.

Figure 39

General tab display
Fexkeys | 1018 | iCikeys | TGB: | TGBKew
Genedl | Hokeys | Concdles | Atlendsnts | Festees

Erder the acces: number lor Expres: Mad
I”O arngnment hene

The EES Inatue i recuired to enable the voice mal system Il the EES
feature it not defined, o  the Expeess Mal access number i not entered, the
woice mad tool will not appear on the dislog.

Viosce Ml maibxn number lemination flag: |“

| T Paswoick ace tequaied

Dalault WAY s 1o b played tor sudble signaling. Click the Play button to hear
[ ARV SR et e EN0 the selected default sound.
5ok 1 pi et lerghh in llsaconcle. This s the leeighh of rsa colayed whana | | w
comma [] i encountered durng dising
4 Tip
: Click the Help button to see a list of
o] cos | i ) general configuration options

Use Procedure 26 “Configuring the Voicemail icon” (page 65) to configure
the Voicemail icon.

Procedure 26
Configuring the Voicemail icon

Step Action

1 First, ensure that End-to-End Signaling (EES) is set up as a
flexible feature by verifying it is listed in the Feature List under
the Tools menu.

2 Choose Console Configuration... under the Config menu.
Select the General tab.
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4 Type the access number for Express Mail in the appropriate text
box.

—End--

The Hotkeys tab
Hotkeys allow you to assign shortcut keyboard commands to commonly
performed tasks.

Use Procedure 27 “Creating a HotKey” (page 66) to create a hotkey.

Procedure 27
Creating a HotKey

Step Action

Select Console Configuration from the Configuration menu.
Select the Hotkeys tab.

Select a task from the hotkey Activities window.

Select New Hotkey .

gaa b~ W N P

Type the new hotkey shortcut. To select a two or three key
combination hotkey press and hold one or more of the Alt, Ctrl,
and Shift keys then press the desired hotkey.

6 Click OK to exit.

Figure 40 "Hotkey tab display" (page 67) shows the Hotkeys
display window.
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Figure 40

Hotkey tab display

Hotkeys tab [Merigiant Attendant PC Connigurtor 3]
Fleckeys | ICs | ICikeys | TGB: | TGEKep:

| General Hotkeys | Corsoles |  Aendsnts | Festuies

Uze thiz page to customize the hotkey assignments, To assign a new holkey,
select an activity from the list below. click on the “New Hotkey' button, and
press the key of key combination to be azsigned to that actiity,

To select a key combination such as AR+F3, press and hold sither Alt key,
piess the F3 key, then release both keys

Note: There are a few keys that, although valid, are probably
not good choices for hotkey assignments. These would
include the F1 key, single key hotkeys that are numbers, and
other keys that you would normally use in the day to day
operation of your console. A two key combination such as
Alt+H is always preferable to a single key such as H.

—End--

The Consoles tab

The Consoles tab is where you register the Attendant PC console
software and define the WAV file used for audible signalling. See Figure
41 "Consoles display window" (page 68).

Consoles |

Enter the following information:

® console serial number

* full name of the console

* name of WAV file designated for audible signaling

Figure 41 "Consoles display window" (page 68) shows the Consoles
display window.
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Figure 41

Consoles display window

Ti
We encourage you to
register your Attendant

¥ i (Moridiant Antendes PC Configus slor
PC application by Pexken | 10 | Kikes | T68: | TGBKem
telephane as soon as Gensial || Hotags Anpedarts | Fesure:
you have installed the e
software. {21000 I
Ful Mo
IMa-n kobby - West wang
H i’
Select the Iocallgn and N i :
WAV file for audible ,W«r-.bbw-s\mmmum Exclmiionmavt =]
signalling by opening the  } 4 '
. = P Seial Number. 41000 ‘
folder icon .- eSO .
Flegistered Mo Tral paod expaes one 373/97 ‘
Click Register to display
the Console Registration ] =y o
form [ ok ]| coaea | | Heb

Click the Play button to hear
the selected default sound.

Click Register to display the Console Registration window. Provide the
registration code and note your company’s name, address, installation
code, and serial number before you telephone the software manufacturer.

The Attendants tab

The Attendants tab displays a security page that allows privileges to each
person identified by role and full name. A indicates specific access rights
for individual user profiles.

Altendants

4

Figure 42 "Attendants display window" (page 69) shows the Attendants
display window.
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Figure 42

Attendants display window

Click each level of access
rights for a new or existing
attendant

To add an additional
attendant, click New. A
“New Attendant’ dialog box
is displayed as shown
below. The user name is
limited to 20 characters

Add Attendant

Mewe Attenaam

Endor the new afendant id

[Define 10 her

Faker | i | OFsn | T8 | TGERem
Genmdl | Hokes | Conscles Avendarts | Fastest

Faghts

 Logon 1o a conusle F Edt loatisns

= Edt genasal pavamein ~ Edeicis

¥ Add/edt sn sttendant F Ed TGE:

¥ Edt a contole ¥ Eda drectery idomation

R
[Con ] cwed | o0 | Wb |

Tip
Click the Help button to see a list of
Attendant properties and descriptions

or user ID.

New Attendant Password v

[Asion Paswerora

Delete New Attendant 4

T e vous s vons w40 et (e stroruinee?

== |

from the list of identified attendant users.

The Features tab
The Features tab displays the following flexible features that are
programmed in advance by the system administrator:

| Featues ‘
* Auto Dial
* Barge-In
* Busy Verify

* Calling Party Number

e Controlled Class of Service

Prompts you for the new attendants name

You can assign a password for each new
attendant. Assigning a password is optional.

Click the Delete button to remove an attendant

Automatic Wake-Up
Break-In

Call Park

Charge Account
DID Route Control
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Figure 43

* Display Calls Waiting

* Display Source

* Malicious Call Trace

* Message Indication

* Paging

* Speed Call Controller
* Stored Number Redial

Display Destination
Do-Not-Disturb Group/Individual
Message Cancellation

Meter

Routing Control

System Speed Call Controller

Use Procedure 28 “Adding a flexible feature” (page 70) to add a flexible

feature.

Procedure 28
Adding a flexible feature

Step Action
1 Make a list of up to twenty features you would like on your
Attendant PC Console.
Note: Every preferred feature must be programmed in
advance on the system for use from your PC workstation
display.
2 Select Features to access the Features script page.

A page is displayed with blank areas for entering the feature
description, label, and type (Virtual or Flexible Feature Key).

Figure 43 "Features display window" (page 70) shows the

Features display window.

Features display window

After you have
definedyour fealure
key and click OK,
your new fealure is
displayed in the
features list

Flexkeys | 102 | wre= | ToB: | TCEKan
Genemsl | Hotkeyn | Comscler | Aleedarts Featuer
Th d bty Wik 1
Adtortark PC tystem U
[Aerviard J1omoAs Lok ctmsd [T | = I
gym In|gIH; £
roak In [BET]
By Viewdy [EVF
Call Park PRE] LI

Charge Account [CHG)
Cortsoled Class of § (cos)
D10 Foute Corversion [DFEC)
(Dvisplay Call 'Wasting [D'WEC)
Display Date [DOTH

D tign [DPD))

(Display DPS)

(Dizpdagy T (D TM]

D Mot Datush Geoup [GND)

01 Mot Disturb Irdeadusl (DOL |

End o End Signaling [EES)

18 ot s Charges/Deingay T (M TH)

Miskcious Cal Toace [TRT) =

or | Caxd |

([«

. e |
. 1 Pk
% [T

* Click Edit to modify a flexible
*. key feature assignment

'Clack Remove fo delefe a flexible

key fealure assignment. .
]

9 Mn-m--n—-!lu—w‘lﬂ!'llhﬁ

=1 4T

Click Help for detailed instructions
on adding a new fealure

3 Click OK. Your feature is now displayed on:
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* the Features page of the Console Configuration menu,
shown above in (Figure 43 "Features display window" (page
70))

* the Flex Keys list, shown in Figure 43 "Features display
window" (page 70).

Note: Many of these features described later in this section
are defined briefly in the section “List of terms” (page 223).

—End--

Creating Virtual feature keys

One of the key benefits of the Attendant PC is the ability to create Virtual
(or customized) features to consolidate multiple keystrokes into one
keystroke.

For example, when placing a call to a pager using a M2250 Attendant
Console, several key presses are required:

* select a loop key

e dial the pager number

* pause for 2 seconds

* press the End-to-End Signaling key

® input your return number

* end with the pound key (#)

* press the Release button

Creating a Virtual Feature for the above functions allows you to execute
the functions with a single keystroke.

Use Procedure 29 “Creating a Virtual feature key” (page 71) to create a
Virtual feature key.

Procedure 29
Creating a Virtual feature key

Step Action

Choose Console Configuration from the Configuration menu.
Select the Features tab.

Click New.

Complete the following information:

A WO DN B
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* Type a description of the feature in the Feature Description
text box.

* Type the label that is to appear on the console in the Key
Label text box.

® Select Virtual in the Type group box.

5 Click Processing.

Figure 44 "Feature Specification window" (page 72) shows the
Feature Specification window.

Figure 44

Feature Specification window

Feature Specification

Feature Description
Cancel |
Kew Label:
B .
Jan's Pager Processing |
Bemove |
Type
& Mirtual Help |

 Flexible feature key

™ Masterfeature (cannot be altered)

6 Select the steps that make up the virtual feature.

Figure 45 "Processing Procedure window" (page 72) shows the
Processing Procedure window.

Figure 45

Processing Procedure window

Jan Dee's Pager - Processing Procedure

Disconnect Audio in from X EEmGVE Dial Murmber
Disconnect Audio in from TX
Disconnect R from Audio out
Disconnect T from Audio out
Pause for 2 seconds

Press aflexible feature key Help
Press anICl key

Press Release _:,[

Awailable procassing steps Selected Steps
Connect.Audiointo RxX - Selectan idle loop Cancel
ConnectAudiointo TX Dial & number (Static)

Connect R to Audio out Add | Pause for 2 seconds

Connect TX to Audio out Press aflexible feature key Flex Select
Dial a number (Dynamic) Dial a number (Static)

Dial a number (Static) Press Release

d

Prass the active lnnn

Highlight the appropriate processing steps in the Available
Processing Steps list box and click Add. The steps appear in
the Selected list box. Use the Remove button and the Arrow
buttons to edit the Selected list box.
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Figure 46

7

Define each step in the Selected list box that requires a flexible
key, an ICI key, or a number to be dialed.

To assign flexible keys for the steps, click Flex Select. For
each step entitled "Press a flexible feature key," select the
appropriate flexible key from the Key list box. When all

flexible keys have been assigned for the required steps, click
OK.

Figure 46 "Flex Key Selection window" (page 73) shows the Flex
Key Selection window.

Flex Key Selection window

Flex Key Selection

You have selected one or mare flexible feature keys to be pressed for this virtual

oK
feature. Selecta "Press a flexible feature key" step in the "Steps" listthen select _
the feature key to be pressed for that step from the "Keys" list.

Steps:

Cancel

[ ey |
b |

Keys: Help

Selectanidle loop
Dial & number (Static)
Fausze for 2 secands

lewible feature key
Dial & number (Static)
Press Release

To assign ICI keys, click ICI Select. For each step entitled
"Press an ICI key," select the appropriate ICI key from the

Key list box. When all ICI keys have been assigned for the
required steps, click OK.

To assign phone numbers, click Dial Number. For each
step entitled "Dial a number (Static)," enter the number to be

dialed. When all numbers have been entered for the required
steps, click OK.

Figure 47 "Static Dialing Assignment window" (page 74) shows
the Static Dialing Assignment window.
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Figure 47

Static Dialing Assignment window

Static Dialing Assignment

Y'ou have selected one or more static dialing steps for this virtual feature. oK
Highlight each of the "Dial & number (Static)" steps in the "Steps” list then enter
the number to be dialed for that step.

Steps:

Cancel

Help

di

Selectanidle

Dial a number (Static)
Pause for 2 seconds
Press aflexible feature key
Dial & number (Static)
Press Release

Enter the number to be dialed.

{408) 555-1212

Click OK.

To use the Virtual Feature, locate and double-click the light-blue
shaded Virtual Feature from the Feature List.

—End--

The Flex Keys tab
You can assign features called Flexible Features to Flex Keys which
enable you to access flexible features quickly.

Flex Kegs ||

Figure 48 "Flex Keys display window" (page 75) shows the Flex Keys

window.

Use Procedure 30 “Displaying features assigned to Flex Keys” (page
74) to display features assigned to Flex keys.

Procedure 30
Displaying features assigned to Flex Keys

Step

Action

1

Click the button to access the pull-down menu that displays one
Flexible Feature chosen by you for each key number.
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Figure 48

[

The Flexible Features defined here have been predefined in
advance by systems staff for the system.

Flex Keys display window

Assign a flexible
fealure to a flex key
number and click
OK.

Mot Attendant PC Corfigur st or

Geowdl | Hotkeys | Conecdes | Aendals | Festues

P | goh | ks | T8 | TBEKen

Conscle |Man ks et weg

r‘n [Baegetn e 2 a0 [sesescapsec) E|

S [ 3 1 |Sooed Cal Cortoler (5001 5]

2 [|Cal Pask [PRE) d ¥

3 bumber [CPHI 3] gy | atione |

[} 5 14 [ Hoee | .

5 2 g [etiona il —

§ [EndwErdSorateg £ES) 3] g [ Hore El B

7 [ Mok T EN s

g [Meziage 2 g | etoes: | - - -

\_ 9 [RoungC 2 g ctiones |
Note: The k made bere must manch g 2 mace =
on the Mendon 1.
Click Help on how to assign Flex Keys
[ o ]| cowe | *ﬂ?“ Io the PC console screen
To view the key or lamp that you will use to activate the feature:
2 Select Feature List from the Console screen’s Tools menu
The new feature is displayed as a light blue lamp symbol in the
Features List window. See Figure 43 "Features display window"
(page 70).
—End--
The ICI tab

Adding an ICI key enables you to create labels and edit some features of
ICIs. ICls are designated in the System by systems staff, then assigned to
a key in the console. This list is displayed when you select the ICI's List
from the Console Configuration menu. The following procedure shows
you how to list the ICI features that are available. The available ICI keys

are:
ICls
e Dial "0" * Call Forward No Answer;
Call Forward Busy
* Intercept * Interpositional Call
* Listed Directory Number * LDO (local line 0), LD1
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Message Center

Recall

TIE, WATS

Fx (Foreign Exchange)
Figure 49 "ICls display window" (page 76) shows the ICI display window.

Figure 49
ICls display window

Meridiant Attendant PC Configurator

Homeys |  Comoles |  Amendsrs |  Festues
Flexkeys 1Cls | ckes | T6E: | TGEKes Click New fo create an IC| description,
_ These CallIndicalcrs aee cumently defived lo exis tiew | Key Label and path {o the location
Lists the ICIs that PR M LA St of the WAV file designated for audible
have been created & |

D T
VIP

signalling.
EE S Click Edit to modify a new or existing
. [Cldescription

.

using the New button.

i

T

"Click Remove 1o delete an ICI
key description

.
-

Meruban] Altendant PC Confupaaton

;f;) i o e st hark 10 vemene 101 “WATS ™
Ho |

Click Help on how fo assign ICI Keys
to the ICI Feature List,

o ]

Cancel

Note: ICI2 must be defined in your System in order to assign ICI keys
from 10 to 19. For further information regarding ICI2, consult your
system administrator.

Use Procedure 31 “Adding an ICI key” (page 76) to add an ICI key.

Procedure 31
Adding an ICI key

Step Action

1 Click New. The ICI Specification window opens.

Figure 50 "ICI specification window" (page 76) shows the ICI
Specification window.
Figure 50

ICI specification window

Tip .
101 S pocidscation | x|
The path and localion 161 Dwsciphon e
of the default directory fore Corced
where ihe larget WAV El‘%;l%‘—
files reside are shown el , Click Help for detailed
as el Pricty 10 Lowest. 99 - Hghaut [0 information on ICI specifications
LS A::..lww-nhuh-dlu.nﬁm
* | = P ANOCWS DU he Scaooctt Sournd mae = [»] Click the Play button to hear
T Mashe insiurm fcarrct be shered] the selected default sound
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2 Define a new ICI Description, Key Label and path to the location
of the default WAV file designated for audible signalling.
3 Click OK to save the ICI key.

The key label entry you created is now displayed on the ICI list
that you selected from the Tools menu.

ICIs List

e

=)

=)
=)

4 Click the ICI Keys tab to associate a new ICI key with each
number from 0 to 19 as described earlier for "Flex keys" on “The
Flex Keys tab” (page 74).

Click OK to save the ICI key.

Select the ICI List from the Tools Menu to see the new
oval-shaped button associated with the ICI key assignment you
just made. You can see a sample ICI List in Figure 51 "ICI Keys
display window." (page 78).

—End--

The ICI Keys tab

Figure 51 "ICI Keys display window." (page 78) displays the ICI Keys
window on which you can pair up to twenty ICI's with one of the key
numbers (just two ICI keys are defined in this sample window).

Dl

To view the ICI Keys display bar, click the to associate an ICI key with
each number from 0 to 19.

[

Select the ICI List from the Tools Menu to see the new oval-shaped
button associated with the ICI key assignment you just made.

Figure 51 "ICI Keys display window." (page 78) shows the ICI Keys display
window.
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Figure 51
ICI Keys display window.

Meridiani Attendant PC Configur ator

Lists the TGBs that — l]*“g:" | D II — Il ——
have been assigned
using the New button, 0 | Icode Bhue 2 qa | ctione B Click, then select a number choice
14 foial 0 El n | Hones E| ~ | to associate an IGI key assignment.
2 U'IF' j 12 | Hones ¥ T
3 13| cHone> et s e | Gy
4 Icrlme> d 14 I <Mone> 1C3 Eapn
5 I +Monss j ‘5 I <Monas Jow o s b w1 by Tl ansgrmets s @ 5008wtk S bay aesgpeerts 5 b Mesdke
5 I Morseo J 5 I prrowy Wt "re cunore dea bt (208 et be ot o O 4 wse (0
7 I(Mcﬂn 3 7 I cHone -
g | cHone> H qg | cone & Lo b i e gty kb s b
.3 I <M j 13 I cMone s
m@(mmmum' doemation in the Mendan 1
COB vt be conligured for IC12 to wre IC1 10 theu 19
: Click Help on how o assign IC| Keys
0K | Concel to the ICI Feature List

The TGB tab

TGBs (Trunk Group Busy) keys enable you to deny users access to trunk
groups and have calls to those trunk groups sent to your console instead.
The lamps in the TGB list window show the status of each group of trunks.
You can create up to ten trunk group busy (TGB) keys that deny users
access to one or more trunk groups from 0 to 9.

s

Figure 52 "TGBs display window." (page 79) shows the TGB display
window.
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Figure 52
TGBs display window.
General | Hotheys | Comsoles | AMendants | Feshues
Flexken | I0: | ICKes | T68: | TGBKep A Click New 1o create a TGB description
Lists the TGBs that o R A P Y eteecte . [ Rer ) and ey Label
have been created g |
using the New o e Bemove | ‘.’
button T pk ncp 2 P Click Edit to modify a new or existing
AATS [Wade Suma Talecom] *. TGB desc;jplian
" Click Remove to delete an TGB
key description,  «’
\?.') mmmn':-n—.u-nmwr-
o R |
Click Help on how to add a new TGB
o | cowes | o m_’ key 1o the console

Note: The customer data block (CDB) must be configured for ICI2 to
use TGB keys.

Use Procedure 32 “Adding a TGB key” (page 79) to add a TGB key.

Procedure 32
Adding a TGB key

Step Action

1 Click New to bring up the popup dialog shown in Figure 53 "TGB
Specification window" (page 80).

2 Define a new TGB Description and Key Label.
Click OK to save the TGB key.

TGBs List

'R"?i
e |

The key label entry you created is now displayed in the
TGB list that you select from the Tools menu.

Figure 53 "TGB Specification window" (page 80) shows
the TGB Specification window.
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menu

Figure 54
TGB Keys display window

Figure 53
TGB Specification window

TGB Spachication

-im e |:--i

TGE
|nE nk growp 1 [ ™
Koy Labet SR L 1 i it P g
II:E\ W ' oy S B (3 o b St L4 o " e
PN
By et hname
L] Wb 0 e e R
fee v

Click Help for detailed
information on TGB specifications

While still in the TGBs window click the TGB Keys tab to
associate a new TGB key with each number from 0 to 19 as
described for Flex Keys on Figure 48 "Flex Keys display window"

(page 75).

Ty

Figure 54 "TGB Keys display window" (page 80) shows the TGB
Keys display window.

Meridiant Aftendant PC Configurator

Geowal | Hotheys | Comles | Mendats | Fostees
Pakes | 10 | Wres | TGB: TG8 Keyn
Lists the TGBs that o) [0 Kerwalice) 5 10 [<Hone: | Selec! a number choice i
haw been ass‘gned JTIE tun 1 _-J | tHoney _-] "
sing the New : e saed L - associate an TGB key
Jand 2 [T mrk pop 2 S5 az ] ones | assignment
buton 5 |TE vk g 3 =l g3 [ e E|
A [WATS (Wide dvea Telecom) 5] 94 | Hones |
5 [EECI | 5 [ e 2
g | MNoe A g | e |
7 [ Hoow 2z [ e E|
g | cHones 3 g [ tione |
5 | Hoow =l [ e |
Please note:
Thase TGH aes it i tha 1.
CDB must bo corfgured for 1012 1o e TGE. |
[T | Heb Click Help on how to add TGB Keys
5 Click OK to save the TGB key.

TGBs List
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6 Select the "TGB List" from the Tools Menu to see the new
shaped "button" associated with the TGB key assignment you
just made.

K

~End--

Interface properties
The Interface Properties screen displays five tabs, each of which allows
you or your system administrator to perform a different setup task.

The Alerter tab

The Alerter page allows you to control alert tone characteristics. The
system plays the alert tone for operator alert conditions, including incoming
calls.

shows the Alerter display window.

Alerter ||
Figure 55

Alerter display window

% Alerter | CallWaiting | Handset | Relay | Diagnostics |
J TP:eseseﬂisgscorhdH’elomMispﬂa}edfofimMcaﬁs
Indicate a in and other attendant alert conditions.
the box for enabling To Cor oompws Lomwe we
of alert tones I dnterface provides dlert tones ree Lo L= T T w1
w
 ~Vokme e Tt Sz o o 8 bne rnates vy B vence ot sy

-

Adjust volume and

pitch with slide setlings e

using the mouse.

e

x|

Cancel |

Click Help on how to configure alert
tones for incoming calls

Note that the above screen provides:
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* acheck box to indicate that you want alert tones provided

®* mouse-operated slides on the screen to set volume and pitch levels

Call Waiting tab

The Call Waiting tab allows you to notify the system whether you want a
Call Waiting tone via a check box. In addition, a mouse-operated slide is
provided so you can determine the volume of the Call Waiting tone.

Call Wating

Figure 56 "Call Waiting display window" (page 82) shows the Call Waiting
display window.

Figure 56
Call Waiting display window

Aletter CalWaiting | Handset | Reloy | Disgnostics |
These settings control the tone that is played for waiting calls,

Indicale a q’ in the
box for enabling of alert I™ Itestace provides Cal W ading tonel

tones Volume
;‘ J I Click Help on how to configure alert
tones provided by the inferface unit
Adjust volume and pitch for Call Waiting
with slide settings using
the mouse

Inturiace provides aler tones
Wi it s i Chech e

- bos

To return to the list of
topics, click Help Topics

Volume slde

Handset tab
You have a choice of connecting any of three receiving units to the
Attendant PC:
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Handset

* Handset
®* Headset 1 (one earpiece)
* Headset 2 (two earpieces)

Click the name of the device you intend on using on the Handset page
shown in Figure 57 "Handset display window" (page 83).

Note: Make sure you plug the headset or handset into the Attendant
PC correctly. If you plug it in upside down, callers will not be able to
hear your voice.

Figure 57
Handset display window

Melidian 1 Attendant PC Interface [ %]

Alester | Call Wailng [ Handset | Relay | Diagrostis |

Select the device thal is curently connected to the
interface.

L Docimes Cptees bl

" Handsat Wooloem] Bes | Bw | & b |

(" Headset1 =

" Headset 2

.
] Click Help indicate the type of device
| oK I Cancel | ool I " Hep 1Y you are using and set he volume for
B yoice communication

Note: You must make a choice when you are using a headset. Carbon
headsets are not supported.

* Headset 1 — applies to the Plantronics-type headset

* Headset 2 — applies to the Liberation/GN Netcom-type headset

Relay tab

The Attendant PC uses relays to configure how a telephone may

be answered when the attendant is not available, such as during an
emergency (fire, earthquake), or off-hours (night or weekend service). For
example, a recording may play during a call, and a night/weekend call may
be transferred to someone in the company’s security personnel. Each
relay triggers the applicable program from the system software.
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Figure 58

Relay ||

Figure 58 "Relay display window" (page 84) shows the Relay display
window.

Relay display window

Indicate 2 4/ in the
box for enabling
General Purpose
Relay

Menidian 1 Attendant PC Interface E

Bletter | Call Waiing | Handset [Fieky | Diagnostics |

Select the desired state of the Meridian 1 Attendant PC Tin o1 Gosmod Qptoms tho
interface's Genesal Puipose relay. Haip Tngses] [ o= | s« [ » |
Paiery

b

RS ™ General Purpose Relay

the General Purpose relay and fo view
the current state of the Night Service

| 0K I Cancel Lol _ and Emergency relays.

| Click Help for information on setting

Diagnostics tab
The Diagnostics tab allows you or the system administrator to perform
the following actions:

Diagnostics

* Self Test button to initiate a diagnostic self test on the PC Console
Interface Unit (PCCIU).

* Reset button to reset the PCCIU to its default status.
Note: Performing a Reset could result in loss of current information.

* Send LoopBack button to check communication between the
Attendant PCand the system.

Figure 59 "Diagnostics display window" (page 85) shows the Diagnostics
display window.
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Figure 59
Diagnostics display window

Mendian 1 Attendant PC Interface E3
Aletter | Call Waiting | Handset | Relay [ Diagnoshics |
~ Self Test

Press the Self Test button o run a diagnostic test on
interface untt

Eie L[o* Ooshgen Optons  Help
[V Lopen]  Gace B | w | o |

[T —

r— Reset =

Press the Reset bulton to force the interface unt to per]
aresel. ”

CAUTION: Cument information may be lost

| _I ] T Click Help for information on running
x | ot | 'ﬂ!! a diagnostic test on the interface unit
or fo reset the interface unit.

Configure Port
The Configure Port option listed on the Config menu allows you to select
a COM port which is required for your Attendant PC.

Conllg
Congole Configuration. .
Interface Properias
Configure Bort.

Chiangs Password.

An open COM port permits a connection between your PC workstation and
the Attendant PC.

Figure 60 "COM Port display window" (page 85) shows the COM port
display window.

Figure 60
COM Port display window

Meridian 1 Attendant PC

Wwihich COM port iz the interface
attached ta?

C COM1 € COM3
& COMZ ¢ COM4
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Change Password
The Change Password option listed on the Config menu allows you to
enter a new password and verify the change by reentering the password.

Figure 61 "Change Password display window" (page 86) shows the
Change Password display window.

Figure 61
Change Password display window

Hew Password
—IEIId password——————————————
Cancel |

— Mew pazsword

Fieenter the new password

For further information on any of the Console Configuration topics
discussed in this section, consult the Help Facility.

Table 4 "Help Facility subjects" (page 86) lists some Help Facility subjects.

Table 4

Help Facility subjects
To learn about... Search the Help Index for...
Editing general parameters General

Requiring a password
Setting up the voice mail icon

Attendants TGBs
Edit TGBs

TGB List

Adding a flexible key to the PC Features

console screen
Building an attendant’s toolbox
Creating a virtual feature

Adding an ICI key to the PC console ICls
screen

ICI Keys

editing ICls
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Attendant PC call processing

Contents

“Answering a call” (page 88)

“Extending a call to an idle extension” (page 89)

“Extending a call to a busy extension (with Camp-on)” (page 90)
“Extending a call to voice mail” (page 91)

“Extending a call to a busy extension (with Hold)” (page 92)
“Holding a call on a loop key” (page 93)

“Call Park” (page 94)

“Timed recall from an unanswered extended call” (page 96)
“Timed recall from an unanswered parked call” (page 97)
“Recall from an extension using LINK or ATT RECALL” (page 98)
“Recall from an extension using Transfer” (page 99)

“Recall from an extension using Conference” (page 100)

“Recall to Same Attendant” (page 101)

“Calling an extension” (page 101)

“Calling an outside number” (page 102)

“Trunk-to-trunk call” (page 103)

“Through-dialing” (page 104)

“Conference” (page 105)
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“Calling another attendant” (page 107)

“Transferring a call to another attendant” (page 108)

“Break-in (post-dial)” (page 109)

“Break-in (pre-dial)” (page 112)

“Break-in (busy verify)” (page 114)

“Sending a warning tone to an extension in line lockout” (page 115)
“Requeueing a call to the next available attendant” (page 116)
“Timed Reminder Recall” (page 117)

“Centrex/Exchange Line Switchhook Flash” (page 118)
“Remote Call Forward” (page 118)

“Call Forward/Hunt Override” (page 120)

“Attendant Console Autoline” (page 120)

“Individual Attendant Directory Number (IADN)” (page 122)
“Attendant Emergency Codes” (page 123)

“Recovery on Misoperation of Attendant Console” (page 123)

Answering a call
Calls are queued in order of arrival. All calls are presented to loop O if idle.
If a call on loop 0 has been placed on hold, the next call in queue will be
presented to loop 1, and so on. A maximum of six calls may be processed
or held on the console.

O (o5 JI1>
O (Lot JA1>
O (Lo Ja>
O (o2 Je3 >
O ([opt )AL
O (op0 J<3 1>

Use Procedure 33 “Answering a call” (page 89) to answer a call.
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Procedure 33
Answering a call

Step

Action

You receive a call and hear a tone. The Source indicator flashes.

Click the appropriate loop indicator. The tone stops and the
Source indicator goes on steadily; you are connected to the
caller.

Note: To give priority to a certain type of call, answer by
clicking the ICI key rather than an idle loop key. You are
connected to the call regardless of its place in the queue.

~End--

Extending a call to an idle extension
After you have answered a call, you can extend it to the extension the
caller requests.

Use Procedure 34 “Ending a call to an idle extension” (page 89) to end
a call to an idle extension.

Procedure 34
Ending a call to an idle extension

Step

Action

Dial the requested extension.

To end your connection before the called party answers, click the
Release button immediately. If the called party does not answer
within a set time (usually within 30 seconds), you are recalled.
Otherwise, wait for an answer. The Destination indicator lights
steadily upon answer.

e
BB
(e [727) (g
[*]) e [#)

Release

Click the Release button to connect the caller and called party
and to end your connection to the call.
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90 Attendant PC call processing

—End--

Extending a call to a busy extension (with Camp-on)
After you have answered a call, you can extend it to the extension the

caller requests.

Use Procedure 35 “Extending a call to a busy extension(with Camp-on)”
(page 90) to extend a call to a busy extension (Camp-on).

Procedure 35
Extending a call to a busy extension
(with Camp-on)

Step

Action

1

Dial the requested extension.

The Excl Src indicator lights during dialing. The Destination
indicator flashes; the extension is busy.

OBEE
GlElE
] 1] g
(=) P[]

Do one of the following:

a If you do not hear a busy signal and the caller wishes to wait,
you can camp the call onto the busy extension by clicking the
Release button. If you do hear a busy signal after dialing the
requested extension, either a call is already camped onto that
extension, or Camp-on is not allowed on that extension.

The indicator goes on; you are free to process other calls.

| Rls Dstl

b If you do hear a busy signal after dialing the requested
extension and the caller wishes to call back later, click the
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Rls Dst button, and then the Release button to end your
connection in the call. The Destination indicator goes off; the
called extension is released from the console. The Release
indicator goes on; you are free to process other calls.

Note: If a camped call is not answered within the set time, it is
returned to you.

—End--

Extending a call to voice mail
If a called party does not answer and/or a call is recalled to the attendant,
you can extend the call to voicemail.

Use Procedure 36 “Extending a call to voicemail” (page 91) to extend a
call to voicemail.

Procedure 36
Extending a call to voicemail

Step Action

1 Dial the requested extension.

I
BIEIS)
o) (120 o]
() Pe)(e)

55

2 If the party does not answer or the call is recalled to the
attendant, drag the number from the display and drop it on the
Voicemail icon in the toolbar. You can also drag a number from
the Directory and drop it on the Voicemail icon in the toolbar.

Note: If the Voicemail icon does not appear in the toolbar,
contact your system administrator.

—End--
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Extending a call to a busy extension (with Hold)
To extend a call to a busy extension which is not allowed camp-on, or
which already has a call camped onto it, you can place the caller on hold.
You must then reenter the call periodically to see if the extension is free.

Use Procedure 37 “Extending a call to a busy extension (with Hold)” (page
92) to extend a call to a busy extension (Hold)

Procedure 37
Extending a call to a busy extension (with Hold)

Step Action

1 Dial the requested extension.

The Excl Src indicator in the Feature List goes on during dialing.
You hear a busy signal and the Destination indicator flashes; the
extension is busy and not allowed camp-on.

DEE
DEE
B
=) e )

2 Click the RIs Dst button.

The Destination indicator goes off; the called extension is
released from the console.

Fls Dstl

3 Do one of the following:

a If the caller wishes to call back later, click the Release button.
The Release indicator goes on; you are free to process other
calls.

Release

b If the caller wishes to wait, click the Hold button, then the
Release button to end your connection in the call. The loop
indicator flashes slowly. The Release indicator goes on; you
are free to process other calls.
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Hold

4 Check periodically to see if the extension is free. To reenter the
call, click the loop key beside the slowly flashing loop indicator,
then dial the extension again.

The loop indicator goes on steadily.
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—End--

Holding a call on a loop key
In some cases you may receive a call from someone who wishes to be
transferred to several different extensions in turn. You can hold the call
on a loop key so that the caller remains connected to your console when
the called party hangs up.

Use Procedure 38 “Holding a call on a loop key” (page 93) to hold a call on
a loop key.

Procedure 38
Holding a call on a loop key

Step Action

1 Dial the requested extension.

The Excl Src indicator in the Feature List goes on during dialing.
You hear ringing. The Destination indicator flashes slowly.
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2 Click the Hold button before or after the called party answers.

The loop indicator flashes slowly.
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3 Click the Release button to free yourself to answer calls on other
loop keys. The Release indicator goes on.

The called party answers.

The Destination indicator goes on steadily. The loop indicator
continues to flash slowly.

4 When the called party hangs up, the Destination indicator goes
off. Click the loop key beside the slowly flashing loop indicator
to reenter the call.

The loop indicator goes on steadily. The Destination indicator is
off; you may extend the call to another party.

Note: When you only wish to put a call on hold, answer it,
click the Hold button, and then Release.

~End--

Call Park
Call Park enables you to put a call on hold without occupying a loop
key on your console. You can, for example, hold a call on a Call Park
extension while paging a called party.
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Use Procedure 39 “Holding a call on Call Park extensionwhile paging a
called party” (page 95) to hold a call on Call Park extension while paging a
called party.

Procedure 39
Holding a call on Call Park extension
while paging a called party

Step Action

You wish to park a call, perhaps because the caller requests you to page
someone.

1 Click Park from the Feature List.

* Feature List M= E3

Wiew Help

Other...

Feature

The Park indicator in the Feature List goes on.
2 Do one of the following:

a If a Call Park extension is available, it is assigned to the call
and displayed automatically. Make a note of the call and the
Call Park extension. The Destination indicator flashes slowly.

b Click the Release button. Page the called party and deliver
the Call Park extension. (An unanswered parked call is
returned to your console after a set time.) The Destination
indicator goes off; the call is parked. The Release indicator
goes on.

| Beleasei

¢ If no Call Park extension is available, nothing is displayed.
Either take a message or place the call on Hold.

The Destination indicator flashes.

—End--
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Timed recall from an unanswered extended call
If a called extension does not answer within a set time (usually 30
seconds), the call is automatically returned to your console. The recall
Incoming Call Indicator (ICI) goes on to signal this type of call.

Use Procedure 40 “Using timed recall from an unanswered extendedcall”
(page 96) to use timed recall from an unanswered extended call.

Procedure 40
Using timed recall from an unanswered extended

call

Step

Action

1

You receive a timed recall from an unanswered extended

call. Click the Loop key beside the flashing Source and slowly
flashing Destination indicators. The tone stops and the Loop and
Source indicators go on steadily; you are connected to the caller.
You hear ringing at the called extension. The recall ICl is on.
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Click the RIs Dst button. Ringing at the called extension stops.
The Destination indicator goes off.

Rls Dstl

Do one of the following:

a If the caller does not wish to wait, click the Release button.
The Release indicator goes on; you are free to process other
calls.

Release

b If the caller wishes to wait, dial the extension again. (If the
caller wishes to be transferred to another extension instead of
waiting or calling back later, you can dial a new number now.)
The Excl Src indicator in the Feature List goes on during
dialing. The Destination indicator flashes slowly.
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Click the Release button to end your connection in the call. The
Release indicator goes on; you are free to process other calls.

—End--

Timed recall from an unanswered parked call
A parked call, if unanswered, is returned to you after a set time.

Use Procedure 41 “Using timed recall from an unansweredparked call”
(page 97) to use time recall from an unanswered parked call.

Procedure 41
Using timed recall from an unanswered

parked call
Step Action
1 You receive a timed recall from an unanswered parked call. Click

the Loop key beside the flashing Source and slowly flashing
Destination indicators. The tone stops and the Loop and Source
indicators go on steadily; you are connected to the caller. The
recall ICI, and call park indicators are on.
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Do one of the following:

a If the caller wishes to remain parked, click the Release
button. The call is parked on the original call-park number.
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The Release indicator goes on; you are free to process other
calls.

Release

b If the caller wishes to end the call, click the Rls Dst button,
then the Release button. The call is unparked. The Source
indicator goes off and the Release indicator goes on; you are
free to process other calls.

| Rls Dst!

—End--

Recall from an extension using LINK or ATT RECALL
An extension user, while talking to someone on the phone, may recall
you by clicking ATT RECALL, or by clicking LINK once and dialing your
number, depending on the type of extension. The recall ICI goes on.

Use Procedure 42 “Recalling an extension using LINK orATT RECALL”
(page 98) to recall an extension using LINK or ATT RECALL.

Procedure 42
Recalling an extension using LINK or
ATT RECALL

Step Action

1 You receive a recall. Click the Loop key beside the quickly
flashing Destination indicator. The tone stops and the Loop and
Destination indicators go on steadily; you, the party originating
the call, and the original caller are connected. The recall ICI and
Source indicators go on.
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2 Click the RIs Dst button (if the recaller has not already released).
The Destination indicator goes off; the recaller is disconnected.

IF"S Dstl
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3 If the caller wishes to be transferred, dial the new extension.
The Excl Src indicator goes on during dialing. The Destination
indicator flashes slowly.

4 Click the Release button to end your connection in the call. The
Release indicator goes on; you are free to process other calls.

Note 1: This recall procedure describes a call that was
originally extended through your console (Source and
Destination indicators both active).

Note 2: If you wish to activate the Secrecy feature, which
excludes the caller until connected to the called party, click
Excl Src before extending the call.

~End--

Recall from an extension using Transfer
An extension user, while talking to someone on the phone, can recall you
by clicking Transfer and dialing your number. The recall ICI goes on.

Use Procedure 43 “Recalling from an extensionusing Transfer” (page
99) to recall from an extension using Transfer.

Procedure 43
Recalling from an extension
using Transfer

Step Action

1 You receive a recall. click the Loop key beside the quickly
flashing Source indicator. The tone stops and the Loop and
Source indicators go on steadily; you and the recaller are
connected. The recall ICI is on.
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2 When the recaller clicks Transfer again, you and the original
caller are connected. If the caller wishes to be transferred, dial
the new extension. The Excl Src indicator goes on during dialing.
The Destination indicator flashes slowly.

3 Click the Release button to end your connection in the call.
The Release indicator goes on; you are free to process other
calls. Recall from an extension using Conference.

(=) ==
(=) (=) =)
= =) o)
[«] o) | #])

(__Release)

—End--

Recall from an extension using Conference
An extension user, while talking to someone on the phone, can recall you
by clicking Conference and dialing your number. The "0" ICI goes on.

Use Procedure 44 “Recalling from an extensionusing Conference” (page
100) to recall from an extension using Conference.

Procedure 44
Recalling from an extension
using Conference

Step Action

1 You receive a recall. click the Loop key beside the quickly
flashing Source indicator. The tone stops and the loop and
Source indicators go on steadily; you and the recaller are
connected. The "0" ICl is on.
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2 When the recaller clicks Conference again, you, the recaller, and
the original caller are connected. If the original caller wishes to
be transferred, dial the new extension. The Excl Src indicator
goes on during dialing. The Destination indicator flashes slowly.

3 Click the Release button to end your connection in the call.
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Release

Note: This recall procedure describes a call that was not
originally extended through your console (Source indicator
active, Destination indicator off).

-~End--

Recall to Same Attendant
This feature functions the same way as normal call recall, with an
enhancement. Previously, calls recalled to the first available attendant.
With this feature enabled calls you extended can be queued to return to
you only when you are idle. If you are busy, the calls remain in queue until
you are available. The following are types of calls and recalls that can be
queued to you for recall:

* |nterattendant calls * Meter recalls
* Slow answer recalls e Park recalls
*  Camp-On recalls * Call Waiting recalls

Calling an extension
You can place a call to any extension within the system.

Use Procedure 45 “Calling an extension” (page 102) to call an extension.
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Procedure 45
Calling an extension

Step Action

1 Click an idle Loop key. The loop indicator beside it goes on.
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2 Dial the extension. You hear ringing. The Source indicator
flashes slowly. When the called party answers, ringing stops and
the Source indicator goes on steadily.

3 Click the Release button to end the call. The Release indicator
goes on; you are free to process other calls.
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~End--

Calling an outside number
You can place a call to a number outside the system by dialing a trunk
access code followed by the desired number.

Use Procedure 46 “Calling an outside number” (page 102) to call an
outside number.

Procedure 46
Calling an outside number

Step Action

1 Click an idle loop key.
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Trunk-to-trunk call
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The loop indicator beside it goes on.

Dial the required trunk access code. You hear dial tone. The
Source indicator goes on.

Dial the outside number. You hear ringing. When the called
party answers, ringing stops.

Click the Release button to end the call. The Release indicator
goes on; you are free to process other calls.
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| Release i

—End--

A user, while outside the system, can call to request access to an outgoing

trunk.

Use Procedure 47 “Making a trunk-to-trunk call” (page 103) to make a
trunk-to-trunk call.

Procedure 47
Making a trunk-to-trunk call

Step

Action

1

You answer an incoming trunk call and the caller requests
access to an outgoing trunk. Dial the trunk access code, then
dial the requested number.

The Excl Src indicator goes on during dialing. You hear dial tone
after dialing the trunk access code, and ringing after the number.
The Destination indicator goes on steadily. When the called
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party answers, you may talk privately. The Destination indicator
remains on. The Excl Src indicator remains on.
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2 Click the Release button to connect the calling and called
parties. The Release indicator goes on; you are free to process
calls on other loop keys.

Note: If neither of the trunks involved in the call has answer
supervision, the call is automatically held on the loop key.
When both parties hang up, the Source and Destination
indicators remain on. Click the loop key and then RIs Src from
the Feature List and RIs Dst and Release again.

—End--

Through-dialing
Extension or tie line users may request access to numbers or trunks which
they are restricted from accessing themselves. Once you have accessed
the trunk, the user is free to dial out. You can provide through-dialing to all
but fully restricted extensions.

Use Procedure 48 “Using through-dialing” (page 104) to use
through-dialing.

Procedure 48
Using through-dialing

Step Action

1 You receive a call from a restricted extension or tie trunk. Click
the loop key beside the quickly flashing Source indicator. The
tone stops. The loop key and Source indicators go on steadily.
The appropriate ICl is on.
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2 The caller requests access to a trunk. Dial the required trunk
access code and listen for dial tone. The Excl Src indicator goes
on during dialing. The Destination indicator is on steady.
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3 Do one of the following:

a You can now complete the call by dialing the required
number. Click the Release button to connect the call back to
the restricted user. The Release indicator goes on; you are
free to process other calls.
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b After hearing dial tone, click the Release button to end your
connection. The user can now dial the number. The Release
indicator goes on; you are free to process other calls.

—End--

Conference
You can set up a conference call for as many as six people, including
yourself, at the request of either an extension user or an outside caller. A
maximum of two trunks can be in the conference at one time.
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Use Procedure 49 “Setting up a conference call” (page 106) to set up a
conference call.

Procedure 49
Setting up a conference call

Step

Action

1

Click an idle loop key and dial the number of the first conference
party. The loop indicator goes on. You hear ringing. The Source
indicator flashes slowly. When the first party answers, the
Source indicator goes on steadily.
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Dial the number of the next conference party. The Excl Src
indicator goes on; the first party is automatically placed on hold
while you dial. The Destination indicator flashes slowly. When
the second party answers, the Destination indicator goes on
steadily.
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Click Conf. (Repeat steps 2 and 3 to add more parties to the
conference.)

The Excl Src and Destination indicators go off; you and the first
two conference parties are connected.

Do one of the following:

a If you want to hold the conference at your console, click
the Release button. The loop indicator flashes slowly. The
Source indicator remains on. The Release indicator goes on;
you are free to process other calls.
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Feature
List
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b If you want to release the conference from your console,
click the Rls Src button, then the Release button. The loop
indicators and Source indicators go off. The Release indicator
goes on; you are free to process other calls.

Note: To reenter a conference that is being held at

your console, click the loop key beside the flashing loop
indicator. To end the conference call, click the loop key
beside the flashing loop indicator, the Rls Src button, then
the Release button. The console should be in normal
mode when setting up a conference.

~End--

Calling another attendant
With this feature, you can call another attendant in your multiple-console

group.

Use Procedure 50 “Calling another attendant” (page 107) to call another
attendant.

Procedure 50
Calling another attendant

Step Action

1 Click an idle loop key.
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The loop indicator goes on.

Dial the attendant access code.

Dial the appropriate attendant code. You hear ringing. The
Source indicator flashes slowly.

4 The called attendant answers. click the Release button when
you wish to end the call. Ringing stops. The Source indicator
goes on steadily. The Release indicator goes on; you are free to
process other calls.

Note 1: If you dial an incorrect attendant code, you hear a fast
busy signal and the Source indicator stays off. Click Rls Src.

Note 2: If the called attendant is busy, you hear ringback and
the Source indicator flashes slowly. Continue to wait and your
call will be the next call presented to that attendant.

Note 3: If the called console is in position-busy or
night-service mode, your call cannot be completed. You hear
a fast busy signal and the Source indicator stays off. Click the
Release button.

—End--

Transferring a call to another attendant
With this feature, you can transfer a call to another attendant in your
multiple-console group.

Use Procedure 51 “Transferring a call toanother attendant” (page 108) to
transfer a call to another attendant.

Procedure 51
Transferring a call to
another attendant
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Step Action

1 The person to whom you are speaking wishes to speak to
another attendant. Dial the attendant access code, then dial the
appropriate attendant code.
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Release l

The Excl Src indicator goes on; the caller is automatically placed
on hold. The Destination indicator flashes slowly. The Loop and
Source indicators are on.

2 When the called attendant answers, click the Loop key.

The Excl Src indicator goes off and the Destination indicator
goes on steadily; you, the called attendant, and the caller are
connected.

3 Click the Release button to end your connection in the call. The
Release indicator goes on; you are free to process other calls If
you dial an incorrect attendant code, you hear a fast busy signal
and the Destination indicator stays off. Click the RIs Dst button.

Note 1: If the called attendant is busy, you hear a busy signal
and the Destination indicator continues to flash slowly. Click
the Release button to transfer the call to the attendant’s
queue.

Note 2: If the called console is in position-busy, you hear a
busy signal and the Destination indicator flashes slowly. Click
the Release button.

—End--

Break-in (post-dial)
You can interrupt an existing connection in order to offer a call or relay an
important message to one of the parties.
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Use Procedure 52 “Using Break-in (post-dial)” (page 110) to use Break-in
(post-dial).

Procedure 52
Using Break-in (post-dial)

Step

Action

Someone calls you and requests that you relay a message or extend the call to
someone already on a call.

1

Dial the requested extension.
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The loop key, ICI, and Source indicators go on steadily. The
Destination indicator flashes, indicating that the extension is
busy. The Excl Src indicator goes on steadily while you are
dialing.

Click Break-In from the Feature List to interrupt the connection.
If the extension is idle, the Break-In indicator goes off, and you
hear ringing.

| Rls Dstl

Do one of the following:

a If the break-in is temporarily denied, you hear busy or fast
busy tone, and the Break-In indicator flashes. Click the Ris
Dst button. You can attempt a post-dial break-in after a few
minutes or another pre-dial break-in immediately.
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b If break-in is denied completely, you hear a fast busy signal.
Click the Rls Dst button.

You are in a three-way connection with the two parties in the
established call. Relay the message, or announce the incoming
call.

Do one of the following:

a Click the Excl Dst button to speak privately with the caller
without ending the three-way connection.

b Click the Release button to end the three-way connection
and remain connected to the caller.

Release

it

Release

c Click the Release button to end your connection in the call.
The incoming call is camped-on if the called party is still
busy, or extended if the called party’s extension is idle. The
Release indicator goes on; you are free to process other
calls.

Note 1: If the requested extension does not allow
camp-on, the following can occur:

* You hear a busy signal when you dial the
extension. Refer to step 1.

* The Destination indicator continues to flash when
you click Break-In. Refer to step 2.

®* You cannot extend the call or camp on to the
extension. Refer to a. Click the RIs Dst button and
redial the extension to extend the call.

Note 2: If the call is from an internal source, you cannot
extend the call or camp on to the extension. Refer to b.
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Note 3: Click the RIs Dst button and redial the extension
to extend the call or camp on to the extension.

—End--

Break-in (pre-dial)
You can interrupt an existing connection in order to offer a call or relay
an important message to one of the parties. Use break-in (pre-dial)
for extensions that have make set busy, do-not-disturb, hunting, or call
forward activated.

Use Procedure 53 “Using break-in (pre-dial)” (page 112) to use Break-in
(pre-dial).

Procedure 53
Using break-in (pre-dial)

Step Action

Someone calls you and requests that you relay a message or extend the call to
someone already on a call.
1 Click Break In from the Feature List.

Feature]Se
List

The Loop, Break In, ICI, and Source indicators go on steadily.

2 Dial the requested extension. The Excl Src indicator goes on
steadily while you are dialing. The Destination Lamp indicator
flashes, indicating that the extension is busy.
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3 In the Feature List, click Break In to interrupt the connection.
Do one of the following:
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‘ Rls Dstl

a If the extension is busy, the Break In indicator goes off, and
you hear ringing.

b If the break-in is temporarily denied, you hear busy or fast
busy tone, and the Break-In indicator flashes. Click the Ris
Dst button. You can attempt a post-dial break-in after a few
minutes or another pre-dial break-in immediately.

c If break-in is denied completely, you hear a fast busy signal.
click the Rls Dst button.

Feature m
List T' ne

Release i.

You are in a three-way connection with the two parties in the
established call. Relay the message, or announce the incoming
call.

Do one of the following:

a Click Excl Dst to speak privately with the caller without ending
the three-way connection.

b Click the Release button to end the three-way connection
and remain connected to the caller.

¢ Click the Release button to end your connection in the call.
The incoming call is camped-on if the called party is still busy,
or extended if the called party extension is idle. The Release
indicator goes on; you are free to process other calls.

-~End--
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Break-in (busy verify)

You can check whether an extension is busy or idle before you attempt
to break in.

Use Procedure 54 “Using Break-in (busy verify)” (page 114) to use
Break-in (busy-verify)

Procedure 54
Using Break-in (busy verify)

Step Action

Someone calls you and requests that you relay a message or extend the call to
someone already on a call.

1 Click an idle loop key.
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The loop indicator goes on.
2 Click Break In from the Feature List.

Feature] ye ne
List

The Break In indicator goes on.

3 Dial the extension you wish to check. If the DN is idle, you
hear ringing, the loop indicator flashes slowly and the Break-In
indicator goes off. Click Break-In to break in.

OBEE
GlElE
B
Blulo
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If the DN is disabled or unassigned, you hear a fast busy signal
(overflow tone) and the loop key and Break-In indicators go off.

If the DN is busy, you hear a busy signal and the loop indicator
flashes. Click Break-In to break in.

If the DN is busy, the Break-In and loop indicators are steadily
lit. You hear the intrusion tone.

You are in a three-way connection with the parties in the
established call. You can speak to the person on the extension.

4 Click the Release button to end your connection in the call. The
Release indicator goes on; you are free to process other calls.

Release i

—End--

Sending a warning tone to an extension in line lockout
When a handset is left off a telephone for an extended period of time, the
telephone goes into a state called line lockout.

Use Procedure 55 “Sending a warning toneto an extension in line lockout”
(page 115) to send a warning tone to an extension in line lockout.

Procedure 55
Sending a warning tone
to an extension in line lockout

Step Action

1 Click an idle loop key.

O (Ltops Ja 1>
O [(Lept JI1>
O Loz JI1>
O Loz Jeqt»
O (o1 J<dL»
O (Ltopo Jeat>

The loop indicator goes on.
2 Click Break In from the Feature List.
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Feature] v e
List t

The Break In indicator from the Feature List goes on.
3 Dial the extension you wish to check.

@EE
=) =)
[re=) [72%] e
(*] Pe]l =)

A fast busy signal (overflow tone) is heard at the console.

4 To break in to the extension, click Break In from the Feature List.
The Break-In indicator from the Feature List goes off.
5 Click the Release button.

The warning tone is sent to the extension.

Note 1: You cannot cancel the warning tone. It stops after
a certain period of time, or when the telephone’s handset is
put back on the hook.

Note 2: You cannot break in to an extension that is already
receiving the warning tone.

—End--

Reqgueueing a call to the next available attendant
You can requeue an incoming call or recall to the next available attendant.

Use Procedure 56 “Requeueing a call to thenext available attendant” (page
116) to request a call to the next available attendant.

Procedure 56
Requeueing a call to the
next available attendant

Step Action

1 You receive a call.
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The ICI indicator goes on and the Source indicator flashes. The
call is queued to the next available attendant.

2 If the system is in Night Service, the call is queued to the next
available Night Service number.

—End--

Timed Reminder Recall
Timed Reminder Recall calls you after a period of time to remind you that
a transferred call has not yet been answered.

Use Procedure 57 “Using Timed Reminder Recall” (page 117) to use
Timed Reminder Recall.

Procedure 57
Using Timed Reminder Recall

Step Action

1 You receive a call for transfer. Dial the desired extension.

) )
(o) o) )
) (x2) )

(<)) (=)
| Release i

The Destination Lamp winks.

2 Click the Release button before the extension answers.
This starts the recall timer. If the extension answers the call, the
timer stops.

3 If the extension does not answer, you receive a reminder call.

The source lamp flashes and the destination lamp winks.

4 Click the Source key to connect with the calling party. If the
dialed extension answers while you are on the line, a conference
is established. You can then complete the transfer. If the called
party does not answer, you can release the source call.

—End--
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Centrex/Exchange Line Switchhook Flash
Centrex Switchhook Flash (THF) allows you to signal the Central Office
during an established call to request activation of a Centrex service such
as call transfer or three-way calling.

Use Procedure 58 “Using Centrex/ExchangelLine/Switchhook Flash” (page
118) to use Centrex/Exchange Line/Switchhook Flash.

Procedure 58
Using Centrex/Exchange
Line/Switchhook Flash

Step Action

1 Click the Switchhook Flash key.
You hear a special dial tone.
2 Click the DN before the tone ends.

When you hang up, or click the Release button, the original
connection and the THF message terminate.

—End--

Remote Call Forward
Use Procedure 59 “Using Remote Call Forward” (page 118) to use Remote
Call Forward.

Procedure 59
Using Remote Call Forward

Step Action

1 Click an idle loop key followed by Attendant Remote Call
Forward (RFW) in the Feature List.

O (o5 Jeat>
O (tops Jea b
O (o3 Jea >
O ((Lep2 J<3 >
O (Ltoop1 JIL>
O (o0 Ja 1>

The RFW key is flashing. The loop key is steadily lit.
2 Dial the DN of the set to be forwarded.
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If the password is required, the RFW key is winking, and the
console display shows PWD. If the console does not support
alpha characters, the attendant display will be blank.

If the password is not required, the console display will display
the DN of the set to be forwarded followed by the CFW DN
stored on that set. The RFW key lamp will display the status of
the CFW DN. If RFW lamp is flashing, then CFW is not active; if
RFW lamp is steady lit, then CFW is active. Proceed to step 4.

Dial the password required followed by #.

DEE
DEE
B
BIGID

The console display will display the DN of the set to be
forwarded followed by the CFW DN stored on that set. The RFW
key lamp will display the status of the CFW DN. If RFW lamp is
flashing, then CFW is not active; if RFW lamp is steadily lit, then
CFW is active.

The user can now enter a new CFW DN or click the RFW key to
activate or deactivate the stored CFW DN.

If a new CFW DN is entered, it must be preceded by an RFW
key click. The console display will display the DN of the set to
be forwarded followed by the CFW DN. If RFW lamp is flashing,
then CFW is not active; if RFW lamp is steadily lit, then CFW is
active.

When the RCFW operation is in this state, the user has three

options:

a Click the Release button or the RIs Src key from the Feature
List to complete RCFW operation.

b Click the RFW key to reverse the CFW status.

Enter a new CFW DN to begin task of changing the CFW DN
programmed. The new CFW DN is not active until the RFW
key is clicked again.

Click the RFW key again to activate the CFW DN on the display.

If the DN entered is invalid, you hear overflow tone, and the
FRW key indicator flashes. Reenter a valid DN.

Click the Release button.
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This terminates the session. The DN is now forwarded.

—End--

Call Forward/Hunt Override
Use Procedure 60 “Using Call Forward/Hunt Override” (page 120) to use
Call Forward/Hunt Override.

Procedure 60

Using Call Forward/Hunt Override

Step

Action

Dial the FFC for Call Forward/Hunt Override.
Dial the DN of the wanted party.

If the telephone is idle, the display(s) is updated.

If the display on the originating telephone is updated when
the call is answered, the Call Forward/Hunt Override FFC will
no longer display.

If the dialed telephone is busy and Hunt is active, the calling
party will terminate on the wanted telephone and will receive
a busy signal.

If the dialed telephone is idle but does not answer within the
defined number of ringing cycles for Call Forward No Answer,
the call is not forwarded (continues to ring).

If the dialed telephone is busy, the attendant can activate
Camp-On, if Camp-On is applicable. In addition, Ring
Again can be placed against a telephone for which Call
Forward/Hunt Override was used and a busy telephone was
encountered.

—End--

Attendant Console Autoline
Use Procedure 61 “Placing an Autoline call” (page 120) to place an

Autoline call.

Procedure 61

Placing an Autoline call
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Step Action

1 Click an idle loop key.

O (o5 J1>
O (Lops JA >
O Loz JI1>
O Loz Jeqt»
O (o1 J<I 1>
O ([Lop0 )< >

The loop indicator is lit.

2 Click Autoline from the Feature List. The pre-programmed
Autoline number is automatically dialed. The Source indicator
winks.

The dialed party answers the call, and the Source indicator is
steadily lit.

-~End--

Use Procedure 62 “Extending a currently active callto the Autoline DN”
(page 121) to extend a currently active call to the Autoline DN.

Procedure 62
Extending a currently active call
to the Autoline DN

Step Action

1 Click Autoline from the Feature List.
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122 Attendant PC call processing

The pre-programmed Autoline number is automatically dialed.
The Destination indicator winks.

The dialed party answers the call, and the Destination indicator
is steadily lit.

2 To complete the transfer, click the Release button.

Release i

—End--

Individual Attendant Directory Number (IADN)
Use Procedure 63 “Answering an IADN call” (page 122) to answer an
IADN call.

Procedure 63
Answering an IADN call

Step Action

1 Click IADN from the ICI List. The first IADN call in the queue is
answered.

CIC] List 3|
wiew Help

I Code Blue

I—iDial "0"

—viF

= ADN

-~End--
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Attendant Emergency Codes
Use Procedure 64 “Answering an emergency code call” (page 123) to
answer an emergency code call.

Procedure 64
Answering an emergency code call

Step Action

1 You receive Priority Buzzing. Check the ICI List to see which
type of emergency calls are indicated by lit ICls.

CICl List 3]
Wiew Help

I Code Blue

= Di=l 0"

=F

=a0m

2 Click the appropriate ICI key which designates the emergency.
The call is answered, for example, Code Blue.

~End--

Recovery on Misoperation of Attendant Console
The Recovery on Misoperation of Attendant Console feature provides a
safeguard on CS 1000 systems to prevent calls from being inadvertently
disconnected.
Clicking the Release key or loop key is ignored when:
* Extending a call to a vacant number
* Extending to a partially dialed number
* Extending a Network blocked call
* Extending a call to a restricted station or trunk
* Extending to a station in the Do Not Disturb (DND) mode
* Extending to a station in the Make Set Busy (MSB) mode
* Extending to a maintenance busy station
* Extending to a station in a line lockout state
* |llegal call extension due to trunk barring

* Extending to a busy station with no Camp-on/Call Waiting
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lllegal call extension due to Trunk-to-Trunk Conference Restriction

lllegal release from a conference connection

Note: When using Autohold on the loop key, the active loop is
automatically placed on hold if the attendant clicks another loop key
prior to extending the active call. The Autohold key does not allow the
disconnection of a single excluded party or conference call. If one of
the parties on a loop is excluded, the operation of the corresponding
Release Source Key or Release Destination Key is ignored.
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Features

Table 5 "Attendant PC features" (page 126) lists the Attendant PC
features which are available for attendant operations, provided they are
programmed in advance on the system switch.

Table 5
Attendant PC features
* Attendant Blocking of Directory * Attendant Break-in Busy indication
Number and prevention
* Attendant Monitor * Auto Dial
* Automatic Wake Up * Barge-In
*  Busy Verify * Charge Account
* DID Route Conversion *  Do-Not-Disturb
* End-to-end signaling * Enhanced Night Service
* Enhanced Secrecy * Malicious Call Trace
* Night Service * Paging
*  Position Busy * Radio Paging
*  Semi-Automatic Camp On *  Series Call
* Speed Call *  Speaking privately (Splitting)
*  Stored Number Redial *  System Speed Call

Attendant Blocking of Directory Number
Use Procedure 65 “Blocking a DN” (page 126) to block a DN.

Procedure 65
Blocking a DN

Step

Action

The attendant clicks an idle loop key.

The attendant clicks Semi-automatic Camp-on (SACP) from the
Feature List.

The SACP indicator goes on.

The attendant dials the source DN that is to be blocked. If the
dialed DN is idle, the DN lamp will have the same state as a

call put on hold, but the DN will not ring. If the DN is busy, the
attendant hears busy tone and the SACP indicator darkens.

If the dialed DN is idle, it is blocked. The DN lamp indicates

a call on hold state, although the DN will not ring (for analog
[500/2500-type] telephones, there is no indication that the DN is
blocked.) On the Attendant Console, the SACP indicator remains
lit and the Source indicator begins blinking.
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If the dialed DN is busy, the attendant clicks the Release button
or RIs Src to release the call.

—End--

Use Procedure 66 “Placing an outgoing callfor the blocked DN” (page
127) to place an outgoing call for the blocked DN.

Procedure 66
Placing an outgoing call
for the blocked DN

Step Action

1 The attendant establishes a call to the desired destination in the
normal way.
2 The attendant clicks SACP (or Sig Src) from the Feature List.

The ringback tone is heard.

3 If the source DN answers, the attendant clicks Release to extend
the call between the destination to the source.

—End--

Use Procedure 67 “Releasing a blocked DN” (page 127) to release a
blocked DN.

Procedure 67
Releasing a blocked DN

Step Action

Choose one of the following:
1

a The attendant clicks either SACP or Sig Src from the Feature
List to ring the DN

b The attendant clicks either the Release or Rls Src to release
the source DN, which then becomes idle.

Use Procedure 68 “Notifying a blocked DN of anestablished call” (page
128) to notify a blocked DN of an established call.
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Procedure 68
Notifying a blocked DN of an
established call

Step Action

1 The attendant clicks SACP or Sig Src from the Feature List.

—End--

Attendant Break-in Busy indication and prevention
If an attendant, during a break-in operation, dials a busy extension, the
Attendant Console display provides one of the following customer-defined
indications:

* three dashes, appended to the end of a digit display (if the busy station
is involved in an external call), or

* a mode-digit, appended to the end of a digit display.
The operator can click on the break-in key either before or after dialing

the destination DN. Break-In operates slightly differently in these two
situations.

Attendant Monitor
The Attendant Monitor feature provides modifications to the Busy Verify
and Barge-In features.

Use Procedure 69 “Monitoring a DN” (page 128) to monitor a DN.

Procedure 69
Monitoring a DN

Step Action

Click on an idle loop key. The loop indicator is lit.
Click on Busy Verify in the Feature List. The Busy Verify lamp
is lit.

3 Click on Busy Verify again to enable Attendant Monitor. The

Busy Verify lamp is in the flashing state indicating that the
Attendant Monitor option is enabled.

4 Dial the extension to be monitored. Attendant Monitor is blocked
when:

* the extension is busy or maintenance disabled
* the extension is vacant

* the extension is in some transient state (e.g., Conference or
Transfer)
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* the extension is idle, receiving busy tone, or receiving
overflow tone

* the extension is involved with another attendant
* the extension has activated the Hold key

* the extension is already involved in a monitored call by
another attendant

Attendant Monitor is active when the extension is busy. The
attendant is able to listen to all connected parties. If the
Attendant Monitor Customer Tone is denied (TOD), there is no
indication given to the connected parties that the attendant is
monitoring.

If the Attendant Monitor Customer Tone is allowed (TOA), a
burst of tone is sent to the connected parties every 16 seconds.
When the monitored DN disconnects from the call, Attendant
Monitor is deactivated.

5 Click the Release button to end Attendant Monitor. The Release
lamp is lit, indicating that the attendant is now free to take other
calls.

Deactivation occurs due to any one of the following:
®* The Release button on the Attendant PC is clicked.
* Any DN involved in the monitored call is disconnected.

¢ Any DN involved in the monitored call at the customer
location activated some form of call modification.

—End--

Use Procedure 70 “Monitoring a Trunk” (page 129) to monitor a Trunk.

Procedure 70
Monitoring a Trunk

Step Action

1 Click on an idle loop key.
The loop indicator lights.
2 Click on Barge-in from the Feature List.
The Barge-in indicator lights.
3 Click on Barge-In again to enable the Attendant Monitor.

The Barge-In indicator flashes indicating that the Attendant
Monitor option is enabled.
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Auto Dial

Dial the trunk access code and route member number, then click
on the pound key (#). One of the following occurs:

Attendant Monitor is blocked when the trunk is disabled or
idle.

Attendant Monitor is blocked when the trunk is already being
monitored by another attendant.

Attendant Monitor is active when the trunk is busy. The
attendant is able to listen to all parties on the trunk.

If the Attendant Monitor Customer Tone is denied (TOD),
there is no indication given to the connected parties that the
attendant is monitoring.

If the Attendant Monitor Customer Tone is allowed (TOA),
a burst of tone is sent to the connected parties every 16
seconds.

Click the Release button to end Attendant Monitor.

The Release indicator lights, indicating that the attendant is free
to take other calls.

Deactivation occurs due to any one of the following:

The Release button on the Attendant PC is clicked.
The trunk disconnects.

Any party at the customer location performs some form of call
modification or activates hold.

Any party at the customer location disconnects.
Any trunk involved in the monitored call disconnects.

—End--

After you have stored a number against an Auto Dial key, you can dial it by
clicking on Auto Dial.

Use Procedure 71 “Calling a number using Auto Dial” (page 130) to call
a number using Auto Dial.

Procedure 71

Calling a number using Auto Dial

Step

Action

1

Click on an idle loop key. The loop indicator goes on.
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2 Click on the required Auto Dial key. The Source indicator lights;
the system automatically dials the stored extension.

Note 1: If you wish to display the extension stored for
automatic dialing, click on Auto Dial, then click on Disp Src.

Note 2: You can store a number of up to 24 digits against an
Auto Dial key. If you need to dial more than 24 digits, you can
dial them after clicking on Auto Dial.

—End--

Storing an Auto Dial number

With Auto Dial, you can store a number (including access codes if
necessary) against an Auto Dial key. You can also change a number
already stored against an Auto Dial key.

Use Procedure 72 “Storing an Auto Dial number” (page 131) to store an
Auto Dial number.

Procedure 72
Storing an Auto Dial number

Step Action

1 When all loop indicators are off, click on Auto Dial.
The Auto Dial indicator flashes.
2 Click on Disp Src.

The display shows the number already stored for automatic
dialing, if there is one.

3 Dial the number to be stored for automatic dialing.

Click on the star key (*) after every trunk access code to ensure
a pause for dial tone.

5 Click on Auto Dial again.

The Auto Dial indicator goes off; the dialed extension is stored
for automatic dialing.

—End--

Automatic Wake Up
With Auto Wake-up, you can instruct the system to provide automatic
wake-up calls at requested times. If extension numbers are not the
same as room numbers, you must translate the room numbers into the
corresponding extension numbers.
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Use Procedure 73 “Programming a wake-up call” (page 132) to program
a wake-up call.

Procedure 73
Programming a wake-up call

Step Action

A hotel guest calls to request a wake-up call.
1 Click Automatic Wake Up.

If the displayed number is not the number requiring the wake up
call, dial the proper number now.

The wake up indicator goes on. The ICI, loop, and Source
indicators are on. The current wake-up time, if any, is displayed.

2 Click the pound key (#).

If the wake up indicator remains on steadily, the dialed number
is valid. If it flashes, the number is invalid.

3 If the dialed number is valid, dial the requested wake-up time
using a 24-hour format.

If the wake up indicator remains on steadily, the requested
wake-up time is acceptable. Go to Step 4.

If it flashes, the time is not acceptable. The next available time is
displayed. Go to Step 5.

4 If the requested wake-up time is acceptable, click Automatic
Wake Up again, then click the Release button.

The Release indicator goes on; you are free to process other
calls.

5 If the initial request was not accepted, the next available time is
displayed. Enter the new time, click Automatic Wake Up, then
click the Release button.

The Release indicator goes on. You are free to process other
calls.

Note: If the requested wake-up time is not acceptable to the
system, the display shows alternative wake-up times in this
order:

* 5 minutes earlier than the requested time
* 5 minutes later than the requested time
¢ the first available 5-minute interval before the requested time

—End--
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Canceling a wake-up call
You can cancel a wake-up call that has already been entered into system
memory.

Use Procedure 74 “Cancelling a wake-up call” (page 133) to cancel a
wake-up call.

Procedure 74
Cancelling a wake-up call

Step Action

A hotel guest calls to request that a wake-up call be cancelled.

1 Click Automatic Wake Up. (If the displayed number is not the
number requiring cancellation of the wake up call, dial the proper
number.)

The Automatic Wake Up indicator goes on.

2 Click the pound key (#), then click Automatic Wake Up again. (If
the indicator flashes quickly, no wake-up call was found for the
dialed number, click Automatic Wake Up again.)

The Automatic Wake Up indicator goes off; the wake-up request
is canceled.

3 Click the Release button to end the procedure.

The Release indicator goes on; you are free to process other
calls.

—End--

Unanswered wake-up call notification

If a guest does not respond to the first wake-up call, the system makes
up to two more attempts at 5-minute intervals. If the guest does not
answer after the third call, the system, if option is set, notifies you of an
unanswered wake-up call.

Use Procedure 75 “Notifying an unanswered wake-up call” (page 133) to
notify an unanswered wake-up call.

Procedure 75
Notifying an unanswered wake-up call

Step Action

A guest has not responded to three wake-up calls.

1 You hear a continuous buzz. The Automatic Wake Up indicator
flashes quickly. The extension number of the room that has
failed to respond is displayed.
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To cancel the natification, click Automatic Wake Up.

The buzz stops. The Automatic Wake Up indicator goes off.
Click the Release button.

ThI(Ie Release indicator goes on; you are free to process other
calls.

Note: When you are notified of an unanswered wake-up call,
you may call the room again.

—End--

Making a VIP wake-up call
At the requested time, you will provide a personal wake-up call to a guest
with VIP status.

Use Procedure 76 “Making a VIP wake-up call” (page 134) to make a VIP
wake-up call.

Procedure 76
Making a VIP wake-up call

Step

Action

1

A VIP wake-up call comes in to your console.

You hear a buzz and the Automatic Wake Up indicator fast
flashes. The Display shows VIP.

Click an idle loop key, then click Automatic Wake Up.

You hear ringing, as the VIP’s room DN is dialled automatically.
The Source indicator goes on, and Automatic Wake Up goes off.

If the guest does not answer or the DN is busy, click Release.
The System will retry the VIP wake-up call in five minutes.

If the guest answers the VIP wake-up call, you deliver a personal
wake-up message to the guest.
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Barge-in

Click the Release button when you have finished the personal
wake-up message.

Note: After a maximum of three attempts, if the guest still
does not answer the VIP wake-up call, a message prints on
the background terminal stating that the wake-up was tried,
but unsuccessful.

—End--

With Barge-In, you can verify that a trunk is in working order, or check the
status of the trunk whether it is busy or idle.

Use Procedure 77 “Using Barge-In” (page 135) to use Barge-In.

Procedure 77
Using Barge-In

Step

Action

Click on an idle loop key. The loop indicator goes on.

Click Barge-In in the Feature List. The barge in indicator goes
on.

Dial the required trunk access code and route member number,
then click on the pound key (#). You hear a fast busy signal if
the trunk is disabled or not assigned. You hear a fast busy signal
and the Source indicator flashes if the trunk is blocked in the
network. Attempt Barge-In again in a few minutes.

You are able to speak to all parties and the Source and
Destination indicators go on steadily if the trunk is busy. Parties
hear a warning tone every six seconds.

You hear dial tone, the Source indicator goes on steadily and the
barge in indicator flashes if the trunk is idle.

Click the Release button to end the procedure. The Release
indicator goes on, indicating that you can now take other calls.

Note: Barge-in cannot be used to verify the status of Release
Link Trunks (RLT) used with Centralized Attendant Service
(CAS).

—End--
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Busy verify
With Busy Verify, you can verify that an extension is in working order, or
check the status of an extension whether it is busy or idle.

Use Procedure 78 “Using Busy Verify” (page 136) to use Busy Verify.

Procedure 78
Using Busy Verify

Step Action

Click on an idle loop key. The loop indicator goes on.

Click Busy Verify in the Feature List. The Busy Verify indicator
goes on.

3 Dial the extension you wish to check. You hear a fast busy
signal if the extension is disabled or not assigned.

You are able to speak to all parties and the Source and
Destination indicators go on steadily if the extension is busy.
Parties hear a warning tone every six seconds.

The Source and Busy Verify indicators flash slowly if the
extension is idle. The extension is not rung.

4 Click on Signal Source to ring the extension. If the called party
answers, the Source and Busy Verify indicators go on steadily.

5 Click the Release button to end your connection in the call.

The Release indicator goes on, indicating that you are now free
to take other calls.

—End--

Charge Account
You can assign a Charge Account number to an outgoing call after you
have dialed the call.

Use Procedure 79 “Entering an account numberafter dialing a call” (page
136) to enter an account number after dialing a call.

Procedure 79
Entering an account number
after dialing a call

Step Action

You have dialed an outgoing call for an extension at your location.
1 Click Charge.
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The Destination indicator flashes; the called party is
automatically placed on hold. The charge indicator goes on.

Dial the Charge Account number.

The Destination indicator goes off; the call is automatically
reestablished. The charge indicator goes off.

Click the Release button to end your connection in the call.

The Release indicator goes on; you are free to process other

calls.

Note 1: Charge account numbers may consist of up to 23

digits. The System ignores extra digits.

Note 2: You can also enter Charge Account numbers before

extending incoming calls to extensions.
Note 3: During a Conference call, you can:

® assign portions of the call to different accounts by
entering charge numbers as you add trunks to the

conference

® assign the entire call to a single charge account
number

~End--

DID Route Conversion
Direct Inward Dialing (DID) permits incoming calls from outside lines that

would normally be directed to the console to be routed to a preselected
destination. Incoming DID digit conversion translates the digits that are

actually dialed into digits that correspond to internal extensions. You

can direct calls coming in on DID trunks to a set of extensions that are

programmed as night destinations, or you can direct them to normal
extensions.

Use Procedure 80 “Using DID Route Conversion” (page 137) to use DID
Route Conversion.

Procedure 80
Using DID Route Conversion

Step

Action

1

Click on an idle loop key.

The loop indicator goes on.

Click on DID Route Conv.

The DID Route Conv indicator goes on.
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Do-Not-Disturb

Click on the pound key (#) to see the status of all DID routes.

The DID Route Conv indicator goes on steadily to show that all
routes are in day mode. The DID Route Conv indicator flashes to
show that some or all routes are in night mode.

Dial the route access code to see the status of a specific DID
route.

The DID Route Conv indicator goes on steadily to show that the
route is in day mode. The DID Route Conv. indicator flashes to
show that the route is in night mode.

Click the Release button to cancel the change. All indicators go
off. Nothing is changed.

Click on DID Route Conv to switch between day and night
modes.

All indicators go off. The mode of the DID route is changed.

Note 1: When you turn on Night Service, all DID routes
automatically go into night mode. You can, however, switch
individual DID routes into day mode.

Note 2: If you want to change all DID routes into night mode,
and only some of the routes are in day mode, You have to first
change all of the routes into day mode.

Note 3: If the DID route has been changed at a telephone
(by the system administrator), you cannot change it at your
console.

~End--

An extension in Do-Not-Disturb (DND) mode is free to place calls but
appears busy to all incoming calls. You can put one extension or a
predefined group of extensions into Do-Not-Disturb mode.

Use Procedure 81 “Setting up Do-Not-Disturb” (page 138) to set up
Do-Not-Disturb mode.

Procedure 81
Setting up Do-Not-Disturb

Step

Action

1

Click on an idle loop key.
The loop indicator goes on.
Click on Do-Not-Disturb in the Feature List.

You can now set up individual or group DND. The Source
indicator goes on. The Do-Not-Disturb indicator flashes slowly.
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3 To set up individual DND, dial the extension requesting DND.

4 To set up group DND, click on the pound key (#), then dial the
appropriate group identification code, then click pound key (#)
again.

The Do-Not-Disturb indicator goes off (or goes on if the
extension or group is already in DND mode).

5 Click on Do-Not-Disturb again. The Do-Not-Disturb indicator
goes on; the dialed extension or group is now in DND.

6 Click the Release button to end the procedure.

The loop, Source, and Do-Not-Disturb indicators go off. The
Release indicator goes on.

Note: If you have a Do-Not-Disturb-Grp key, click on the
Do-Not-Disturb-Grp key for the group of extensions you wish
to place in do-not-disturb mode. The Do-Not-Disturb-Grp
indicator flashes briefly, then goes on.

—End--

Use Procedure 82 “Using Do-Not-Disturb” (page 139) to use
Do-Not-Disturb.

Procedure 82
Using Do-Not-Disturb

Step Action

1 Click on an idle loop key.
The loop indicator goes on.

2 To test individual DND, dial the extension previously placed in
DND mode. To test group DND, dial one extension within a
group previously placed in DND. You hear a busy signal. The
Source indicator flashes. The Do-Not-Disturb indicator in the
Feature List goes on.

3 Click the Release button.

The loop, Source, and Do-Not-Disturb indicators go off. The
Release indicator goes on.

—End--

Cancelling Do-Not-Disturb
You can cancel Do-Not-Disturb (DND) for a single extension or for a
predefined group of extensions.
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Use Procedure 83 “Cancelling Do-Not-Disturb” (page 140) to cancel
Do-Not-Disturb.

Procedure 83
Cancelling Do-Not-Disturb

Step Action

1 Click on an idle loop key.
The loop indicator goes on.
2 Click on Do-Not-Disturb in the Feature List.

You can now cancel individual or group DND. The Source
indicator goes on. The Do-Not-Disturb indicator flashes slowly.

3 Do one of the following:

a To cancel individual DND, dial the extension to be removed
from DND mode.

b To cancel group DND, click on the star key (#), dial the
appropriate group identification code, and then click the star
key (#) again. The Do-Not-Disturb indicator goes on. Click on
Do-Not-Disturb again.

The Do-Not-Disturb indicator goes off; the dialed extension or
group is now removed from DND mode.

4 Click the Release button to end the procedure. The loop and
Source indicators go off. The Release indicator goes on.

Note: If you have Do-Not-Disturb-Grp keys, click on the
Do-Not-Disturb-Grp key beside a Do-Not-Disturb-Grp
indicator which is on, to cancel DND for that group. The
Do-Not-Disturb-Grp indicator flashes briefly, then goes off.

—End--

Overriding Do-Not-Disturb
A Do-Not-Disturb indicator which is on tells you that you have dialed an
extension in Do-Not-Disturb mode.

Use Procedure 84 “Overriding Do-Not-Disturb” (page 141) to temporarily
override DND for that call.
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Procedure 84
Overriding Do-Not-Disturb

Step

Action

Click on an idle loop key. The loop indicator goes on.
Dial the extension previously placed in DND mode.

You hear a busy signal. The Source indicator flashes. The
Do-Not-Disturb indicator goes on.

Click on Do-Not-Disturb.

You hear ringing. The Source indicator flashes slowly. The
Do-Not-Disturb indicator goes off. The called party answers.

Click the Release button when you wish to end the call.
The Source indicator goes on steadily upon answer. The

loop and Source indicators go off upon release. The Release

indicator goes on.

Note: To override DND for an extension within a group that

has been placed in Do-Not-Disturb, click on an idle loop

key, click on the appropriate DND group key, then dial the

extension as usual.

—End--

Testing Do-Not-Disturb

When the Do-Not-Disturb indicator goes on steadily, Do-Not-Disturb is

functioning properly.

Use Procedure 85 “Testing Do-Not-Disturb” (page 141) to test
Do-Not-Disturb.

Procedure 85
Testing Do-Not-Disturb

Step Action
1 Click on an idle loop key.
The loop indicator goes on.
2 To test individual DND, dial the extension previously placed in

DND mode. To test group DND, dial one extension within a
group previously placed in DND.

You hear a busy signal. The Source indicator flashes. The DND

indicator goes on.
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3 Click the Release button.

The loop, Source, and Do Not Disturb indicators go off. The
Release indicator goes on. A dnd. group indicator stays

on steadily while the extensions within the group are in
Do-Not-Disturb mode.

—End--

End-to-end signaling
You can send Dual Tone Multiple Frequency (DTMF) signals from your
console to access devices that require Touch tone signalling.

Use Procedure 86 “Sending DTMF signals” (page 142) to send DTMF
signals.

Procedure 86
Sending DTMF signals

Step Action

You have an active call on either the Source loop or Destination loop.
1 Click on EES. The EES indicator fast flashes.

2 Dial numbers on the dial pad.

The connected party receives DTMF signals. Your line display
may display each number you dial. You may hear the tones if
feedback has been defined in software.

3 Click on EES to end the procedure. The EES indicator goes off.

Note: The console can have only one party connected, either
source or destination. Activating any feature that allows or
requires an active party on the loop key (Hold, Call Park,
Charge Account, Release) will cancel end-to-end signaling.

—End--

Enhanced Night Service
Enhanced Night Service modifies the existing Night Service operation by
allowing Public Network (Central Office [CO], Direct Inward Dial [DID],
Foreign Exchange [FEX], and Wide Area Telephone Service [WATS])
trunks to be assigned to specific Directory Numbers (DN) during Night
Service.
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Enhanced Night Service allows you to:
* address different night answering requirements

* establish different patterns to satisfy required night, holiday, or
weekend Night Service answering needs

* modify the assignment when Night Service is not active (a service
change may also perform this modification)

Use Procedure 87 “Determining the Night Service setting” (page 143) to
determine the Night Service setting.

Procedure 87
Determining the Night Service setting

Step Action

1 Click an idle loop key.
The loop key indicator lights steadily.
2 Click the Busy button.

The indicator flashes. You hear dial tone, and the current Night
Service Option number is displayed.

3 Click the Release button.

The loop and Busy indicators light steadily, and the display is
cleared.

—End--

Use Procedure 88 “Selecting a new Night Service” (page 143) to select
a new Night Service.

Procedure 88
Selecting a new Night Service

Step Action

1 Dial a one-digit (0 to 9) option number.

The old Night Service number (X) is shifted and the new Option
number (Y) is displayed. X and Y are separated by a hyphen,
for example, Y-X.

2 Click the Release button.

The Position Busy indicator goes out. The new Night Service
option is stored. The display is cleared.

—End--
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Turning Enhanced Night Service on and off

Enhanced Night Service permits incoming calls that would normally be
directed to the console to be routed to a preselected destination when the
console is unattended. Your console may be equipped with either regular
Night Service, or enhanced Night Service, but not both. If necessary,

ask your system administrator which version of Night Service is on your
console.

Use Procedure 89 “Turning Enhanced Night Service on and offfor a single
console” (page 144) to turn Enhanced Night Service on and off for a single
console.

Procedure 89
Turning Enhanced Night Service on and off
for a single console

Step Action

1 Click the Busy button to activate enhanced Night Service for a
single console.

2 Unplug the handset or headset.
The current Night Service option number is displayed.

3 To cancel enhanced Night Service for a single console, plug in
the handset or headset.

—End--

Use Procedure 90 “Turning Enhanced Night Service on and offfor a
multiple consoles” (page 144) to turn Enhanced Night Service on and off
for multiple consoles.

Procedure 90
Turning Enhanced Night Service on and off
for a multiple consoles

Step Action

Click on the Busy button at each console.
2 Unplug all headsets and handsets.
The current Night Service option number is displayed.

3 To cancel enhanced Night Service for multiple consoles, plug in
at least one handset or headset.
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When all consoles but one are in Position Busy mode and the
attendant at the only active console clicks on the Busy key, the
system is automatically placed in Night Service.

—End--

Enhanced Secrecy
The Enhanced Secrecy feature ensures that either the caller or the called
party is always excluded from the call when you are talking to the other

party.

Use Procedure 91 “Using Enhanced Secrecy” (page 145) to use Enhanced

Secrecy.

Procedure 91
Using Enhanced Secrecy

Step

Action

1

Dial the requested extension.

The Excl Src indicator goes on during dialing. You hear ringing.
The LCD indicator flashes slowly.

When the called party answers, the Destination indicator goes on
steadily. The caller cannot hear conversation between you and
the called party.

Click on the loop key beside the slowly flashing Source indicator
to establish a three-way connection. You, the caller, and the
called party hear a warning tone.

Click the Release button or an idle loop key to release the call
from the console.

You cannot reenter the call. The caller and the called party
remain connected. The Release indicator and all other indicators
go off.

If you want to be able to reenter the call later, click on the Hold
button, then the Release button. This step will exclude you from
the call, but keep it on hold at the console. The caller and the
called party remain connected. The loop key flashes slowly.

To reenter the call, possible only if you follow the process
outlined in the second paragraph of step 3, click on the loop key
beside the slowly flashing Source indicator. You, the caller, and
the called party hear a warning tone.

Note 1: In Step 1, click on Excl Dst to talk to the caller while
the called party’s extension is being rung. The called party is
excluded from the connection when the call is answered. The
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caller hears ringing if you click on the Release button while
the called party is being rung.

Note 2: In Step 2, there is no connection between the caller
and the called party if either has warning-tone-denied Class
of Service.

Note 3: To establish yourself, the caller, and the called party
in a connection that allows the called party to make another
call, click on Conference in the Feature List after Step 4.

~End--

Malicious Call Trace
Malicious Call Trace lets you trace nuisance calls being presented to your
console.

Use Procedure 92 “Tracing nuisance calls” (page 146) to trace nuisance
calls.

Procedure 92
Tracing nuisance calls

Step Action

1 Click Call Trace from the Feature List while the call is in
progress.

The loop indicator is on. The Source or Destination indicator is
on.

Note: A call trace report is printed on the maintenance
terminal at your company. The report identifies the source
or destination, or both.

—End--

Night Service
Night Service allows you to connect incoming trunks to selected Night
Service extensions. You can assign any number of trunks to the same
Night Service extension.

Use Procedure 93 “Using Night Service” (page 147) to use Night Service.
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Procedure 93
Using Night Service

Step Action

Click on an idle loop key.
Click the Busy key.
You hear dial tone. The loop indicator goes on.

3 Dial the desired trunk access code and member number,
followed by the pound key (#).

4 Click on Display Source to check the display.

If the display is clear, no night-service extension has been
assigned to the trunk. If the display shows an extension humber,
it is the night-service extension assigned to the trunk.

5 To set up a Night Service connection, dial the Night Service
extension number to which the trunk is to be routed, followed by
#.

6 To cancel an existing Night Service connection, press the star

key (*), then the pound key (#). Trunk Answer From Any Station
(TAFAS) is now allowed.

—End--

Turning Night Service on and off

Night Service permits incoming calls that would normally be directed to
the console to be routed to a preselected destination when the console
is unattended. You can turn Night Service on or off for a single- or
multiple-console System.

Use Procedure 94 “Turning Night Service on and offfor a single console”
(page 147) to turn Night Service on and off for a single console.

Procedure 94
Turning Night Service on and off
for a single console

Step Action

Click on the Busy button.
Unplug the handset or headset.

To cancel Night Service for a single console, plug in the handset
or headset.

—End--
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Use Procedure 95 “Turning Night Service on and offfor multiple consoles”
(page 148) to turn Night Service on and off for multiple consoles.

Procedure 95
Turning Night Service on and off
for multiple consoles

Step Action

Click the Busy button at any console.

Unplug all handsets and headsets.

To cancel Night Service for multiple consoles, plug in at least
one handset or headset.

Note: When all consoles but one are in Position Busy mode
and the attendant at the only active console clicks on the Busy
key, the System is automatically placed in night-service mode.

—End--

Displaying and changing the Night Service option number

As part of enhanced Night Service, you can display and change the Night
Service option number. The Night Service option number tells you which
night number to which incoming calls will be directed.

Use Procedure 96 “Displaying the Night Serviceoption number” (page
148) to display the Night Service option number.

Procedure 96
Displaying the Night Service
option number

Step Action

Click on an idle loop key.
Click the Busy button.
You hear dial tone. The loop indicator goes on.

—End--

Use Procedure 97 “Changing the Night Serviceoption number” (page
149) to change the Night Service option number.
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Procedure 97
Changing the Night Service
option number

Step Action

1 Dial a one-digit option humber (0 to 9).

The dial tone stops. The old and new Night Service option
numbers, separated by a hyphen, are displayed.

2 Click the Release button.
The loop indicator goes off.

—End--

Paging
You can page someone over your organization’s paging equipment
through your console if the two are connected.

Use Procedure 98 “Using Paging” (page 149) to use Paging.

Procedure 98
Using Paging

Step Action

1 Click on an idle loop key.
The loop indicator goes on.
Click on the Page key and make the announcement.
Click the Release button to end the procedure.

The loop indicator goes off. The Release indicator goes on,
indicating that you are now free to take other calls.

—End--

Position Busy
Position Busy allows you to make your console appear busy, thus
preventing incoming calls from reaching you.

Use Procedure 99 “Using Position Busy” (page 150) to use Position Busy.
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Procedure 99
Using Position Busy

Step

Action

1

Radio Paging

To activate Position Busy, click the Busy button when your
console is idle (all loop indicators off).

You will receive no further calls.

To cancel Position Busy, click the Busy button when your
console is in Position Busy mode.

You will now receive calls.

Note: In a single-console setup, clicking on Busy places the
System in Night Service. In a multiple-console setup, the
System is placed in Night Service when all consoles are put
into Position Busy.

—End--

Use Procedure 100 “Using Automatic pre-selection” (page 150) to use
Automatic pre-selection.

Procedure 100
Using Automatic pre-selection

Step

Action

1

Lift handset.

The telephone receives a dial tone.

Enter the RPAC (FFC) for initiating RPA.

The telephone receives the following:

* paging tone if FFC is valid

®* CTVN treatment if FFC is invalid

® congestion tone (as configured) if no trunk is available in a
single System

Enter the DN of the part to be paged.

The telephone receives the following:

* ringback tone, call progress tones or silence (as configured) if
paging was successful

* no tone from the System if speech path is provided
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®* CTVN treatment if DN is invalid
® congestion tone if no paging trunk is available
* hbusy tone if absence signal is received

—End--

Use Procedure 101 “Using Automatic post-selection” (page 151) to use
Automatic post-selection.

Procedure 101
Using Automatic post-selection

Step Action

1 Lift the handset.
The telephone receives a dial tone.
2 Enter the DN of the party to be paged.

The telephone receives ringback or busy tone if DN is valid. It
receives CTVN treatment if DN is invalid.

3 Click on the RPAG key (for RPA).

The telephone receives ringback tone, call progress tones or
silence (as configured) if paging was successful. If the paging
call recalls, the attendant can extend the call again.

* The telephone receives CTVN treatment if FFC or DN is
invalid.

* The telephone receives congestion tone if no paging trunks
are available.

* The telephone receives busy tone if absence signal is
received.

—End--

Use Procedure 102 “Using Manual pre-selection” (page 151) to use
Manual pre-selection.

Procedure 102
Using Manual pre-selection

Step Action

1 Lift the handset.
The telephone receives a dial tone.

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



152 Attendant PC features

Enter the RPAC (FFC) for initiating RPA.

The telephone receives:

* paging tone if FFC is valid

* DTVN treatment if FFC is invalid

* congestion tone (as configured) if no paging trunk is available

Enter the DN of party you wish to reach.

The telephone receives ringback or busy tone if DN is valid. The
telephone receives CTVN treatment if DN is invalid.

Enter mode digit.
Enter information to be sent.
Press the pound key (#).

The telephone receives ringback tone, call progress tones or
silence (as configured) if paging was successful.

The telephone receives busy tone if absence signal is received.

—End--

Use Procedure 103 “Using Manual post-selection” (page 152) to use
Manual post-selection.

Procedure 103
Using Manual post-selection

Step

Action

1

Lift the handset.
The telephone receives a dial tone.
Enter the DN of the party to be paged.

The telephone receives ringback or busy tone if DN is valid. The
telephone receives CTVN treatment if DN is invalid.

Click on the RPAG key (for RPA).
The telephone receives:

® ringback tone, call progress tones or silence (as configured) if
paging was successful

®* CTVN treatment if FFC or DN is invalid
® congestion tone if no paging trunks are available

—End--
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Semi-automatic Camp On
When an attendant extends a call to a desired party who is busy, the
attendant can activate Semi-automatic Camp-On.

Use Procedure 104 “Activating Semi-automatic Camp-On” (page 153) to
activate Semi-automatic Camp-On.

Procedure 104
Activating Semi-automatic Camp-On

Step Action

1 Click Semi-automatic Camp-On in the Feature List.

The call is camped on the desired party. The display shows the
calling party’s DN, and the party to which the call is camped on
(the desired party).

2 The desired party becomes idle.
The call is recalled to the attendant.

3 To ring the desired party after receiving the recall, click
Semi-Automatic Camp-On in the Feature List again.

—End--

Series Call
The attendant designates the source call as a Series Call by clicking
Series Call (SECL) from the Feature List. Series Call may be clicked by
the attendant while dialing, talking to the destination party, or while a call
is ringing. The associated indicator remains lit until the Series Call is
cancelled. If the attendant tries to extend a call to an external station, the
SECL indicator flashes. The attendant has to click Series Call to cancel
the Series Call, and extend the call as a standard call extension.

Speaking privately (Splitting)
Splitting allows you to talk to a called party without the caller hearing, or to
talk to a caller without the called party hearing.

Use Procedure 105 “Speaking privately” (page 153) to speak privately.

Procedure 105
Speaking privately

Step Action

A caller requests an extension.
1 To exclude the caller from the connection, click on Excl Src in
the Feature List.
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Speed Call

The Excl Src indicator goes on.
Dial the requested extension.

The called party answers. Talk privately with the called party.
You hear ringing but the caller does not. The Destination
indicator flashes slowly. Upon answer, ringing stops and the
LCD indicator goes on steadily.

To exclude the called party from the connection, click on Excl
Dst.

You and the caller are reconnected. Talk privately. The Excl Src
indicator goes off. The Excl Dst indicator goes on.

To connect yourself, the caller, and the called party, click on the
loop key. The Excl Dst indicator goes off.

To end your connection in the call, click the Release button. The
Release indicator goes on, indicating that you are now free to
take other calls.
Note 1: The Secrecy feature automatically prevents a voice
connection between caller and called party while you are
extending a call.
Note 2: Splitting allows you to talk selectively and privately to
caller and called party while you are extending a call, or while
you are actually connected to a call.

—End--

If your console is designated a Speed Call user, you can place a call by
dialing a one-, two-, or three-digit access code.

Use Procedure 106 “Calling a Speed Call number” (page 154) to call a
Speed Call number.

Procedure 106
Calling a Speed Call number

Step

Action

1

Click on an idle loop key.
The loop indicator goes on.
Click on Speed Call.

Dial the one-, two-, or three-digit access code associated with
the desired number.

The Speed Call indicator goes off; the system automatically dials
the full number.
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Note 1: After dialing the Speed Call code, you can add extra
digits to the number represented by the code.

Note 2: If you wish to display the number stored against a
speed-call access code, click on Disp Src after dialing the
code.

—End--

Storing a Speed Call number

If your console is designated a Speed Call controller, you can store a
number for Speed Call and use the Speed Call codes. Also use this
number-storing procedure to change a humber stored against a Speed
Call code.

Use Procedure 107 “Storing a Speed Call number” (page 155) to store a
Speed Call number.

Procedure 107
Storing a Speed Call number

Step Action

1 When all loop indicators are off, click on Speed Call.
The Speed Call indicator flashes.

2 Dial the one-, two-, or three-digit code to be associated with the
phone number.

3 To see if a number is already associated with the dialed code,
click on Disp Src from the Feature List.
The current speed-call list entry (if any) is displayed.

4 Dial the number to be stored. Click on the star key (*) after every
trunk access code to ensure a pause for dial tone.

5 Click on Speed Call again.
The Speed Call indicator goes off; the access code and phone
number you dialed are stored together for speed-calling.

6 To cancel a number stored against a code, click Speed Call,

enter the code, and press the star key (*).
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Regarding Speed Call access codes:

* A one-digit access code (0 through 9) allows a Speed Call
list of up to 10 numbers.

* A two-digit access code (00 through 99) allows a Speed Call
slit of up to 100 numbers.

* A three-digit access code (000 through 999) allows a Speed
Call list of up too 1000 numbers.

Note: The phone numbers assigned to Speed Call access
codes can be 4, 8, 12, 16, 20, 24, 28 or 31 digits long
(including any asterisks inserted for dial tone pauses).

—End--

Stored Number Redial
Stored Number Redial (SNR) can be used when you hear either dial tone
or special dial tone. This means that Stored Number Redial can be used
during established calls to transfer or conference in a call.

Use Procedure 108 “Using SNR” (page 156) to use Stored Number Redial
(SNR)

Procedure 108
Using SNR

Step Action

1 Click on an idle loop key.
The loop indicator goes on.

2 Click on Stored Number Redial to redial the stored number.
The stored digits are automatically dialed.

3 Dial further digits now, if needed.

—End--

Use Procedure 109 “Storing an SNR number ahead of time” (page 156) to
store an SNR number ahead of time.

Procedure 109
Storing an SNR number ahead of time

Step Action

You can store one number of up to 31 digits for later use.
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Click on Stored Number Redial.

The Stored Number Redial indicator flashes.
Dial the number to be stored.

Click on Stored Number Redial again.

The Stored Number Redial indicator goes off; the previously
stored number is erased.

Note 1: If more than 31 digits are entered, you hear a dial
tone.

Note 2: If SNR is clicked on and no digits (or more than
31 digits) are dialed, the SNR memory is not changed; the
previously stored number remains unchanged.

Note 3: If SNR is not clicked on a second time, or the SNR
sequence is interrupted by clicking on another key, the new
entry is ignored; the previously stored number remains
unchanged.

—End--

Use Procedure 110 “Storing an SNR number during a call” (page 157) to
store an SNR number during a call.

Procedure 110
Storing an SNR number during a call

Step

Action

You can use SNR while trying to establish a call (when the other end is ringing or
busy), or during an established call (when you are talking to someone at the other
end). If you are on an established call, go to Step 3.

1

Click on an idle loop key.

The loop indicator goes on.

Dial the required number.

Click on Stored Number Redial from the Feature List.

Note 1: When a call is active on the source and destination
side, the destination humber is stored. If only the source is
active, no number is stored.

Note 2: For internal calls, the dialed digits must result in

a busy signal or ringing. If insufficient digits or an invalid
extension is dialed, the attempt to store the number is rejected
and any previously stored number is not changed.
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Note 3: For external calls, if no trunk is available, all digits
dialed are stored even though some digits may be entered
after an overflow or busy signal.

—End--

System Speed Call
You can make a System Speed Call from a Meridian 1 proprietary
telephone or an Attendant Console (user).

Use Procedure 111 “Making a System Speed Call” (page 158) to make a
System Speed Call.

Procedure 111
Making a System Speed Call

Step Action

Click an idle loop key.
Click System Speed Call from the Feature List.
Dial the Speed Call code.

If the Speed Call number is accepted, the telephone number
represented by the Speed Call code is dialed automatically. No
confirmation tone is given unless Flexible Feature Code (FFC) is
implemented.

If the Speed Call number is not accepted, a fast busy signal
indicates the number was rejected.

~End--
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Attendant PC network features

Contents

Features

“Features” (page 159)
“Centralized Attendant Service” (page 159)

“Network Attendant Service” (page 164)
“Networking (ESN, ISDN) features” (page 168)

This section defines the Attendant PCnetwork features that are available
for attendant operations. The network features described are divided into
three groups:

* Centralized Attendant Service (CAS)
* Network Attendant Service (NAS)
* Networking (ESN, ISDN)

Centralized Attendant Service

With Centralized Attendant Service (CAS), attendant services for multiple
locations can be provided from a single location. As a CAS attendant, you
can handle calls that would normally be handled by the attendants at a
remote location.

Use Procedure 112 “Answering a call to a remote console” (page 159) to
answer a call to a remote console.

Procedure 112
Answering a call to a remote console

Step Action

You receive a call intended for a remote console.
1 Click on the loop key beside the flashing Source indicator (or
remote ICI) to answer the call.
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The tone stops and the loop and Source indicators go on
steadily; you hear two beeps before you are connected to the
caller. The remote ICI indicator is on.

Respond to the caller’s request.

If no further action is needed, click the Release button to end
the call.

The Release indicator goes on; you can now take other calls.

Note 1: Calls from remote locations travel over release line
trunks (RLTs). Call source information consists of an RLT
access code and member number.

Note 2: You can also receive direct calls from extension users
and attendants at the remote location. Handle the same as
for indirect calls outlined above, except that direct calls cannot
be placed on silent hold. If you dial the silent hold code, you
hear a fast busy signal.

—End--

Extending a call to an idle extension
After answering a call to a remote console, you can extend it to the desired
extension at the remote location.

Use Procedure 113 “Extending a call to an idle extension” (page 160) to
extend a call to an idle extension.

Procedure 113
Extending a call to an idle extension

Step Action

The caller requests an extension at the remote location.
1 Click on the key that forwards calls from other sites to the main
location.

You hear dial tone from the remote location; the caller hears
nothing. The remote ICI, loop, and Source indicators are on.

2 Dial the requested extension.
You hear ringing at the remote location.

3 If you wish to release before the called party answers, click the
Release button.

You are recalled if the called party does not answer within a set
time after you release from the call. The Release indicator goes
on; you can now take other calls.
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If you wish to ensure that the called party is present, wait for an
answer before releasing. When answered, the ringing stops; you
can talk to the called party.

4 Once you have ensured that the called party is present, click the
Release button to end your connection in the call.

—End--

Extending a call to a busy remote extension

You can route one call to a busy extension at a remote location if camp-on
is allowed at the busy end. If the called extension does not become idle
within a set time, you are automatically recalled by the camped caller.

Use Procedure 114 “Extending a call to a busy remote extension” (page
161) to extend a call to a busy remote extension.

Procedure 114
Extending a call to a busy remote extension

Step Action

The caller requests an extension at the remote location.
1 Click on the key that forwards calls from a remote location to the
main location.

You hear dial tone from the remote location; the caller hears
nothing. The remote ICI, loop, and Source indicators are on.

2 Dial the requested extension.

If the called extension is busy, you hear a busy signal followed
by a beep; you are reconnected to the caller.

3 If the caller does not wish to wait, click the RIs Dst button, then
the Release button to end the call.

The Release indicator goes on; you can take other calls.

If the caller wishes to be camped on to the busy extension, click
the Release button. If recall occurs, either click the Release
button to reextend the call or click the Rls Dst button, then the
Release button to end the call. The Release indicator goes on;
you can take other calls.

Note: If you dial the requested number at the remote location
and hear only a busy signal (with no beep), then a call is
already camped onto that extension. If the caller wishes to
wait, put the call on silent hold. Otherwise, release the call.

—End--
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Putting a call on silent hold

When one call is already camped onto a busy extension and a third caller
wishes to wait for a connection, you can put the third caller on silent hold
until camp-on becomes possible. You are automatically recalled by the
caller after a set time.

Use Procedure 115 “Putting a call on silent hold” (page 162) to put a call
on silent hold.

Procedure 115
Putting a call on silent hold

Step Action

The caller wishes to wait for a connection but cannot be camped onto the busy

extension.

1 Click on the key that forwards calls from a remote location to the
main location.

You hear dial tone from the remote location; the caller hears
nothing. The remote ICI, loop, and Source indicators are on.

2 Dial the silent hold code.
You hear four to six beeps.

3 Click the Release button to put the call on silent hold.
The Release indicator goes on; you can take other calls.

4 When recall occurs, check if camp-on is possible. If not, either
put the call back on silent hold (Steps 2 and 3) or end it by
clicking the Rls Dst button and then the Release button.

Note: When you place a call on silent hold, the release link
trunk (RLT) is held at the remote location. When you use
Hold, the RLT is held at your location.

—End--

Remote recall

When you extend a call to an idle extension at a remote location and
the called party does not answer within a set time, you are automatically
recalled by the caller.

Use Procedure 116 “Using Remote recall” (page 163) to use remote recall.
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Procedure 116
Using Remote recall

Step Action

You receive a recall from a remote location.
1 Click on the loop key beside the flashing Source indicator (or
remote) to answer the call.

The tone stops and the loop and Source indicators go on
steadily; you hear a beep before being connected to the caller.
The remote ICI indicator is on.

2 Click the RIs Dst button. Ringing at the called extension stops.
If the caller wishes to end the call, click the Release button.
The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new
number, then click the Release button. The Release indicator
goes on; you can now take other calls.

Note: Recalls from remote locations travel over release link
trunks (RLTs). Call source information consists of an RLT
access code and member number.

~End--

Transferring a recall to another remote extension
A called party at a remote location can transfer a call back to you, which
you can then extend to another extension.

Use Procedure 117 “Transferring a recall to anotherremote extension”
(page 163) to transfer a recall to another remote extension.

Procedure 117
Transferring a recall to another
remote extension

Step Action

You receive a recall from a remote location.
1 Click on the loop key beside the flashing Source indicator (or
remote) to answer the call.

The tone stops and the loop and Source indicators go on
steadily; you hear two beeps before you are connected to the
called party. The remote IClI indicator is on.

2 The called party asks to have the caller transferred back to you.
Click the RIs Dst button to release the called party from the call.
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You are connected to the caller.
3 If the caller wishes to end the call, click the Release button.
The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new
number, then click the Release button. The Release indicator
goes on; you can now take other calls.

—End--

Network Attendant Service
The following NAS features are processed the same as for local calls. You
can find these features elsewhere in this section:

* Attendant Routing

* Break-In

* Call Extension

* Call Waiting

e Camp-On

® Incoming Call Indication

* Night Service

e Off-Hook Queueing

* Timed Reminder Recalls

The next five features apply specifically to NAS situations. Clicking the

NAS key on your screen console makes you available for calls from all
locations in the network.

Answering a call from a remote console

With Network Attendant Service (NAS), attendant services for multiple
locations can be provided from a single location. As a NAS attendant, you
can handle calls that would normally be handled by the attendants at a
remote location.

Use Procedure 118 “Answering a call from a remote console” (page
164) to answer a call from a remote console.

Procedure 118
Answering a call from a remote console

Step Action

You receive a call intended for a remote console.
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1 Click on the loop key beside the flashing remote ICI to answer
the call. The tone stops and you are connected to the caller. The
appropriate ICl indicator is on.

2 Respond to the caller’s request. If no further action is needed,
click the Release button to end the call. The Release indicator
goes on; you can now take other calls.

Note 1: Calls from remote locations travel over Integrated
Service Digital Network (ISDN) trunks. Calling Line ID is
supplied, to indicate the source of the call.

Note 2: You can also receive direct calls from extension
users and attendants at the remote location. The procedure is
the same as for indirect calls outline above, except that direct
calls cannot be placed on silent hold. If you dial the silent hold
code, you hear a fast busy signal.

—End--

Extending a call to a busy remote extension

You can route a call to a busy extension at a remote location if camp-on
is allowed at the busy end. If the called extension does not become idle
within a set time, you are automatically recalled by the camped caller.

Use Procedure 119 “Extending a call to a busy remote extension” (page
165) to extend a call to a busy remote extension.

Procedure 119
Extending a call to a busy remote extension

Step Action

You receive a call intended for a remote console.
1 Click on the loop key beside the flashing ICI key to answer the
call. The appropriate ICI indicator is on.

2 The caller requests an extension at the remote location. Dial the
requested location.

The appropriate ICI indicators are on. If the called extension
is busy, you hear a busy signal followed by a beep; you are
reconnected to the caller.

3 If the caller does not wish to wait, click the RIs Dst button, then
the Release button to end the call.

The Release indicator goes on; you can now take other calls.

If the caller wishes to be camped onto the busy extension, click
the Release button. If recall occurs, either click the Release
button or click the RIs Dst button, then the Release button to
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end the call. The Release indicator goes on; you can take other
calls.

Note: If you dial the requested number at the remote location
and hear only a busy signal (with no beep), then a call is
already camped onto that extension. If the caller wishes to
wait, put the call on hold. Otherwise, release the call.

—End--

Extending a call to an idle remote extension
After answering a call to a remote console, you can extend it to the desired
extension at the remote location.

Use Procedure 120 “Extending a call to an idle remote extension” (page
166) to extend a call to an idle remote extension.

Procedure 120
Extending a call to an idle remote extension

Step

Action

You receive a call intended for a remote console.

1

Click on the loop key beside the flashing ICI key to answer the
call. The appropriate ICI indicator is on.

Dial the requested extension.
You hear ringing at the remote location.

If you wish to release before the called party answers click the
Release button.

The Release indicator goes on; you can now take other calls.

To ensure that the called party is present, wait for an answer
before releasing. When call is answered, the ringing stops; you
can talk to the called party.

Once you have ensured that the called party is present, click the
Release button to end your connection in the call.

The caller and called party are connected. The Release indicator
goes on; you can now take other calls.

—End--
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Remote recall

When you extend a call to an idle extension at a remote location and
the called party does not answer within a set time, you are automatically
recalled by the caller.

Use Procedure 121 “Using Remote recall” (page 167) to use Remote
recall.

Procedure 121
Using Remote recall

Step Action

You receive a recall from a remote location.

1 Click on the loop key beside the flashing ICI indicator.
The appropriate ICI indicator is on.

2 Click the Rls Dst button. The ringing at the called extension
stops.

3 If the caller wishes to end the call, click the Release button.

The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new
number, then click the Release button. The Release indicator
goes on; you can now take other calls.

Note: Calling Line ID supplies the information regarding the
source of the recall.

—End--

Transferring a call to another remote extension
A called party at a remote location can transfer a call back to you, which
you can then extend to another extension.

Use Procedure 122 “Transferring a call to another remote extension” (page
167) to transfer a call to another remote extension.

Procedure 122
Transferring a call to another remote extension

Step Action

You receive a call from a remote location.
1 Click on the loop key beside the flashing ICI indicator to answer
the call.

The appropriate ICI indicator is on.
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2 The called party asks to have the caller transferred back to you.
Click the RIs Dst button to release the called party from the call.
You are connected to the caller.

3 If the caller wishes to end the call, click the Release button.
The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new
number, then click the Release button. The Release indicator
goes on; you can now take other calls.

—End--

Networking (ESN, ISDN) features
When an extension user requests an ESN location, you may have to enter
an authorization code to override the access restrictions assigned to the
user’s extension. Authorization codes are issued to extension users with
special calling needs.

Use Procedure 123 “Overriding access restrictions” (page 168) to override
access restrictions.

Procedure 123
Overriding access restrictions

Step Action

A caller requests an extension at a distant ESN location and provides an
authorization code.

1 Dial the requested number. The Excl Src indicator goes on. You
may hear the authorization-code prompt:

* arecorded message followed by three beeps, or
* ten beeps followed by dial tone

Dial the user’s authorization code. The call is completed.
Click the Release button to end your connection in the call.
The Release indicator goes on; you can now take other calls.

—End--

Charge Account
If your console has a Charge key, you can assign a charge account
number to a call about to be extended to an ESN location.

Use Procedure 124 “Assigning a charge account number to a call” (page
169) to assign a charge account number to a call.
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Procedure 124
Assigning a charge account number to a call

Step Action

A caller requests an extension at a distant ESN location and wishes to charge
the call to an account number.

1 Click on Charge.
The Charge indicator goes on. The Destination indicator flashes.
2 Dial the charge account code.

The Charge and Destination indicators go off when the last digit
of the charge account code is entered.

3 Dial the call as usual and click the Release button.

A charge record is produced when the trunk is accessed. The
Release indicator goes on; you can now take other calls.

—End--

Expensive Route Warning Tone

When an extension user requests an ESN location, you may be signaled
that only an expensive route is available. The caller can accept the
expensive route (direct distance dialing, or DDD) or try again later.

Use Procedure 125 “Accepting or rejecting anexpensive route” (page
169) to accept or reject an expensive route.

Procedure 125
Accepting or rejecting an
expensive route

Step Action

A caller requests an extension at a distant ESN location.
1 Dial the requested number.

The Exsl Src indicator goes lights. You hear three beeps if the
only available route is the most expensive one.

2 Do one of the following:

a To accept the expensive route, company policy permitting,
stay on the line. The call is completed.

b To reject the expensive route, click the Release button.
The Excl Src indicator goes off; you and the caller are
reconnected.

3 Click the Release button to end your connection in the call.
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The Release indicator goes on; you can now take other calls.

—End--

Extending a call: off-hook queueing
When an extension user requests an ESN location for which a trunk is not
immediately available, you can:

e wait off-hook until a trunk becomes available
* release the connection and allow the caller to wait for the trunk

Use Procedure 126 “Using off-hook queueing” (page 170) to use off-hook
queueing.

Procedure 126
Using off-hook queueing

Step Action

A caller requests an extension at a distant ESN location.
1 Dial the requested number.

The Excl Src indicator goes on during dialing. you hear a beep if
a route is not immediately available.

2 Inform the caller that there will be a brief wait.
Click the Release button to end your connection in the call.
The Release indicator goes on; you can now take other calls.

—End--

Network Speed Call
With Network Speed Call, you can extend calls to a selected number at an
ESN location by dialing a one-, two-, or three-digit code.

Use Procedure 127 “Using Network Speed Call” (page 170) to use
Network Speed Call.

Procedure 127
Using Network Speed Call

Step Action

1 Click on a loop key.
The loop indicator goes on steadily.
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Dial the network access code, the Network Speed Call list
access number, and the one- to three-digit code for the desired
number.

The Source indicator goes on steadily. The number is
automatically dialed.

—End--

Routing control

You can use ESN routing control to modify extension user’s network
access. When routing control is on, each extension usually has more
restrictions. Turning routing control off restores the Network Class of
Service (NCOS) assigned to each ESN user.

Use Procedure 128 “Using routing control” (page 171) to use routing

control.

Procedure 128
Using routing control

Step Action

1 To turn routing control on, click on Routing Controls in the
Feature List.
The Routing Controls indicator goes on.

2 To cancel routing control, click on Routing Controls.

The Routing Controls indicator goes off.

—End--
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Using the Attendant PC Help Facility

Contents

Description

“Description” (page 173)
“About the Help facility” (page 173)
“The Help menu” (page 174)
“Console Help F1” (page 174)
“Options menu” (page 178)
“Glossary descriptions of console features” (page 178)
“About the Attendant PC software” (page 179)

Online Help is essential to learning and using the Attendant PC. There are
two kinds of Help: Help about a specific procedure and Help that gives you
information about what you see on your screen.
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About the Help facility

The Help facility provides the following three functions:

* describes the toolbar menu and console keys, such as fixed keys, loop
keys and lamps

* provides definitions of call processing features, such as Barge In, Call
Waiting, Call Park, and Malicious Call Trace

® gives setup instructions for feature keys, trunk group busy keys (TGB),
and incoming call indication (ICI) keys.
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The Help menu
This section describes the Help facility and the options you can access
to select Attendant PCtopics of interest ranging from "Creating a Virtual
Feature" to understanding basic loop key operation. The next section
provides examples of object and topical information contained within the
Help facility.

Select a Help menu on your Console screen from the following options:

Console Help F1
Cantents
Contest Help Shift+F1

About Meridian 1 Attendant PC Caonsole...

You can also access Help for a dialog box object by using any of the
following means:

‘what's this?

* Click the right mouse button on a Attendant PC object to display a
"What's This?" message

* Click the icon in the dialog box title bar to display a Help cursor, then
click the object

Press the key to get Help on the selected object
GD,
* Use the key to close the current Help window.

Console Help F1
When you press the function key on your keyboard, your terminal displays
the Help Console window shown in Figure 62 "Console Help window"
(page 175).

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



The Help menu 175

This window contains an image of your console, including its menu, and
also has its own four-item menu bar displayed at the top:

The Help topics menu bar contains the following selections:
®* Help Topics

®* Back

* Options
®* Glossary
Figure 62

Console Help window

Help Tapics menu bar

CEE =
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Contents tab

Use the Contents tab from Help Topics to assist you in finding Attendant
PCinformation quickly (Figure 63 "Contents tab window" (page 176)) to
provide step-by-step procedures as well as set up instructions for "Using
the PC console screen”, for example:

Contents

Conlers | e |

* Building an attendant’s toolbox
* Extending a call to voice mail

* Adding an attendant
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* Headset and handset operation

® Sizing a PC console screen

Figure 63
Contents tab window

V4

Tip

" X Help Topics: Hortel Meridian 1 PC Console
Some Help topics contain —
green underlined text. erte [ index | Find |

You can click the green fext

Ll Chck a logec, and then chick Display, Or click. ancthes tab, such as Index.
to see a definition of the term.

[ @ About Nortel Merdian 1 Altendant PC

Q Featurss
Q Using the PC console screen
Represents a c:alegon,f e LIW] Configuring the F ole screen

of topics 7] Adding an IC1 key to the PC consols seieen

(7] Addng a TG key to the PC console scieen
1 7] Addng a fledble key to the PT console scieen

Reveals book contents lu B Ciooing o vl foshure

(7] Setting up the voice mal icon

(7] Setting mterdace unit contiolied lests

A page represents @ [ Setting the initerface uni alert for Call Waiting

an indvidual topic o ieline

Index tab

Use the Index tab to search console keywords for Help on a specific topic.

The Index serves as a traditional book index, listing keywords and phrases
alphabetically.

Index

Corerts s |

See Figure 64 "Index tab window" (page 177).
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Figure 64
Index tab window

m Help Topics: Windows Help

Tip Contents Index | Find |
To scroll through the Help 1 Tupe the first few leltess of the word youte looking for.
Index, type the first few EZ]
letters of the word you want fo 2 Cick the index entty you wand, and then click Display.
search for. [ ——
Find tab i Help, usrg
findng
Help tapics
phrases in Help fies _I
Double click on a console = T | .o nHee fie: ]
topic or click the Display o Shnemg i Holp loaise Toreturn to the list of
button o Shano topics, click Help Topics
He:dch-\g book marks to Help lopes
adding :Hmri: o Heldp topics
L mddgmmﬂ T i
(@D S |
Find tab

Use the Find tab to initiate a full-text search for any Attendant PC keyword
or phrase in the Help facility.

See Figure 65 "Find tab window" (page 177).

Figure 65
Find tab window
Find
Corterts| lodes Fird
Help Topics: Hortel Meridian 1 PC Console
Conterts | Index  Find
z 1 Tyses thes weoeds) you want to find
| - o
Tip s

et tor

2 Gelect some malching words o namow you search R
Type the keyword or phrase e g _|

you want to find. a

About the Metdan 1 Atterdant PC \
or \
Seltirad indedf ace unit controlled st ¥

. L Sodting the interface unit alert for Cal Waitng TO I'eturn IO the |iS| Of
Double click on a console # topics, click Help Topics
topic or click the Display ~ oo [ hage i P
button.
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Options menu
Use the Options menu to access enhanced console Help functions. The
menu contains the following selections:

* Annotate - Allows you to add notes to a topic.
* Copy - Allows you to copy all or some selected topic text.
* Print Topic - Allows you to print selected topic.

* Keep Help on Top - Allows the Help window on top, or in a default
position.

* Font - Allows you to specify small, normal or large font.

* Use System Colors - Allows you to display the Help system using
specified colors.

Glossary descriptions of console features
The Glossary window (Figure 66 "Glossary window" (page 179)) provides
a reference for reading about console features. Click on any Attendant PC
entry of interest to display a popup description for that feature.
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Figure 66
Glossary window

. incoming cal indicaar (1]

: ®
Can ook on & fashng I lamg ks arcwes e 2l emcasted it |

About the Attendant PC software
This Help menu displays the current software version of the Attendant
PCapplication that you are presently using, for example; Version 1.1.
Copyright ® 1996-1997, Nortel. All rights reserved.

Note: Not every feature is available on every Attendant PC application.
Features available for the release of software on your System

are described in the NTP Features and Services Fundamentals
(NN43001-106).
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Installing the Attendant PC Software

Contents

“Overview” (page 181)

“System requirements” (page 182)

“Installing the software” (page 182)

“Registering the Attendant PCsoftware” (page 192)

“Configuring voicemail” (page 192)

“Programming a Call Park Virtual Feature” (page 193)

“Accessing the CPLUS Directory” (page 195)

“Changing database location” (page 197)

“Exporting Directory numbers” (page 199)

“Importing Directory dialing numbers” (page 200)

“Installing the PC Console Interface Unit” (page 201)
“Required Hardware” (page 201)
“Self Test and Diagnostics” (page 207)
“Troubleshooting the Status LED” (page 208)
“Standalone test procedure” (page 208)
“Audio In/Out” (page 209)

“Alarm or event notification” (page 209)

Overview
This section provides instructions for installing the Attendant PCsoftware
application.

Note: After you have completed the software installation that follows,
refer to “Installing the PC Console Interface Unit” (page 201) and follow
the procedures that describe how to install the PC Console Interface
Unit (PCCIU).
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182 Installing the Attendant PC Software

System requirements
To use the Attendant PCsoftware application, you need the following
equipment:

®* PC compatible computer system containing:

Pentium processor, 100 MHz or higher

16 MB RAM available memory

Hard disk with at least 10 MB of free disk space

17" SVGA color monitor (1024 by 768 resolution, 256 colors)
16-bit sound board (recommended)

Printer (optional)

Network interface adapter (for LAN applications)

Windows 95®, Windows 98®, Windows 2000®, Windows NT® or
Windows XP® operating systems

RS232 serial port

Installing the software

Note: Before you set up the Attendant PCsoftware turn off any virus
protection programs you may have running. Virus protection programs
can interfere with the set up process.

The di

sk set in your package includes an InstallShield Wizard to help you

quickly install your copy of the Attendant PCsoftware.

Use Procedure 129 “Installing the Attendant PC software” (page 182) to

install

the Attendant PC software.

Procedure 129
Installing the Attendant PC software

Step

Action

Make sure that no applications are running.

Make a written note of the serial number printed on the disks.
This number will be requested later during the installation.

Insert disk 1 into the drive from which you want to install.
Double-click the My Computer icon on your Windows desktop.
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Double-click the Control Panel icon shown in Figure 67
"Accessing the Add/Remove Programs Control Panel" (page
183).

The "Control Panel" dialog window displays.

Double-click on Add/Remove Programs icon shown in Figure
67 "Accessing the Add/Remove Programs Control Panel" (page
183).

Figure 67

Accessing the Add/Remove Programs Control Panel

5. Bob's Box = (O]
File Edit “iew Help
=334 Floppy (&)

A2} Audio CD (D:)
9] Cortral Panel
| E] Prirters:

| 2] Dial-Up Metwarking

B ohject(s] 4

B3 Control Panel

File Edit “iew Help
& accessibiity Options
Emove F'ru:ugr:ar1_'_|_:_-::
A Display o Find Fast
2 Internet iy Jowystick

The Install/Uninstall property page from the Add/Remove
Program Properties sheet is displayed.

Figure 68 "Install/Uninstall property page" (page 184) shows the
Install/Uninstall property page.
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Figure 68
Install/Uninstall property page

AddRemove Programs Properties
Irestall /U nirstall I ‘windows Setup I Startup Disk I

Toinstall a new pragram from a floppy disk or CD-ROM
drive, click Install

The follawing software can be automatically removed by
‘windows. To remove a pragram or to modify its installed
components, select it from the list and click
Add/Remave.

Adobe Acrobat -
Adobe Acrobat Reader 3.0
Adobe Framebdaker +5.1.1

Cybertdedia Qil Change

Diamond Multimedia Product Installation & Removal

E azyPhato

Eudora Pro Yersion 2.2

ForeHelp 2.95

Hiview =

SddrEEmavE.. |

Ok | Cancel I Ll |

7 Click Install.

Figure 69 "Install Program from Floppy Disk window" (page

184) shows the Install Program from Floppy Disk window.
Figure 69

Install Program from Floppy Disk window

Inztall Program From Floppy Dizk or CD-ROM

Inzert the praduct's first installation floppy disk or CO-ROM,
and then click Mext.

Cancel

8 Click Next.

Figure 70 "Run Installation Program window" (page 185) shows
the Run Installation Program window.
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Figure 70
Run Installation Program window

Run Installation Program

IF thiz iz the correct installation pragram, click Finish. Tao
start the automatic search again, click Back. To manually
search for the installation program, click Browse.

< Back I Firizh I Cancel

Click Finish.

The Attendant PCConsole setup prepares the "InstallShield
Wizard" to assist you in the set up process.

Setup

InstallShield® ‘wWizard which will guide you through the rest

g Meridian 1 Attendant PC Console Setup is preparing the
= of the setup process. Please wait.

T 0

The next window displays the software license agreement.
Before you click YES, make sure you read carefully all of the
terms of the license agreement.

Figure 71 "Software license agreement” (page 186) shows the
Software license agreement window.
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Figure 71
Software license agreement

Software License Agreement

Fleasze read the following license agreement carefully. Use the scroll bar to view the
rest of thiz agreement

Meridian 1 Attendant PC o
Copyright [C] 1997 Martel Carporation

All Rights Rezerved

Licenze Agreement

Yiou should carefully read the fallawing terms and conditions befare using this zoftware.
Yiour uze of this software vou indicates your acceptance of this license agreement.

Governing Law

The laws of the State of Texas shall govern thiz agreement.

Disclaimer of YW aranty =l

Do you accept all the terms of the preceding License Agreement? If pou chooze Mo, Setup
will cloze. Toinstall Meridian 1 Attendant PC, you must accept this agreement.

< Back Yes No |

The installation process continues with the Welcome display.

Figure 72 "Welcome display" (page 186) shows the Welcome
display window.

Figure 72

Welcome display

Welcome

‘wielcome to the Meridian 1 Attendant PC Setup
program. This program will install Meridian 1
= Attendant PC on your computer,

It iz strongly recommended that you exit all \Windows programs
befare running this Setup program.

Click Cancel to quit Setup and then close any pragrams vou
hawve running. Click Mest ta continue with the Setup program.

WwARMIMNG: This program iz protected by copyright law and
international treaties.

Lnauthorized reproduction or distribution of this program, or anyp
portion of it, may regult in zevere civil and criminal penalties, and
will be prozecuted to the mavimum extent pozsible under law.

Cancel |
10 Click Next to display the User Information window.
11 Enter your name and company and click Next.

Figure 73 "User information display" (page 187) shows the User
Information window.
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Figure 73
User information display

User Information

Type wour name below. 'ou must alzo bype the name of the
company you work for.

MName: IJohn Smith

LCompany: I.&cme Corp]

< Back I Mest » I Cancel |

The "Setup Type" window prompts you to indicate the setup you
prefer for the Attendant PCconsole (Figure 74 "Setup type" (page
187)).

12 Choose "Standalone", or, if you will be connecting more than
one attendant together via a LAN, choose "Network - Initial" or
"Network - Additional Workstation" as appropriate. See “Installing
the LAN Interface Software” (page 213) for more information.

13 Click Next to continue.
Figure 74 "Setup type" (page 187) shows the Setup type window.
Figure 74
Setup type
Setup Type

Click the type of Setup vou prefer, then click Next.

1. Standalone
2. Metwark, - [nitial

3. Metwark, - Additional Workstation
4. Cuztom

— Description

Select this option ta install Meridian 1 Attendant PC ta a
workstation that will not be used in a networked environment.

< Back I Mest » I Cancel |

14 Click Next to choose the Destination Folder of the Attendant
PC, or browse to select another folder.
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Figure 75 "Choose Destination Location window" (page
188) shows the Choose Destination Location window.
Figure 75

Choose Destination Location window

Choose Destination Location

Setup will install Meridian 1 Attendant PC in the following folder.
Ta install ta this folder, click Next.

Ta install to a different folder, click Browse and select another
falder.

Y'ou can choose not to install Meridian 1 Attendant PC by clicking
Cancel to exit Setup.

" Destination Folder

C:h . SMartelMeridian 1 Attendant PC Browse... |

< Back

Cancel |

15 When the Select Program Folder window appears, click Next to
continue.

Figure 76 "Select Program Folder window" (page 188) shows the
Select Program Folder window.

Figure 76

Select Program Folder window

Select Program Folder

Setup will add program icons to the Program Folder listed below.
“r'ou may type a new folder name. or select one from the existing
Folders list. Click Mext to continue.

Program Folders:

b eridian 1 Attendant PC]

E zizting Folders:

Eudora by QUALCOMM B
Frame Products

Hivfiew J
InControl Tools 95

lomega Tools

Macromedia Shockwave
I céfes ViusScands
Ieridian 1 Attendant PC

< Back I Mest » I Cancel |

16 When the "Start Copying Files" window appears, click Next to
continue.

Figure 77 "Start Copying Files window" (page 189) shows the
Start Copying Files window.
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Figure 77
Start Copying Files window

Start Copying Files

Setup haz enough information to start copying the program files.
If you want ta review or change any settings, click Back. |f you
are satisfied with the settings, click Mext to begin copying files.

Current Settings:

Setup Type: =]
Complete

Target Folder
C:%Program FilesiMortel\Meridian 1 Attendant PC

Uszer Information
Mame: John Smith
Company: Acme Corp.

il

< Back

17 When prompted, insert the Attendant PCdisk 2 or disk 3 into
drive A:\ and click OK.

Figure 78 "Next disk display" (page 189) shows the Next disk
display window.

Figure 78

Next disk display

Setup Heeds The Hext Disk

Please insert the next disk, Disk 2. If the files on this disk
can be found in another location, for example, in another
drive, enter its full path or click the Browse button to select

itz path.
Path:

Iﬁ Browse. .. |
Ok I Cancel |

A status gauge reports the final copying progress of the set up
program.

After a short time, the Setup Complete window displays (Figure
79 "Setup complete display" (page 190)) indicating that the
Attendant PCsoftware installation has succeeded.

Figure 79 "Setup complete display" (page 190) shows the Setup
complete window.
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Figure 79
Setup complete display

Setup Complete

Setup has finizhed copying files to pour compter.
Setup will now launch the pragram. Select paur option belaw.

Click Finizh to complete Setup.

< Back I Finizh I

18 Click Finish to restart your computer.

Now that your Attendant PCsoftware is installed, you may wish
to create a shortcut "console icon" to display on your desktop, to
allow you easy access to the application.

:.

See your Windows User Guide or online Windows Help to assist
you in creating a shortcut.

19 Once you've created your shortcut, double click on it to register
your serial number and console name (Figure 80 "Attendant
PCSerial number" (page 191)).

20 Enter the serial number that is printed on the diskette label into
the "Serial Number" box.

21 In the "Console Identification" box, enter text which readily
identifies the console to the users of the Attendant PC system.

For example:
"Reception Area - East Wing" or "Reception Area - Main Lobby"

This information will be displayed on the top status bar after the
word "Console."
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22

Enter the serial number found on the installation diskettes, then
click OK to confirm your serial number is correct and launch the
Attendant PCconsole.

Note: Entering the serial number is not the same as
registering the software. Please refer to “Registering the
Attendant PCsoftware” (page 192).

Figure 80 "Attendant PCSerial number" (page 191) shows the
Attendant PC Serial number window

Figure 80

Attendant PCSerial number

Meridian 1 Attendant PC Installation ]

@ Serial # 41000 has been installed as conzole Reception area - main lakbky.

The Main Screen appears. This is the screen that the attendant
will use to perform basic call processing functions and use
features.

Figure 81 "Attendant PCMain Screen" (page 191) shows the
Attendant PC Main Screen window.

Figure 81

Attendant PCMain Screen

T Console: Reception ared - main lobby - Attendant: Ad... =]
Tools Console Config Help

NERTEL MERIDIAN|
Hm
I
IIBEJ @ Position Busy (Fls D) a5 =

|:] |.@ |E] 2| Loop§ |< ] [ O Beleasel
DED | =

1T
1T
10
1T
1T
1T

D | Loop3 <l [= Q (
BB J=2

|E] |@ |E] Ol L0 JI 1> [ Answer]
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When the Main Screen appears, the Attendant PC will be in
position busy or night and must be removed from that state
before it can receive calls.

—End--

Registering the Attendant PCsoftware
The Attendant PCsoftware has now been installed, however this software
will expire in 30 days unless it is made permanent by the following
registration process.

Note 1: If the Attendant PC software has not been registered within
30 days after installation, you will be unable to access the application
and you will be prompted to enter a registration number before you
can use the software.

Note 2: Completing registration before the 30 day period ends is
highly recommended, since some information, such as the "Installation
code", which is requested when you are obtaining the registration code
through the registration process, is available only within the Attendant
PC application.
Use Procedure 130 “Registering your copy ofAttendant PC software” (page
192) to register your copy of Attendant PC software.

Procedure 130
Registering your copy of
Attendant PC software

Step Action

1 Choose Console Configuration from the Configuration menu,
then click the Consoles tab.
2 Click the Register tab.

Call the number provided on the dialog box and provide the
information requested by the technical staff.

4 Type the registration number provided by the technical staff into
the text box and click OK.

—End--

Configuring voicemail
Before the attendant can extend calls to voice mail, the voice mail access
number must be configured in the Attendant PC.
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Use Procedure 131 “Configuring voicemail” (page 193) to configure
voicemail.

Procedure 131
Configuring voicemail

Step Action

1 Choose Console Configuration from the Configuration menu,
then click the General tab.

2 Enter the access number for voicemail in the appropriate text
box.

3 Enter the voicemail number termination flag in the appropriate
text box.

Click the General tab.
Select a default WAV file for audible signalling (optional).

Select the length of time delay (in milliseconds) when a comma
is encountered during dialing.

&

Click the Flex Keys tab.
Assign End to End Signalling (EES) to a Flexible Feature key.

Click OK to return to the main screen.

The Voicemail icon now appears on the Main Screen to the right
of the Directory icon.

—End--

Programming a Call Park Virtual Feature
Before the attendant can activate the Call Park feature, it must be
programmed as a Virtual Feature.

Use Procedure 132 “Creating a Virtual Feature for Call Park” (page 193) to
create a Virtual Feature for Call Park.

Procedure 132
Creating a Virtual Feature for Call Park

Step Action

1 Select Console Configuration from the Configuration menu.
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Click the Features tab.
Click New.
4 Enter the "Feature Description" and "Key Label."

Figure 82 "Feature Specification window" (page 194) shows the
Feature Specification window.

Figure 82

Feature Specification window

Feature Specification

Feature Description
ICaII Park
Cancel |
Kew Label: .
ICaII Parkl Processing |
Eermee |
Type
& Virual (=l |

 Flexible feature key

= iesterfeature (Eannet be aliered)

5 Make sure that the Virtual radio button is selected in the Type
box.

Click Processing.

Select each of the following steps in the left column and click
Add:

* Dial a number (Dynamic)
* Press Release

Figure 83 "Call Park - Processing Procedure window" (page
194) shows the Call Park - Processing Procedure window.

Figure 83
Call Park - Processing Procedure window
Awailable processing steps Selecled Steps
Connect Audio in ta RX - Dial a number (Dynamic) Cancel
ConnectAudiointo TX Press Release

Connect R to Audio out Add |
Connect TA to Audio out

Dial a number (Dynamic)

Dial a number {Static) .

Disconnect Audio in fram R EEnIeVE BT e =i
Disconnect Audio in from T
Disconnect R from Audio out
Disconnect TA fram Audio out
Pause for 2 seconds

Press aflexble feature key
Press anICl key

Press Release ;!

Prass the active lnon

8 Click OK until you return to the Main Screen.
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The Call Park Virtual Feature will appear in the Feature List with
the name you entered as the "Key Label." Virtual Features are
distinguished by light blue icons.

Now you can activate the Call Park Virtual Feature by clicking it
from the Feature List and entering the extension where the call
will be parked.

—End--

Accessing the CPLUS Directory
Procedure 133 “Use CPLUS Directory to upload CPLUSDIR.BTR” (page
195) shows you how to use the CPLUS Directory function to upload
CPLUSDIR.BTR dialing numbers from a diskette to the Attendant PC Data
folder. These dialing numbers can then be transferred to your personal
Directory.

Use Procedure 133 “Use CPLUS Directory to upload CPLUSDIR.BTR”
(page 195) to use CPLUS Directory to upload CPLUSDIR.BTR.

Procedure 133
Use CPLUS Directory to upload CPLUSDIR.BTR

Step Action

1 Select CPLUS Directory from the Tools menu.

A dialog displays prompting you that the CPLUS directory file
CPLUSDIR.BTR cannot be found.

Figure 84 "CPLUS Directory dialog box" (page 195) shows the
CPLUS Directory dialog box.

Figure 84

CPLUS Directory dialog box

CONSOLE

@ The CPlus directary file (CPLUSDIR BTR) cannot be found. Would you like to locate this file yourself?

: o |
2 Click Yes to locate the CPLUS file.
The CPLUS Directory "Look in" window is displayed.
3 Click the to display the 31/2 Floppy (A:) drive icon.
[
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Figure 85 "CPLU Directory Look in display window" (page
196) shows the CPLUS Directory Look in window.

Figure 85

CPLU Directory Look in display window

P virecory G |
Look ifc =3 Mesidian 1 Attendant PC > ﬁ“:gl -
= | a2
| 0sta = Rp(C) B~=---- Click here to
& Program Fies access the
] Moutel
9 Meridian 1 Attendant PC drop-down
=) Remavable Disk (D) devices Window.
%) Audia CD [E1) —
| Bs Netwotk Neighbothood =]
File name: |cplusrir.btr Open I
Files of type: | CPlus Files [CplusDir btr) =l Cancel |
Help |
4 Select the CPLUSDIR.BTR file and click Open.
The CPLUSDIR.BTR file is uploaded to the Attendant PCData
folder.

Figure 86 "Customized Toolbox display" (page 197) shows a
view of a console desktop with populated Toolbox and Directory
windows. All features, ICls, and TGBs are now easily accessible
in one central location.
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Figure 86

Customized Toolbox display
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—End--

Changing database location

The default database and configuration files reside in the Data folder within
the Attendant PC folder.

In the event of a network failure, the directory information on the network
will be unavailable to the attendant. For this reason, attendants should
periodically copy the network database files to the Data folder in the
Attendant PC folder on their hard drive.

Use Procedure 134 “Backing up network database filesto another location”
(page 197) to back up the network database files to another location.

Procedure 134
Backing up network database files
to another location

Step Action

Locate the Data folder located on the network.
Double click the folder.

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



198

Installing the Attendant PC Software

Three files are displayed: Config.dat, Directory.dat, and
Information.dat.

3 Press Ctrl + A to select all three files.
Press Ctrl + C to copy the three files.

5 Locate and double click the Data folder within the Attendant PC
folder on your hard drive (C: drive).

6 Press Ctrl + V to paste the three files into the Data folder on
your hard drive.

Frequent copying of these files from the network to the local hard
drive will ensure that the local directory files contains accurate
directory information.

~End--

Use Procedure 135 “Configuring the Attendant PC to usedirectory
information on the hard drive” (page 198) to configure the Attendant PC to
use the directory information on your hard drive rather than the network
directory information.

Procedure 135
Configuring the Attendant PC to use
directory information on the hard drive

Step Action

1 Click on the Configuration menu and select Change Database
Location.

2 Select the Config.dat file located in the Data folder in the
Attendant PC folder on the hard drive (C: drive).

3 Click Open.

The Attendant PC software restarts and accesses the directory
information on your hard drive.

When the network becomes operational, you should perform
the Change Database Location command again to access the
network directory information:

4 Click on the Configuration menu and select Change Database
Location.

5 Select the Config.dat file located in the Data folder on the
network.

6 Click Open.
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The Attendant PC software restarts and accesses the network
directory information.

—End--

Exporting Directory numbers
Use Procedure 135 “Configuring the Attendant PC to usedirectory
information on the hard drive” (page 198) to export Directory numbers.

Procedure 136
Exporting Directory numbers

Step

Action

1

Click Directory to select Export.

=~

Figure 87 "Export display window" (page 199) shows the Export
display window.

Figure 87
Export display window
w [Ereareneteren epoih

e e

Z nmm:muh?::m Cancel | =

Tip P e [ _ . Click Edit (Figure 24) to modify file
g, | A =~ information and columns for the exported

Click the Help buttonto | — = directory job

see information on _ e |},

Exporting jobs using

the Contents, Index,

and Find tabs.

Click Delete to remove an export
directory job

Click New to enter a name for the new export job.
The Export Job window displays.

Figure 88 "Export Job display window" (page 200) shows the
Export Job display window.
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Figure 88
Export Job display window
AT B H]

i =]
chmite €~ ow |
vt i TTm-e -Indicate File Information (default is
[t At FEG = Comma Separated) and Qutput File
5 Gt cokm b 1t fst econd Name or location of the export job.

v caree —

T;p mnmmhmnmmuh —

= robinchaded Lot . e egorted

Dolub!e ilnck ?On a ; . ([

GO e mﬂove I = Select the calumns you want

quickly between “not & included in the export file.

displayed” to

“displayed” areas.

3 Click OK.
-—End--

Importing Directory dialing numbers
Use Procedure 137 “Importing Directory sources” (page 200) to import

Directory sources.

Procedure 137
Importing Directory sources

Step

Action

1

Click Directory to select Import.

Figure 89 "Import display window" (page 201) shows the Import
display window.
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Figure 89

Import display window

e —
m ) e Ty Bun I
below and clch the Aun buton
Tip Diectory réomation vl be imparied Cancel |
i seleched job. The information in the _ Click Edit (Figure 24) lo modify file
Click the Help button to F20cH Mok be e iy £ ~ =~ information and columns for the imported
see information on & |* directory job
Importing jobs using peee | |-
the Contents, Index, C b [ ——
and Find tabs. = |
Click Delete to remove an import
directory job.
2 Click New to enter a name for the new import job.

Figure 90

The Import Job window displays.

Figure 90 "Import Job display window." (page 201) shows the

Import Job display window.

Import Job display window.

v
Double click on a
column item to move it
quickly between “not
displayed” fo
“displayed” areas.

il

vl
-

[piesen T inerdare PO

¥ Eapnt cokumn st it S st mecemd

Click OK.

-Indicate File Information (default is
Comma Separated) and Output
File Name or location of the import

job.

Select the columns you want
included in the import file.

—End--

Installing the PC Console Interface Unit

Note: The Attendant PC software must be installed before the PC
Console Interface Unit (PCCIU) is installed.

Required Hardware
PC Console Interface Unit (PCCIU)

one DB25 system cable
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* one DB9 RS-232 serial cable that connects the “Installing the PC
Console Interface Unit” (page 201) to the PC

* Adapter (may be required to connect the PCCIU to the PC with the
DB9 RS-232 serial cable)

* Handset

* Headset (optional)

Use Procedure 138 “Installing the PCCIU” (page 202) to install the PCCIU.

Procedure 138
Installing the PCCIU

Step Action

1 Nortel recommends that you place the Attendant PC flat under
the PC monitor with the front panel facing forward.
Figure 91
PC Console Interface Unit front panel
i —
I 0 e
Stats LEDC ‘ﬂﬂﬂTﬂTnnF 9t J)
L1 | I—
Front Panel
2 Connect one end of the DB25 system cable to the Meridian 1
connector on the rear of the Attendant PC.
3 Connect the other end of the DB25 system cable to the MDF
connector.
4 Attach the DB9 connector from the DB9 RS-232 serial cable to
the PC port on the Attendant PC.
5 Connect the other end of the DB9 RS-232 serial cable to the

serial port (COM port) on the PC.

Note: An adapter may be required to connect the DB9
RS-232 serial cable from the PCCIU to the PC.
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Figure 92
PCCIU back panel

connection for DBO RS-232 cable from
the PC's serial port (COM port)

connecticn for th ird-party
audio applications (optional)

diagnostic LEDs for
maintenance

Meridian 1

Phote In Awdio Dut PFT

Reset

-

B OO'IE-'“ 1234 Q

T
connection for the DB25 system cable
from the MDF connector of the

Meridian 1 system

T |
connection for Meridian reset button

Drigital Telaphone (optional )

power fail
transfer switch

Attach a headset to the RJ32 jack or a handset to the PJ327
two-prong connector jack on either side of the PCCIU. See
Figure 93 "Correct PJ327 insertion" (page 203) for the correct
PJ327 two-prong connector jack insertion.

Note 1: The PCCIU supports both amplified and non-amplified
headsets.

Note 2: The PCCIU does not support carbon type headsets
or handsets. Contact your Nortel distributor for further
information on headsets and handsets.

Figure 93

Correct PJ327 insertion

Ensure that the brandline plate on the handset connector jack
faces forward.
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Figure 94
Incorrect PJ327 insertion

The brandline plate on the handset connector jack must face
forward.
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Figure 95
Connector usage

connector

If a Power Fail Transfer Unit (PFTU) is available, connect the
Power Fail Transfer pair (11 and 36 in Figure 96 "PCCIU system
wiring to the MDF block" (page 206)) from the MDF block to the
PFTU.

If desired, install a M3900 Series Digital Telephone through the
teledapt PHONE connector at the rear of the PCCIU using a
two-wire pair on the MDF block (BACK_UP 1 and BACK_UP 2 in
Figure 96 "PCCIU system wiring to the MDF block" (page 206)).

Note: The M3900 Series Digital Telephone can be used as a
Night DN, or if the PC falils.

Connect the General_Purpose relay to the MDF block as shown
in Figure 96 "PCCIU system wiring to the MDF block" (page
206).

Note: LDNO must be configured with EMER_DN for this relay
to work properly.

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



206 Installing the Attendant PC Software

10 Use the Audio Input/Output jacks to connect third-party audio
applications, for example, a sound card. Refer to the third-party
audio applications user manual for instructions.

—End--

Figure 96
PCCIU system wiring to the MDF block
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First TN
TCM Primary

i

Second TH arw
TCM Secondary
Third TH wsl | 30
sbw T &5
Power
bk-bl = 26
|__ bkbk T 11
GMND
TC
GND bk-br 1= 39
ALARM br-bk T 14
BACK P —— ypy 1]
BACK_LUP2 —1 bty T 15
Might_Relay 2 ——— y-br - 44
Night_Relay1 —] bry = 19
General_Purposa_Relay 2 — Y5 P 45
General_Pumpase_Realay 1 =] =¥ T 20
EMER_OM_Relay2 —0—d o M =0
EMER_DM_Relay 1 sl-v T 25
Cable from Cable from

Meridian/Suceassion  Attendant PC unit

Use Procedure 139 “Configuring the PC Console Interface Unit” (page
206) to configure the PCCIU.

Procedure 139
Configuring the PC Console Interface Unit

Step Action

1 Make sure that there are three available ports on the digital
line card (or four free units if you installed an M3900 Series
Digital Telephone in Step step 8 of Procedure 138 “Installing the
PCCIU” (page 202)).

2 In LD 12, configure the first two ports as the primary and
secondary TNs using the same setup as the M2250.

Refer toSoftware Input Output Reference -- Administration
(NN43001-611). At the TYPE prompt, enter 2250.
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Then configure the third unit as a power unit.

In LD 11, configure the fourth unit as a NIGHT_DN if you
installed an M3900 Series Digital Telephone in Step step 8 of
Procedure 138 “Installing the PCCIU” (page 202)).

If you are using a PFTU, configure a TN in LD 10 using
the same setup as the analog (500/2500-type) telephone.
Refer to Software Input Output Reference -- Administration
(NN43001-611).

Place the PFT in the OFF position (1 = On, 0 = Off).

Ensure all system cross-connects to the PCCIU are wired at the
MDF block. See Figure 96 "PCCIU system wiring to the MDF
block" (page 206).

Connect the DB25 system cable to the MDF block.

Connect the DB9 RS-232 serial cable to the PC serial port (COM
port).
Launch the Attendant PC software application.

Note: If you experience a one way speech path, check all
cross-connections, and make sure all connections are secure.

—End--

Self Test and Diagnostics

When the PCCIU powers up, it performs a self-test diagnostic routine. The
Status LED on the front of the PCCIU should turn red for 2 seconds and
then turn solid green, and the Diagnostics LEDs on the rear of the PCCIU
should flash once and then turn off.

If a failure occurs during the PCCIU self-test diagnostic routine, the
Status LED will change to yellow and the error will be indicated by which
Diagnostics LEDs are illuminated. Contact your authorized distributor to
report the problem.

Note: Only one error can be indicated at a time, in priority-order from
highest (1) to lowest (7).

Table 6
LED number, description, and priority PCCIU Status LEDs
LED#
1 2 3 4 Description Priority
Off Off Off Off Self-test passed
On Off Off Off EEPROM failure 7
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[EiDDIenﬁmber, description, and priority PCCIU Status LEDs (cont’d.)
LED#
1 2 3 4 Description Priority
Off On Off Off Alerter micro failure 6
On On Off Off Port expander failure 5
Off Off On Off Loopback test failure 4
On On On Off RAM failure 1

Troubleshooting the Status LED
The Status LED indicates the current status of the PCCIU as follows:

Solid green indicates that the PCCIU is operating normally.

Off indicates that there is no power going to the PCCIU. Contact your
system administrator.

Flashing red is a major alarm indicating that a System-related error
has occurred. Contact your system administrator to report the problem.

Flashing green indicates one of the following:

a. PCCIU is in Night Service or Position Busy

b. Power Fail Transfer (PFT) switch is in the incorrect position (Off)
C. handset or headset is not connected properly

Solid red indicates that the PCCIU is not communicating properly with
the PC. Contact your system administrator to report the problem.

Solid yellow indicates that a failure occurred during the PCCIU
self-test diagnostic routine. Contact your Nortel authorized distributor to
report the problem.

Standalone test procedure
Use Procedure 140 “Performing the standalone test procedure” (page
208) to perform the standalone test procedure.

Procedure 140
Performing the standalone test procedure

Step Action

1

Disconnect the DB25 system cable to power down the PCCIU
and then disconnect the DB9 RS-232 serial cable.

Make a connection between pins 2 and 3 on the PC port at
the rear of the PCCIU. Nortel recommends you to use a DB9
connector with pins 2 and 3 jumpered (shorted).
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3 Power up the PCCIU by reconnecting the system cable and
pressing the reset button at the rear of the unit.

ATTENTION

IMPORTANT!

The reset button should only be used when performing this
standalone test procedure with pins 2 and 3 on the PC port
connected (as described in step 2). The PCCIU runs its self-test
diagnostics and goes into run mode. (If the PCCIU fails the self-test,
the Status LED will turn yellow and the Diagnostics LEDs will
indicate what is wrong, as previously described in "Self-Test and
Diagnostics.")

4 Disconnect the DB25 system cable to power down the PCCIU,
reconnect the DB9 RS-232 serial cable, and then reconnect the
system cable.

5 If the PCCIU still fails to communicate with the PC, check
the DB9 RS-232 serial cable and the PC communication port
settings.

--End--
Audio In/Out

The audio input/output jacks (3.5mm) are located on the rear panel. The
input and output impedances are 600 2. These ports can be used to
connect the PCCIU audio paths to external audio applications, under
control of the PC application.

Alarm or event notification
In the event of PC failure, or loss of synchronization/communication
between the PC or PC-based Console application software and the
PCCIU, there is no alarm or event indication. The PCCIU Status LED will
still show solid green and calls will still present to the console.

To remove the console from service until the PC function is restored,
activate the Power Fail Transfer (PFT) switch or remove the headset
or handset. For further information, refer to the Meridian 1 PC Console
Interface Unit Quick Reference Guide.
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Using Attendant PC Help Facility

The Attendant PC Help Facility gives you instant information about the
console application. Whenever you press, you get information related to
what you're doing at that time; and then when you press (cancel), you're
returned exactly to where you were before.

GY)

And there’s more to help than that—there’s linking to related topics, a help
index, information on keys and start up tips. It's really a built-in manual
that is always within easy reach by accessing the Help menu Contents
tab using your mouse.

Figure 97 "Attendant PC Help Facility" (page 212) shows Attendant PC
Help Facility window.
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Figure 97
Attendant PC Help Facility
About the Nortel Meridian 1
Attendant PC provides an
overview of console features
and describes how to register = 5
foix saiwite. Help Topics: Nortel Meridian 1 PC Console K|
Features describes the Contents Ilrliez | Fird ]
Altendant PC's ICI, TGB,
flexible and virtual features
abook, and then chck Open. Or click anather tab, such as Index.
Using the PC console screen
details how to administer the Y bbat Nofte| M'Hldlirl 1 ﬁ.HE’ﬂda’t F.E
consale’s screen. e -
gatures
Configuring the PC console :
screen describes how lo set /' 0 Uy ﬂ'pe Pl o
up or manage console Conbguringthe PC console screen
functions such as ICI, TGB, Q Reference
voice mail, and virlual features.
=y
Reference provides quick ki o

access to glossary and
troubleshooling information.

Note: The Help facility is described in more detail in the section “Using
the Attendant PC online help” (page 23).
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Installing the LAN Interface Software

Contents
“Overview” (page 213)
“Requirements” (page 213)
“Installing the LAN Interface Software” (page 214)
“Configuring Access Privileges” (page 221)
Overview

This section provides instructions for installing the Attendant PC LAN
Interfacesoftware.

Requirements
Each workstation which will use the Attendant PC LAN Interface must
already have the Attendant PC software installed and have met these
requirements as described in CS 1000/Meridian PC Console Interface Unit
Installation Guide (P0944090) .

®* PC compatible computer system containing:
— Pentium processor, 100 MHz or higher
— 16 MB RAM available memory
— Hard disk with at least 10 MB of free disk space
— 17" SVGA color monitor (set for 1024 by 768 resolution, 256 colors)
— 16-bit sound board (recommended)
— Printer (optional)
— Network interface adapter
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— Windows 95®, Windows 98®, Windows 2000®, Windows NT® or

Windows XP® operating systems

— RS232 serial port

Additionally, a workstation that will be part of the Attendant PC LAN
requires the following:

®* One copy of the LAN Interface software

* Connection to a Windows 95®, Windows 98%, Windows 2000%,
Windows NT® or Windows XP® compatible network

Installing the LAN Interface Software

Note: Before you set up the software, turn off any virus protection
programs you may have running. Virus protection programs can
interfere with the set up process.

The disk set in your package includes an InstallShield Wizard to help you
quickly install your copy of the Attendant PC LAN Interfacesoftware.

Use Procedure 141 “Installing the LAN Interface software” (page 214) to
install the LAN Interface software.

Procedure 141
Installing the LAN Interface software

Step

Action

Make sure that no applications are running.

Make a written note of the serial number printed on the disks.
This number will be requested later during the installation.

Insert Disk 1 into the drive from which you want to install.
Double-click the My Computer icon on your Windows desktop.

Double-click the Control Panel icon.
Double-click on Add/Remove Programs icon.

Figure 98 "Accessing the Control Panel" (page 215) shows how
to access the Control Panel and Add/Remove Programs.
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Figure 98
Accessing the Control Panel
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Figure 99 "Install/Uninstall property sheet from Add/Remove
Programs properties page" (page 215) shows the Add/Remove
Programs properties display window.

Figure 99

Install/Uninstall property sheet from Add/Remove Programs
properties page

AddRemove Programs Properties E
Inztall/Uninstall I Windows Setup | Startup Disk I

Tao install & new pragram from a floppy disk or CO-ROM
drive, click [nstall

The following software can be automatically removed by
‘windows. Toremove a program or to modify its installed
components, select it from the list and click

Add/Remave.
Adobe Acrobat =
Adobe Acrobat Reader 3.0
Adobe Frametdaker v5.1.1
Cybertedia Oil Change
Diamond Mulimedia Product Installation & Remnoval
E azyPhoto
Eudora Pro Version 2.2
ForeHelp 2.95
Hivigw =l
AddrEemaye. . |
1] 3 | Cancel I Apply |
Click Install.

Figure 100 "Install Program from Floppy Disk or CD-ROM
window" (page 216) shows the Install Program from Floppy Disk
window.
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Figure 100
Install Program from Floppy Disk or CD-ROM window

Inztall Program From Floppy Dizk or CD-ROM

Inzert the praduct's first installation floppy disk or CO-ROM,
and then click Mext.

Cancel

8 Click Next.

Figure 101 "Run Installation Program window" (page 216) shows
the Run Installation Program window.

Figure 101

Run Installation Program window

Run Installation Program

IF thiz iz the correct installation pragram, click Finish. Tao
stark the automatic search again, click Back. To manually
search for the installation program, click Browse.

< Back I Firizh I Cancel

9 Click Finish.

The Attendant PC LAN Interfacesetup prepares the "InstallShield
Wizard" to assist you in the set up process.

Meridian 1 Attendant PC - LAM Key Setup iz preparing the
InstallShield ‘Wizard which will guide vou through the rest
- of the setup process. Please wait.

L
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The installation process continues with the Attendant PC LAN
Interfaceset up program or Welcome display.

Figure 102 "Welcome window" (page 217) shows the Welcome
window.

Figure 102

Welcome window

Welcome

‘welcome to the Meridian 1 Attendant PC - LAN Kep Setup
program.  This program will install Meridian 1 Attendant PC - LAN
K.ew on vour comouter.

It iz strongly recommended that you exit all \Windows programs
before running this Setup program.

Click Cancel to quit Setup and then cloze any programs vou have
unning. Click Mest to continue with the Setup program.

WARMING: This program is protected by copyright law and
international treaties.

Unauthorized reproduction or distribution of thiz program, or any
portion of it, may result in severe civil and criminal penalties, and
will be prosecuted to the masimum extent possible under law.

Cancel |

10 Click Next to display the User Information window.

Figure 103 "User Information window" (page 217) shows the
User Information window.

11 Supply the appropriate information and click Next.
Figure 103
User Information window

User Information

Type wour name below. v'ou must also bype the name of the
company you work for.

Mame: |J ohn Smith

Company: IAcme Corp.

< Back I Mest » I Cancel |

12 Click Next to choose the Destination Folder for the Attendant
PC, or browse to select another folder.
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13

14

Figure 104 "Choose Destination Location window" (page
218) shows the Choose Destination Folder window.
Figure 104

Choose Destination Location window

Choose Destination Location

Setup will install Meridian 1 Attendant PC - LAN Key in the
following directony.

Toinstall to this directory, click Mest.

To install to a different directary, click Browse and select another
directory.

“Y'ou can choose not to install Meridian 1 Attendant PC - LAN Key,
by clicking Cancel bo exit Setup.

C:A SHortelsMendian 1 Attendant PC Browse... |

" Drestination Directons

< Back Cancel |

Click Next to add icon programs to a Program Folder or type a
new program folder.

Figure 105 "Select Program Folder window" (page 218) shows
the Select Program Folder window.

Figure 105

Select Program Folder window

Select Program Folder

Setup will add program icons to the Program Folder listed below.
“r'ou may type a new folder name. or select one from the existing
Folders list. Click Mext to continue.

Program Folders:

M eridian 1 Attendant PO

E zizting Folders:

Frame Products B
Hivfiew

HF Laser)et 5L Prirter J
InControl Tools 95

lomega Tools

Macromedia Shockwave
I céfes ViusScands

Ieridian 1 Attendant PC

< Back I Mest » I Cancel |

Click Next to accept the current settings. Click Back to change a
setting.

Figure 106 "Start Copying Files window" (page 219) shows the
Start Copying Files window.

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



Installing the LAN Interface Software 219

Figure 106
Start Copying Files window

Start Copying Files

Setup has enough infarmation to start copying the program files. If
wou want to review or change any settings. click Back. Ifyou are
satisfied with the settings, click MNext to begin copying files.

Current Settings:

Setup Type: -l
Cormplete

Target Folder
ChProgram Files\MNorel\Meridian 1 Attendant PC

User Information
Marme: John Smith
Company: Acme Corporation

L o

< Back

Cancel |

A status gauge reports the final copying progress of the
Attendant PC LAN Interfaceset up program.

The Setup Complete window is displayed indicating that the
Attendant PC LAN Interfacesoftware installation has been
completed.

Figure 107 "Setup complete display" (page 219) shows the
Setup Complete window.

Figure 107

Setup complete display

Setup Complete

Setup has finizhed copying files to pour compter.
Setup will now launch the pragram. Select paur option belaw.

Click Finizh to complete Setup.

< Back I Finizh I

15 Indicate a to launch the program icons.
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16

17

W

Figure 108 "Attendant PC LAN Interfaceprogram icons" (page
220) shows the program icons.

Figure 108

Attendant PC LAN Interfaceprogram icons

I Meridian 1 Attendant ... [Ej[=]
File Edit “iew Help
1240 Serial Number.
L AN Key
Meridian 1 Attendant PC

|3 object(s) =

Click Finish to complete the Attendant PC LAN Interfaceinstal
lation.

Enter the serial number found on the installation diskette, then
click OK to confirm your serial number is correct.

Figure 109 "Attendant PC LAN InterfaceSerial number" (page
220) shows the Attendant PC LAN Interface Serial number
window.

Figure 109

Attendant PC LAN InterfaceSerial number

%= LAHKey Installation

Enter the LAN key zerial number.
Cancel |

Mote: If you have already registered thiz console it
must be reregistered after a LAN key iz installed.

Figure 110
PC LAN Interface software has been successfully installed

Meridian 1 Attendant PC LAH Key B

@ The LAM key has been successfully installed. You may now install and register additional consoles.

Installation of the LAN Interface software allows the sharing of
directory information among workstations. When a workstation
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makes an entry in the directory, all workstations will be updated,
including any information screens.

—End--

Configuring Access Privileges
Access privileges, which determine whether a given workstation can
perform certain actions, such as make changes to the directory, are
located under the Configuration menu "Attendants" tab.

The "Rights" box lists privileges that can be configured for each attendant.
A check in a box indicates that the attendant has the privilege to perform
the specified function.

For example, the attendant with the "New Attendant #1" identifier has
the privileges to "Log on to a Console" and "Edit general parameters.”
However, the absence of check marks in other boxes indicates that no
other privileges are available to this attendant. This means that "New
Attendant #1" could not, for instance, "Add/edit an attendant” or "Edit
Directory Information."

Note: You must register at least one Attendant PC and the LAN
interface module before attempting to add additional workstations.

Figure 111 "Attendant rights" (page 222) shows the Meridian 1 Attendant
PC Configurator window.
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Figure 111
Attendant rights
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Alarm
Also called off-hook alarm security. Enables any call to be
intercepted by a customer-defined extension; for example, by
security’s extension.

Auto Dial

A dialing feature available on a programmable feature key in
which the telephone user programs the number into the Auto
Dial key, which will thereafter dial the number whenever the user
presses the key.

Automatic Wake-up
A hospitality flexible feature which allows an overnight guest to
state the time he/she wants to be awakened. The telephone
system will ring the guest at the specified time.

Barge In
This flexible feature key enables you to verify the status (idle or
busy) of any trunk or special service access line.

Break In
A programmable feature key that enables you to enter an
existing connection to offer a call or relay an important message
(international use only).

Busy Verify

A flexible feature key that enables the attendant to verify the
status (idle or busy) or any extension.

Call Forward Busy
An ICI key that allows a call at a busy extension to be
automatically routed to you because the extension was
programmed this way.
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Call Forward No Answer
An ICI key that allows a call to an extension that does not answer
to be automatically routed to you because it was programmed to

do so.

Call Park
A flexible feature key that enables you to place a call on hold
without occupying a loop key on your console.

Call Waiting

This light on the console indicates the number of calls in queue
to be answered. If no calls are waiting, the light is off. If 1-3 calls
are waiting, the light is green. If more than three calls are waiting,
the light is red, and the number of calls waiting appears beside
the light.

Calling Party Number
A programmable feature key that enables you to record the calling
party number on an incoming collect call or to assign a special
billing code to an incoming collect call.

Camp-on
Routes one additional external call to a busy DN. Applies only
to attendant-extended calls. If the called party is not free within
a specified time, the caller is routed back to the attendant as a
recall.

Centralized Attendant Service (CAS)
One group of operators or attendants answers all telephone calls
coming into a company’s Media Gateway 1000B (MG 1000B)
within an assigned region. Enables the attendant at a remote
location to automatically reroute calls to a CAS attendant at the
main location. In addition, this feature enables the CAS attendant
at the main location to get a dial tone from a remote location to
extend a call there.

Charge Account
A flexible feature key that enables you to enter a charge account
number for a call going out through your console.

Codes
These codes permit you to temporarily override the access
restrictions assigned to an on-site caller extension.
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Communication Server for Enterprise 1000 (CSE 1000)

Conference

Console

For CSE Release 2.0 (also known as "X21"), the term "CSE 1000"
referred to an IP-based PBX. For Succession Release 3.0, the
term "CSE 1000" was replaced by "Succession 1000. For CS
1000 Release 4.0, the term Succession 1000 was replaced by
Communication Server 1000S.

The following table shows how this change has been implemented
in product names.

$:lr3rlnein7mogy changes: Communication Server for Enterprise (CSE)
Succession 3.0 CS 1000 Release 4.0
CSE 1000 Communication Server 1000S
CSE 2000 Communication Server 2000
CSE MX Multimedia Communication
Server 5100 (MCS 5100)

Allows you to establish a conference with up to six parties (on two
trunks), including yourself.

A telephone receiver that can perform operations on incoming
and outgoing calls, such as the large unit used by telephone
attendants.

Controlled COS

Controlled Class of Service. A flexible feature key that enables
the attendant to alter line restrictions for a group of users that all
have the same Class of Service.

Call Waiting Indication

Destination

DID trunks

One or more incoming calls are waiting to be answered; a
key/lamp pair and a tone provide a warning. One waiting call can
be answered when current call is released.

In telephony, the destination of a call is the called party.

Direct Inward Dial trunks; trunks on which outside calls are
presented.
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DID Route Control
A programmable feature key that enables you to direct calls
coming in on DID trunks either to either to a set of extensions
considered to be night destinations, or to normal extensions.

Display Calls Waiting
A flexible feature key that enables you to display the number of
calls waiting to be answered at the console.

Display Destination
A programmable feature key that enables you to display the
phone number of a called party.

Display Source
A programmable feature key that enables you to display stored
numbers associated with Auto Dial, Speed Call, and Night
Service.

Do-Not-Disturb Group
A programmable feature key that enables you to place a
predefined group of extensions in the Do-Not-Disturb mode.

Do-Not-Disturb-Individual
A programmable feature key that enables you to place an
individual extension or a predefined group of extensions in
Do-Not-Disturb mode.

DRC
See DID Route Control.

DTMF
Dual-Tone Multi-Frequency. Tones generated when the keys on a
telephone keypad are struck that enables the switch to signal the
desired telephone that a caller wants to be connected.

Electronic Switched Network
See ESN.

Emergency transfer switch
This feature, accessible from your Attendant PC interface unit,
will present incoming calls from selected trunks to preselected
telephones instead of to your console. Use this feature only during
an emergency when these telephones must have direct access to
dedicated trunks.
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End-to-End Signaling (EES)
This flexible feature that you program on the "Flex Keys" sheet
from the Config menu, enables voice messaging (Voice Mail) and
paging from the attendant.

ESN
Electronic Switched Network. A telephone system that uses
electronics to perform call switching and associated billing.

Exclude Destination
An attendant presses the Excl Des button on the console so that
he/she can have a private conversation with the calling party
(source).

Exclude Source
An attendant presses the Excl Src button on the console so that
he/she can have a private conversation with the called party
(destination).

Fixed feature
A fixed feature appears in all installations of the Attendant PC and
cannot be edited or removed. Fixed features include alarm, call
waiting, CAS, conference, night service, position busy, release
destination, release source, signal destination (source), and
exclude destination (source).

Flexible Feature
A console feature assigned in the System by an engineer and
given a key label and definition in the console.

Foreign Exchange
See FX.

Fully Restricted
A call from a fully restricted extension. A person using this
extension can place calls to and receive calls from other
extensions and the attendant, but is denied access to all incoming
and outgoing trunk lines. Incoming calls for a fully restricted
extension come to the attendant, who then extends them.

FX
Foreign Exchange, type of trunk. Fx is the label on an ICI key
which receives calls from Foreign Exchange trunks.
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ICI

Incoming Call Indicator. A key on the Attendant PC interface unit
that flashes to inform the attendant that an incoming call on a
particular trunk is waiting to be answered. An ICI "key" indicates
the first call; later calls light up the message waiting indication until
the first call is released.

May also refer to the light that identifies the type of call coming
to your console (ICI), such as internal external, WATS, tie

trunk, emergency, and so on. All incoming calls are queued
automatically in the order of arrival, and the appropriate I1CI
indicators go on. You can click on a flashing ICI light to answer
the call associated with it. Set up your ICI keys from the ICI keys
page on the Config Console menu.

Incoming Call Indicator

Intercept

See ICI.

The call that activates this button may be from a caller who

dialed the access code for a busy trunk group, or from a caller
encountering equipment or dialing irregularities, such as a caller
who dialed an extension in Do-Not- Disturb mode. Finally, this call
may be from a restricted or semi-restricted extension attempting to
make a call that is not allowed.

Interpositional Call

LDN

Interpositional Call. This ICI key indicates an incoming call from
another attendant at your location.

Listed Directory Number. This is an ICI key that indicates a call

to a number for your organization that is found in the public
telephone directory. When the feature Network Attendant Services
is enabled, the LDNs are recognized across the network.

Listed Directory Number

Loop

See LDN.

A line that comes into the console, over which the attendant can
assign an outgoing call or answer an incoming call.
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Malicious Call Trace
A flexible feature key that enables you to identify an internal
obscene or otherwise objectionable call. This feature can also
trace static on the line.

Meridian
The term "Meridian" represents a Nortel product family. For CS
1000 Release 4.0, the term "Meridian" has been removed from
several product names. Table 8 "Terminology changes: Meridian
(page 229) shows how this change has been implemented.

Table 8

Terminology changes: Meridian
Succession 3.0 CS 1000 Release 4.0
Meridian Integrated Call Assistant | Integrated Call Assistant
(MICA)
Meridian Integrated Conference Integrated Conference Bridge

Bridge (MICB)

Meridian Integrated Personal Call | Integrated Call Director
Director (MIPCD)

Meridian Integrated Recorded Integrated Recorded Announcer
Announcement (MIRAN)

Meridian Integrated Voice Service | Hospitality Integrated Voice
(MIVS) Services

Message Cancellation
A flexible feature key that enables you to turn off the message
waiting signal at an extension after you have delivered the
message for that extension.

Message Center
This ICI key indicates that a caller wants to leave or retrieve
a message. This indicator appears only on Attendant PCs
programmed to handle message center features.

Message Indication
A flexible feature key that enables you to turn on the message
waiting signal at an extension for which a message has been
taken.
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NAS

Network Attendant Services. This feature allows attendant
console positions to be dispersed in multiple locations within
the network. Pressing the NAS key on your console makes you
available for calls from all network locations.

Night (Service)

Paging

The System goes into night service when all consoles are
unattended. Then, all incoming calls are routed to a destination
other than the consoles (such as to a security representative), or
to a Night Service Extension (where callers may hear a recorded
message).

A programmable feature key that enables you to connect to your
organization’s paging equipment. Press the key for the duration
of your announcement.

Peripheral Equipment (PE)

Position busy

Recall

Release

On CS 1000 systems, Intelligent Peripheral Equipment (IPE) is
supported, but Peripheral Equipment (PE) is not supported.

When an attendant will be leaving the console, he/she presses
this button. As a result, the System transfers all calls incoming to
the departing attendant’s console to other attendants.

This ICI key indicates the return to you of a call that you have put
through to an extension that is busy or does not answer within a
set time (usually 30 seconds). This ICI can also indicate a call
from an extension user who has activated the Attendant Recall
feature.

Mouse-operated key on the right side of the Attendant PC
Software screen display. Enables the attendant to release a
connection from the console.

Release destination

A Fixed Feature key on the console which allows the attendant to
disconnect the called party (destination) from a call.
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Release Line Trunk
Telecommunications line used with Centralized Attendant Service
to connect callers from a remote location desiring an attendant
at a main location.

Release source
A Fixed Feature key on the console which allows the attendant to
disconnect the calling party (source) from a call.

Remote
A key on systems equipped for CAS (Centralized Attendant
Service) that indicates a call from a remote location, routed over a
release link trunk.

Restricted "0"
Key turns on when a call is from a fully restricted extensions,
which is denied access to all incoming and outgoing trunk
lines. Incoming calls for a fully restricted extension come to the
attendant, who can then extend them.

RLT
See Release Line Trunk.

Route access codes
Directs a call over a certain route to reach a specific destination.
The code may represent a specific line for a call (Tie, WATS, or
public trunk) or an attendant console for placing or transferring a
call.

Signal destination
The attendant pushes a key that signals a called party that he/she
is connected to the attendant.

Signal source
The attendant pushes a key that signals a caller that he/she is
connected to the attendant.

Source
In telephony, the source of a call is the calling party.

Speed Call
A dialing feature available on a programmable feature key
that enables you to dial any number stored by the Speed Call
Controller. As an alternative you can enter the Speed Call SPRE
code, and then enter the code assigned to the desired number.
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Speed Call codes
A feature available on a programmable feature key that uses a
code to dial a programmed number automatically. The Speed
Call Controller assigns codes to the list of telephone numbers for
dialing by the Speed Call feature key.

SPRE codes
Special PREfix code, one to four digits long, that is assigned by
your System administrator. You use the code to operate a feature
for which your console has no dedicated (programmed) feature
key.

Stored number redial
Pressing the correct flexible feature key allows a number to
be stored after it has been dialed, either before or during the
connection, for later automatic dialing.

Succession
The term "Succession” represents a Nortel product family. Within
this family, the term "Succession 1000" represents the name of
an IP-based PBX, while "Succession Call Server" represents the
name of a component.

For CS 1000 Release 4.0, the family name "Succession" has
been replaced by "CS 1000", while the product name "Succession
1000" has been replaced by "CS 1000S".

In addition, the term "Succession" has been removed from the
name of several components in CS 1000 systems (CS 1000E, CS
1000M, and CS 1000S).

Table 9 "Terminology changes: Succession" (page 232) shows
how this change has been implemented in product names.

Table 9

Terminology changes: Succession
Succession 3.0 CS 1000 Release 4.0
Succession 1000 Communication Server 1000S
Succession 2000 Communication Server 2000
Succession Branch Office Media Gateway 1000B
Succession Call Server Call Server
Succession Element Manager Element Manager
Succession Media Card Media Card

Nortel Communication Server 1000
Attendant PC Console Fundamentals
NN43001-520 04.01 4 June 2010

Copyright © 2003-2010 Nortel Networks. All Rights Reserved.



233

Table 9

Terminology changes: Succession (cont’d.)
Succession 3.0 CS 1000 Release 4.0
Succession Signaling Server Signaling Server
Succession System Controller Small System Controller

Supervisory mode
Selecting the Make Set Busy key when your set is idle enables
you to monitor other attendants, call an attendant, transfer a call
to another attendant, and receive a call from another attendant.

System Speed Call Controller
A flexible feature key that can overcome restrictions on individual
telephones via programming so that the users can call out to
specific set of numbers, such as for emergencies (ambulance, fire
department, 911) or to a company out-of-area MG 1000B, etc.

Through-dialing
Extension or tie-line users may request access to a number which
requires use of a trunk which they are not allowed to access.
Access the trunk for the user. Then the user can then dial out
(except onto fully restricted trunks).

Tie trunk
A dedicated circuit linking two PBX's.

Trunk group
A set of telephone lines of a particular type, such as WATS, TIE,
public, or Foreign exchange.

Trunk group busy (TGB) keys
Your console may have up to ten trunk groups, but only if ICI2
is provisioned on the System. Press a Trunk Group Busy key
to deny users access to that trunk group. Configure TGB keys
from the TGB page from the Console Config choice on the Config
menu.

Trunk-to-trunk call
A user, while outside the system, may call to request access
to an outgoing trunk. You dial the trunk access code, than the
requested number. Press RLS to connect the calling and called
parties.
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Unanswered wake-up calls
If a hotel/motel guest does not respond to the first wake-up call,
the System makes up to two more attempts at 5-minute intervals.
If the guest does not answer after the third call, the System, if set
for this option, notifies you of an unanswered wake-up call.

Unrestricted or Semi-restricted
Refers to a call from an unrestricted or semi-restricted extension.
An unrestricted extension user can place and receive all types of
calls. A semi-restricted extension user can place calls to other
extensions, and can place calls to the public network with the
assistance of the attendant.

VIP wake-up
A hospitality feature that extends a VIP wake-up call to your
console. Press an idle loop key, followed by the Auto Wake-up
key. If the DN is busy or the guest does not answer, press the
RLS key. If the guest answers, deliver a personal wake-up
message to the guest.

Virtual feature
A console feature created entirely using software commands.

WATS
Wide Area Telecommunications Service. A discounted
long-distance service provided by all telephone companies. Also,
a label on one or more of your Loop Pickup keys.

To refer to the hardware platform that supports a Branch Office
configuration, the term Media Gateway 1000B (MG 1000B) is
used.
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adapter 202
adding a flexible feature 70
adding an ICI key 36, 39, 75-76, 79
Alerter page
Attendant PC Properties sheet 81
Answer key 21
answering a call 88
attendant
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Attendant Console Autoline 120
Attendant Emergency Codes 123
Attendant monitoring
atrunk 129
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Relay page (diagram) 83
Attendant PC unit 201
Attendant Recall 98
Audio Input/Output jacks 206, 209
authorization code (ESN) 168
Auto Dial 130
Auto Dial number
storing 131
Autoline 120
Automatic Wake Up 131

B

barge-in 135
break-in
by attendant to busy extension 128
build the operator Toolbox 41
busy verify 136

C

call
answer from a remote console
(NAS) 164
extending a call to an idle extension
(CAS) 160
extending to busy remote ext.
(NAS) 165

extending to busy remote loc. (CAS) 161
extending to idle remote ext. (NAS) 166

extending with off-hook queueing
(ESN) 170
putting on silent hold (CAS) 162
transfer to another remote ext.
(NAS) 167
Call Park 94, 193
Call Waiting page (Attendant PC
Properties sheet) 82
Calling
an Auto Dial number 130
an extension 101
an outside number 102
another attendant 107
Camp-on 90
cancelling Do-Not-Disturb 139
CAS features
extending a call to an idle extension
Extending call to a busy remote ext.
putting a call on silent hold 162
remote recall 162
transferring recall to remote
extension 163

160
161

Centralized Attendant Service features 159

Centrex Switchhook Flash 118
change database location 197
Change Password dialog box 86
Charge Account 136
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Charge account (ESN) 168
Conference 105
conference call 105
Config menu

submenu list 63
Console Config sheet

Features page 69

ICI page (diagram) 36, 39, 76, 79
console keys, using 20
Contents tab 175
CPLUS

accessing a CPLUS directory 195
Create a Directory entry 47
creating an information screen 60
creating hotkeys 66
creating virtual features 31, 71
customizing keys 31, 71

D

database 197
diagnostics 207-208
Diagnostics LEDs 207
Diagnostics page (Attendant PC
Properties sheet) 84

dialing 18, 23
dialog boxes

Change Password 86
DID Route Conversion 137
DID routes

controlling 137
digital line card 206
directory 197
Directory command on Tools menu 46
displaying, changing Night Service

option no. 148

Do-Not-Disturb

cancelling 139

overriding 140

testing 141

E

End-to-end signaling feature 142
enhanced night service

turning on and off 144
Enhanced Night Service 142
Enhanced Secrecy feature 145
ESN

authorization code 168

Charge account 168

expensive route warning tone 169

routing control 171
Exit option 28
expensive route warning tone (ESN) 169
exporting Directory numbers 199
extending a call

to a busy remote extension 161
Extending a call 89

off-hook queueing (ESN) 170

to a busy extension (with Camp-on) 90

to a busy extension (with Hold) 92

to idle remote ext. (NAS) 166

to voice mail 91

to voicemail 91

F

Feature List option 28

features commonly available 69

Features page 69

Flex Keys page (Console Config sheet) 74

G

General page (Console Config sheet) 64
General Purpose relay 205

H

handset 202

Handset page (Attendant PC Properties
sheet) 82

hardware 201

Help menu 23, 174

choices 23

Console Help 23

Contents selection 23

Contents tab 175

Context Help selection 23

Find tab 177

Glossary 178

Index selection 23

Index tab 176

Options menu 178

help topics 212

Hold key 21

holding a call on a Ipk key 93

hotkeys 66

IADN 122
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ICI keys, how to setup 75
ICI List option 28
importing Directory dialing numbers 200
Incoming Call Indicator keys 35
Index tab 176
Individual Attendant Directory Number
information screens

accessing 62

creating 60
installation

Attendant PC software 182

K

key operation 20

L

license agreement
loop keys 21

M
Main Distribution Frame (MDF) 202

main screen 191
major alarm 208

122

186

menus
Help 23
Tools 28

Meridian Digital Telephone 205
monitoring by attendant
trunk 129

N
NAS (Network Attendant Service)
answering a call from a remote
console 164
extending a call to a busy remote
ext 165
extending a call to idle remote ext.
(NAS) 166
features 164
remote recall 167
transferring a call to another remote
ext. 167
network features
Centralized Attendant Service
(CAS) 159
ESN, ISDN 159
Network Attendant Service (NAS) 159
network speed call (ESN) 170

Night Service 146
displaying, changing option number
enhanced 144
enhanced feature 142
turning on and off 147

O

online help 173, 211
overriding Do-Not-Disturb 140

P

Paging feature 149
PJ327 2-prong connector jack 203

148

ports 206
Position Busy feature 149
power
no power going to the Attendant PC
unit 208

Power Fail Transfer Unit (PFTU) 205, 207
Procedures

Adding a flexible feature 70

Adding an ICI key 36, 39, 76, 79

Create a Directory Entry 47

Setting up the Voice Mail icon 65
putting a call

on hold 93

on silent hold 162

R

recall
remote (CAS) 162
remote (NAS) 167
transf. to another remote ext.
Recalls
from an extension using Conference
key 100
from an extension using LINK or ATT
RECALL 98
from an extension using Transfer key 99
from an unanswered extended
call 96-97
redialing a stored number
registration 192
Relay page (Attendant PC Properties
sheet) 83
Release key 21
RJ32 jack 203
routing control (ESN) 171
RS232 cable 202

163

156
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S
self test 207-208
serial number 191
setting up
console Directory 46
flexible features 74
ICI keys 36, 38-39, 75-76, 79
TGB keys 78
Voice Mail icon 65
setup type 187
shortcut
creating a shortcut 190
software installation 182
speaking privately feature 153
Speed Call Number
network (ESN) 170
splitting feature 153
Status LED 207
stored number redial
redialing 156
storing ahead of time 156
storing
a stored number ahead 156
an Auto Dial number 131
Supplementary features
Break-in (busy verify) 114
Break-in (pre-dial) 112
system cable 201
system requirements 182
System Speed Call 158

T

telephone 205

testing Do-Not-Disturb 141
TGB keys 39

TGB List option 28

TGB page (diagram) 78
through-dialing 104
Timed recall

from an unanswered extended call
from an unanswered parked call

Toolbox 197

Toolbox command on Tools menu 41

Toolbox option 28
Tools menu 28
Tools option 28
tracing a malicious call 146
Transferring a call
to another attendant 108
to remote ext. (NAS) 167

Transferring a recall
to another extension 99
to remote ext. (CAS) 163
troubleshooting 208
Trunk Group Busy keys 39
trunk group busy keys, status 22
trunk-to-trunk call 103
turning enhanced night service on and
off 144
turning night service on and off 147

V

virtual feature keys 71
voice mail 91, 192
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